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Chapter 1 — Introduction

About T4 TimeSaver

ELM Computer Systems Inc. has provided custom programming and consulting
services to accounting firms and to small business since 1978. The T4
TimeSaver development team is committed to providing software for producing
Canadian tax information returns which is superior to any other system available.

Technical Support

As a registered user you may telephone, fax, or e-mail us with your questions
about the installation and use of the T4 TimeSaver program. There are a
number of other technical support options available to you. Select Technical
Support Options from the Help menu to view a list of them.

Our technical support hours are 9am to 5pm ET.

Technical Support Hot Line:  1-800-268-3211

Local to Toronto: (416) 495-1624

Fax Number: (416) 495-0044

Email: support@t4timesaver.ca
Product Website: www.tdtimesaver.ca
Corporate Website: www.elmcomputers.com

To quickly and easily send an email to our technical support team, select Send
an E-mail to Technical Support from the Help menu.

If you encounter a problem with the software, you may find some assistance in
the "Common Problems" listed in Appendix C of this User Manual or in the
program's on-line help system under the title "Common Problems". To access
this information, press [F1] anywhere in the program and click the Contents tab
to view the table of contents for the Help system.

Technical support is available in the French language at our Montreal office.
Support from our Toronto office is available only in English.

French Language Technical Support:

Telephone number: (514) 499-9669

Receiving Updates
2008 T4 TimeSaver can automatically check for updates on the T4 TimeSaver
download page. Select Check for Program Updates from the Help menu.
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& Check for Program Updates

T4 TimeSaver can autamatically check for program updates available
on the T4 TimeS aver download page. Select how often you vould like
the software to check the website for updates.

" Do not automatically check for updates
" Check for updates every time the program starts

o Check for updates everp | 2 days

Ok | Cancel ‘ CheckNow‘

Select the option which best meets your needs. You can also click the Check
Now button to do an immediate search.

Requesting System Enhancements

We value your suggestions at ELM Computer Systems Inc. and attempt, as
much as possible to incorporate them into future versions of T4 TimeSaver.
Many of the features now available in the system are the result of comments
made by people like you who have used the program for years.

If there is a feature which you would like to see in T4 TimeSaver please call or
send us a note and let us know. We cannot promise that all suggestions will be
incorporated into the system but we assure you that each one will be given our
careful consideration.

Thank you in advance for helping us to make T4 TimeSaver the finest tax slip
preparation software available in Canada.

Hardware Requirements

Computer
Any Pentium class PC

Operating System

'Windows 980 (no longer supported by Microsoft), Windows MEUO (no longer
supported by Microsoft), Windows NT (no longer supported by Microsoft),
Windows 20000, Windows XP[ and Windows Vistall.

! Note: Windows is a registered trademark of Microsoft Corporation. All product
names mentioned in this manual and not listed are trademarks of their respective
companies.
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System Memory
A minimum of 64 Mb RAM is required to run T4 TimeSaver. Typically, any system
able to run a current version of Windows will be able to run T4 TimeSaver.

Disk Drives

A hard disk drive with at least 20 Mb of available disk space is required for
installation of the program files while leaving sufficient space for data. Data may
be stored on either a hard disk or on removable media; T4 TimeSaver performs
much better if data is stored on a hard disk. The software and/or its data files
may also be installed on a network file server.

For optimal performance of both T4 TimeSaver and other software ensure that
you have sufficient room available on your hard disk for the virtual memory swap
file maintained by Windows. Typically this file is 50% greater than the size of the
available RAM installed on your system.

Printer

Slips and summaries may be printed on ink jet and laser printers using
government supplied forms. T4 TimeSaver will not print to dot-matrix (or impact)
printers as these forms are no longer supported by either the CRA or the MRQ.

T4 TimeSaver can also produce most forms as facsimiles on ink jet and laser
printers. You may also file most types of returns via the internet or on diskette,
CD or DVD, greatly reducing your paper requirements and the labour involved in
producing these returns.

License Agreement

T4 TimeSaver ("program”) is owned by ELM Computer Systems. ELM Computer
Systems grants to you as a registered user a non-exclusive, non-transferable
license to use the program. You are expressly prohibited from distribution of the
program to others outside your office, regardless of whether such distribution is
for profit. All rights, title and interest in and to the program, and all
documentation, code and logic which describes and/or comprises the program
are vested in ELM Computer Systems. Your right to use the program is
conditional upon and limited by the terms and conditions of this license. You may
not: (a) modify, adapt, translate, reverse engineer, decompile, disassemble, or
create derivative works based on the program; or (b) loan, rent, lease or
sublicense the program or any copy, without the prior written consent of ELM.
Any violation of these provisions will constitute an automatic revocation of your
license to use the program and will subject you to substantial liability under the
applicable legislation of the jurisdiction in which the program is being used.

You are permitted to use the program on any and all personal computers in your
office, with no restriction on the number of concurrent users. Use of the program
at other offices (i.e. different street addresses) is prohibited unless separate
licenses have been purchased for each office.
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Warranty Information

We warrant to you for ninety (90) days from the date you received the software
package that the package contains an accurate reproduction of the program, and
the copy of the User Manual is accurately reproduced. The program itself is
excluded from our warranty. To obtain replacement of these materials, you must
(i) return the inaccurate package or copy of the User Manual to us within the
warranty period, or (ii) first notify us in writing within the warranty period that you
have found an inaccuracy and then return the materials to us. This limited
warranty only covers the original user of the software package, and we make no
other warranties expressed or implied. ANY AND ALL WARRANTIES
RELATING HERETO ARE LIMITED IN DURATION TO THIS NINETY-DAY
WARRANTY PERIOD. REPLACEMENT OF THE DISK CONTAINING THE
PROGRAM OR USER MANUAL IS YOUR EXCLUSIVE REMEDY AND SOLE
MEASURE OF RECOVERABLE DAMAGES.

Disclaimer

The Package (The program and the User Manual) is licensed "as is", without
warranty of any kind, either express or implied, including but not limited to the
implied warranties of merchantability and fithess for a particular purpose, without
limitation; all warranties against infringement or the like respecting the package
are hereby disclaimed by us. We do not warrant that any functions contained in
this package will meet your requirements or that your use of the package will be
uninterrupted or error-free.

We shall have no liability to you or any third party regarding the package, the
User Manual or otherwise in warranty, contract, tort, or otherwise. In no event will
we be liable for any direct, incidental, special, indirect, general, or consequential
damage or loss of any nature (such as damage to property, damages resulting
from delay, claims of third parties, loss of profits, or injury to person) which may
arise in connection with the use of or inability to use this package. This clause
shall survive failure of an exclusive remedy. We specifically disclaim liability for
any and all forms generated by the Package for submission to CRA or Québec's
Ministere du Revenu. It is the users' responsibility to ensure that the proper
forms are used and, with respect to the Relevé slips, that the serial numbers on
the forms are unique and within the range assigned to the user by ELM
Computer Systems, Inc.
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Chapter 2 - Getting Started

Installation

T4 TimeSaver may be installed on any hard disk drive accessible to your
computer. Single User and Network installations are described below. If you
used T4 TimeSaver last year, you may install the program without affecting last
year’'s database, nor will reinstalling the current program affect the current year’s
database.

We strongly recommend against storing data files on floppies as data loss will
occur when the database exceeds the capacity of the floppy disk. For fastest
program response and most secure retention of data it is recommended that data
files be stored on either a local or network hard disk. Data files can also be
stored on many USB flash drives provided sufficient space is available.

To install T4 TimeSaver from the CD follow these steps:
1. Copy the original CD media and store the originals in a safe place.

2. Close all open applications to avoid possible conflicts with open
programs.

3. Insert the copy of the installation CD in an appropriate drive.
4. Click on the Windows Start button. For XP select Run from the menu
displayed, for Vista type Run in the search box. Type d:t4setup (replace
“d:” with the drive letter in which the install CD is located.) Click OK to
continue.

To install T4 TimeSaver from the internet follow these steps:
1. Download the installation package from our website:

http://www.t4timesaver.ca/contents/t4_timesaver_downloads.html

2. Close all open applications to avoid possible conflicts with open
programs.

3. Click on the Windows Start button. For XP select Run from the menu
displayed, for Vista type Run in the search box. Type location \t4setup
(replace “location” with the name of the folder to which you downloaded
the installation package.) Click OK to continue.
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When the setup program begins, follow the directions on your screen.

a
=

= T4 TimeSaver Installation

" Metwork Administrator

Whorkstation: Installs a copy of T4 Timesaver on your hard
disk.

Metwaork. Administrator: Installs the application and node
getup program or the file server. Each uger can then in
T4MODE.EXE to copy the files necezsary ta run the
application without copying all the files to their hard disk.

< Back et » Cancel

Workstation Installation:

Select Workstation from the Select Install Type window. This will install the
program on either the local hard drive or any network drive available to the
computer, placing all resources required by the software only on the local
workstation.

Network Administrator Installation

Select Network Administrator from the Select Install Type window to install the
program on a network drive. Then run TANODE.EXE from each workstation to
copy the necessary files to run the program from the workstation.

Starting the Program
The Start menu will contain the T4 TimeSaver icon in the T4 TimeSaver program
group.

Registration

Your copy of T4 TimeSaver must be registered before all functionality of the
program is activated. Click on the Registration button on the registration screen
and enter the unique authorization number issued to you by ELM Computer
Systems to register this copy of the program. You can then click on the Start
button on the registration screen to begin using T4 TimeSaver.
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You may enter data into the T4 TimeSaver without registering the program but
you will be unable to produce a valid return until the registration number is
entered. (Many functions will also be unavailable until the software is registered.)

w. 2006 T4 TimeSaver

Welcomel

Welcome to T4 TimeSaver, Canada's finest software for producing
T4's, T5's, and other information returns!

We encourage you to use this evaluation version and pass it on to
your associates. You may enter your current data to evaluate T4
TimeSaver. All data that you enter will be saved; when you register
S (416) 495-0044 thg software, you will NOT havg to re-enter any data. If you used_Tq-
Toll-free: 1-800-268-3211 | TimeSaver last year, you can simply roll forward last year's data into
Toronto: (416) 435-1624 | this year's program.

TLEETAL TR We are confident that once you have experienced the power and
www. t4timesaver.ca L . .
ease-of-use of this time-saving tool you will want to become a
registered user of T4 TimeSaver. Place your order and join thousands

ELM Computer Systems Inc. | of Canadian companies already using this excellent productivity tool!
502 Gordon Baker Road

MNorth York, Ontario

M2H 384

Order Online Begistration How to Order

Exit ‘

The opportunity to register will be available every time you start the program until
registration has been completed.

T4 TimeSaver program is copyright (c) 1987-2008 by ELM Computer Systems
Inc. Please refer to the License Agreement in Chapter 1 for full details of the
agreement between ELM Computer Systems Inc. and users of the package.

User Names and Passwords (Plus version only)

Every time T4 TimeSaver Plus is started, you will be prompted for your user
name and password. You can enter any name you wish to for a username.
There should be a unique user name assigned to each person or workstation.
The first time you enter a new user name, you must also enter a password which
will be assigned to the user name. You will be asked to confirm that this is a new
user name. You can change the password by selecting the Change password
option from the File menu.

Each user name is associated with a corresponding user profile. The user profile
contains the user settings associated with the user name. You can create as
many user profiles as you require. The user settings can be unique for each user
or there can be a number of identical users. A user profile is created by typing in
a unique entry when prompted for the user name.
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Each user can establish their own settings by selecting User Setup Options
from the Setup menu. Preferences and default values can then be entered in
the various categories. See chapter 4 for descriptions of the various settings.

Alternatively, global settings can be established by using the User

Administration option in the Setup menu. To access this function you must
enter the user name “Admin” upon startup. With this function you can add a new
user or edit, copy or delete existing user settings.

NOTE: DEFAULT VALUES ENTERED IN SETUP WILL BE REFLE CTED IN
NEW COMPANIES ONLY. TO CHANGE VALUES IN EXISTING COMPANIES,
SELECT EDIT COMPANY INFORMATION FROM THE COMPANY ME NU.

Privacy Protection

Additionally, user names can be used to restrict access to sensitive information.
By default there is no restriction to database access, but the creator of a
database (or the person with username “admin”) can restrict access to the
database to any users not on a user list. Select the Database Access Control
from the Setup menu, and then select Setup Database Access User List

Check the “Restrict Access to the current database” checkbox. The database will
be restricted to the creator and the user “Admin” unless additional usernames are
added to the list.

What's on the T4 TimeSaver Window?

The title bar of the main window contains the name of the program and the name
of the current database. Beneath it is the main menu. Each menu item can be
accessed by clicking its name. Under the main menu are both the current
company name and the icon toolbar. Clicking the company name will give you a
list of all the companies available in the current database and will allow you to
switch to any other company. The icons that appear in colour are available to
use.

& T4 TimeSaver HEHE

File Company Tools Setup Window Help

[ |Dlw|Elnl 8 &% [

Those that are greyed out are only available when a form is open. See the
section below on Toolbar Icons for details on the individual icons.

Use of Special Keys
The T4 TimeSaver makes use of some special keys and key combinations to
facilitate your data entry and editing.
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Short-cuts

Any command button that has an underlined letter can be accessed by
simultaneously pressing the [Alt] key with that underlined letter. (E.g. pressing
[Alt] + [K] would have the same affect as clicking on the OK button.)

In the same way, each menu title at the top of the window can be selected by
simultaneously pressing the [Alt] key with the underlined letter. When the menu
is open, you can select from the list of topics by simply typing the underlined
letter (without the [Alt] key).

Many of the menu items have short-cut key strokes which can be used instead of
opening up the menu and selecting the function. These are listed below:

Flon. Accesses on-line help

Ctrl+P....... Opens print window (with current employee selected, where applicable)
Ctrl+ A....... Adds a slip to the current company

Ctrl+D....... Deletes the current slip from the current company data

Ctrl+S....... Allows you to select from the list of employees for the current company
Ctrl + PgUp Moves to the first slip for the current company

PgUp.......... Moves to the previous slip for the current company

PgDn.......... Moves to the next slip for the current company, adding a new slip if current

slip is the last slip
Ctrl + PgDn Moves to the last slip for the current company

FO o, Switches between a T4 or T5 and its corresponding RL-1 or RL-3
Ctrl+ G........ Switches between a slip and its corresponding Summary
Ctrl + J......... Adjusts the current employee’s T4 or RL-1 slip

Special Keys for Data Entry
During data entry the following keys may prove useful:

Tab or Enter Moves to the next data entry field.
Shift + Tab .. Moves to the previous data entry field.

ESC..ccccvnnnnns Exits the current screen.

Home .......... Moves to the beginning of a data entry field.

End.............. Moves to the end of a data entry field.

[D]=] [ Erases the character under the cursor.

Backspace .. Erases the character to the left of the cursor.

F2.oi. Opens a combo box (a box with a black top right corner, containing multiple choices).
Fa..ooonnnns Allows you to override a calculated field.

F5. i, Formats the employee name as “SURNAME, First name”.

Up-Arrow..... Moves to the previous selection in a list.
Down-Arrow Moves to the next selection in a list.

PgUp........... Moves by pages up through a list.

PgDn........... Moves by pages down through a list.

Shift+F6......Inserts the company address to an employee’s slip.

F7 i, Copies the address and S.I.N. for the current employee to a clipboard.

Shift + F7..... Pastes the address and S.I.N. from the clipboard to the current employee.
F8 oo Switches order of first and last name
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Toolbar Icons

The toolbar is located directly below the main menu. The icons in the toolbar
provide shortcuts for some of the common functions of the T4 TimeSaver
program.

]

—— Add a New Company. This function creates a new company within the
current database. You must enter a company name that is unique to the
database. You can have as many companies in the database as you wish.

E Open a Company in the Current Database.  Clicking this icon will produce
a list of the company names for all the companies in the current database.
Select the desired company by highlighting it and clicking Select.

Edit the Current Company Information. This function opens the current
company information window and allows you to edit the information for the
current company. You can change the company name, address, business
number, El rate, or adjustment options.

ﬂ Find a Company by Name. Clicking this icon opens the "Find Company"
dialog box. Type in the company name (or part of it) and select either "All
databases in directory"” or "Current database only". Then click on the Find
button. T4 TimeSaver will generate a list of companies that contain the desired
name (or part of name). Select a particular company by locating and highlighting
the desired company name and clicking Select (or double-click on the correct
company name).

Q Print the Current Form.  Clicking this icon will open the print window with
the company and employee already selected allowing you to print a single slip or
summary. Choose the type of form and the copy number that you require. You
can also adjust the margins and select printers from the same dialog box. [Ctrl] +
[P] performs the same action. See Chapter 9 - Producing Reports.

i

—" Add a Slip. This function creates an empty slip of the same type as you
are currently accessing. [Ctrl] + [A] performs the same function. Pressing [PgDn]
when you are at the final slip for the company also adds a new slip.

Iﬁ: | Delete this Slip. This deletes the current slip. [Ctrl] + [D] performs the
same function. If you delete the only slip, the slip window will be closed.

ﬁ Find a Slip. This provides you with a list of all the employees entered for
the current company. [Ctrl] + [S] performs the same function. Select the desired
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employee from the list by highlighting the name and then clicking Select or
simply double-clicking on the employee name.

Go to Summary/Go to Slips.  Clicking this icon toggles between the
Summary report and the slips for the type of form currently being displayed for
the current company. [Ctrl] + [G] performs the same function.

ﬂ Adjust this T4 Slip.  This function calculates and makes any adjustments
necessary for the current slip, based on the adjustment options entered for the

current company. [Ctrl] + [J] performs the same function. The adjusted values

will appear below the entered values.

The buttons below are only visible when an information return is being displayed.

m Clicking this icon moves to the first slip for the current company. [Ctrl] +
[PgUp] performs the same function.

ﬂ Clicking this icon moves to the last slip for the current company. [Ctrl] +
[PgDn] performs the same function.

ﬂ Clicking this icon moves to the previous slip for the current company.
[PgUp] performs the same function.

ﬂ Clicking this icon moves to the next slip for the current company. [PgDn]
performs the same function.

Input Conventions

The decimal point should be used to enter cents. Where no decimal point is
entered, the system will assume and display zero cents when the [Tab] or [Enter]
keys are pressed, or you move the cursor to another field.

New data entered in a field will overwrite previously entered data. You may edit
existing data by using the left and right cursor control keys, as well as the
[Backspace], [Delete], [Home], and [End] keys.
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Getting Help

Whenever you require help, press the [F1] key to access the on-line help
screens. If context-sensitive help is available it will be displayed. Otherwise use
the table of contents to access the desired topic. Hyperlinks to related topics are
provided for your convenience.

You can also access the help files from the Help menu. The Contents option
will access the table of contents for the Help Pages. The Search for help on
option will access the help index. The Internet sites submenu lists a number of
Internet sites that may prove helpful.

During a technical support session our staff may request that you supply a copy
of your database or a record of the settings currently being used by T4
TimeSaver installation at your location.

To send ELM a copy of your current database select the Help menu, then the
Send an E-mail to Technical Support sub-menu, then the Send Current
Database sub-menu. Please be assured that we will treat any data sent to us
with the strictest of confidence and will delete all copies once your question has
been answered.

To send ELM a listing of your current program settings select the Help menu,
then the Send an E-mail to Technical Support sub-menu, then the Send Other
Email sub-menu.

Please note that client confidentiality agreements between your office and its
clients may prohibit sending client and/or corporate data to another entity such as
ELM.
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Chapter 3 - Working with Databases

Creating a Database

A T4 TimeSaver database is a collection of the data for one or more companies
in a single file on your computer. Each database can contain the data for
numerous companies and you can create as many databases as you wish. To
create a database select New database from the File menu.

First, select the folder in which you want to store the database. You can select
any local or network folder available to your computer. If a multi-user network
version of T4 TimeSaver is being used, the database should be stored on a
network drive so that it can be accessed by all users. Next, you will need to give
the database a name. Enter a valid Windows filename. If you enter the
extension, it must be ".T0O8". If no extension is entered the extension will default
to ".T08".

Create New Database

Save jn: |JT4T|meSaver L| ck B

;33 [E5] My Data, 106

ERL

o

File name: |T4Data 106 Save

Cancel

4

!

Save as type: |T\meSaverﬁIes (*.106)

L

Click Save to create the database and exit the Create New Database dialog
box. The new database will be automatically opened and its name will appear in
the title bar of your T4 TimeSaver window.

If you already have a database open when you choose New database the
current database is automatically closed before the new database is created and
opened unless you cancel the procedure.

By default there is no restriction to database access, but in the Plus version, the
creator (or the person with username “admin”) can restrict access to the
database if desired. Select the Database Access Control from the Setup
menu, and then select Setup Database Access User List . Check the “Restrict
Access to the current database” checkbox. The database will be restricted to the
creator, the user “admin” and any additional usernames added to the list.
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Opening a Database

To work with an existing database, you must open it. Choose Open Database
from the File menu. Select the path and folder that contains the required
database. Select or type the name of the document you want to open in the File
name field. You can only open a database with the filename extension ".T08"
when using the 2008 T4 TimeSaver. If you attempt to open a database with a
“.TO7” extension you will be asked if you wish to convert the selected database
into the 2008 format. If you respond “Yes” a 2008 database will be created
which contains all of the company and employee information that was in the
original 2007 database. The original 2007 database will not be affected.

If no database exists you will need to create one by selecting New database
from the File menu.

NOTE: IF YOU ARE UNABLE TO ACCESS MOST ITEMS UNDER THE
‘COMPANY” MENU THE MOST LIKELY CAUSE IS THAT NO DAT ABASE IS
OPEN IN T4 TIMESAVER. YOU WILL ONLY BE ABLE TO CREA TE
COMPANY INFORMATION IF A DATABASE IS OPEN IN THE T4 TIMESAVER.

Closing a Database
Close the current database by selecting Close database from the File menu.

The database must be closed to allow you access to the file through your
operating system in order to move or backup the file without closing T4
TimeSaver.

Deleting a Database

Ensure that the database you wish to delete is closed. Select Delete database
from the File menu. Locate and highlight the name of the database to be
deleted and then click the OK button. You will be asked to confirm the deletion.

Renaming a Database

To rename an existing database you must first close the database. Select
Rename database from the File menu. Locate and highlight the name of the
database you wish to rename and click the OK button. You will be asked to
enter the new name of the database file. Ensure that the correct filename is
entered, including the path and the “.T08" extension and again click the OK
button.

Finding a Database

To find an existing database you can select Find database from the File menu.
You will be asked to specify a folder in which to look for database files from
either the current taxation year, the previous taxation year, or both. All sub-
folders of the specified folder will also be searched.
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Chapter 4 - User Setup Options

T4 TimeSaver comes with many user-definable settings to make it more flexible
and efficient. Before entering data, you may wish to configure the program to
your specific needs. If you are using the T4 TimeSaver Plus, these settings can
be different for each user.

NOTE: DEFAULT VALUES ENTERED IN SETUP WILL BE REFLE CTED IN
NEW COMPANIES ONLY. TO CHANGE VALUES IN EXISTING COMPANIES,
SELECT EDIT COMPANY INFORMATION FROM THE COMPANY ME NU.

Data Entry Tabs

Each data entry screen contains a number of boxes corresponding to the boxes
on the printed form. It may not be necessary for you to enter information into
each box as some boxes may be left blank or they may contain a default value.
Place a check mark beside the name of each box where you want the cursor to
stop and remove the check mark from beside any box where you do not require
the cursor to stop in the Data Entry tabs for each type of slips. When you are
finished, click on the OK button to save your selection.

The following is a sample of the T4 Data Entry tab:

T4 Adjustrnent Defaults

MNew Company Defaults | Magnetic Media ‘

4 _w_;lTélA Data Enry | T Data Entry | Rt Data Entyy | 3 Data Entry |

When entering T4 slips. the cursor will automatically move to the boxes with a check

[v' Employee name [v' 14 Employment income [v' Other information #1

[ Address ling 1 [v 15 CFF contribution [ Cther information #2

[v Addressline 2 [ 17 QPP caontribution |7 Other infarmation #3

[w City [v 18 El premium [ Cther information #4

[v Province [ 20 Pension plan |7 Other infarmation #5

[v Postal code [v 22 Income tax deducted [ Other information #6

[ Country [v' 24 Elinsurable earnings |7 44 Union dues

|10 Prov. of employment |v 26 CPP/QPF eamings [ 46 Charitable donations

v 12 SIMN. [ 28 CPPexempt [ 50 Fension plan DFSF number

[ 29 Employment code [ 28 Elexempt [ 52 Pension adjustment

[v' CPP pensionahle weeks [ 28 PFIF axampt [ 55 PFIP premuims

[ Amended [ Do not adjust CPR/QPP [ 56 PFIF insurable eamings

[ “oid [ Do not adjust EI [ Cther deductions from net pay
[ Do not adjust PFIF [¢ Employee number

During data entry, pressing the [Tab] key or the [Enter] key will move you from
one checked box to the next. Pressing [Shift] + [Tab] will move you back to the
previous checked box. Use the space bar to check and uncheck boxes. If, on a
particular form, you need to edit a box that would normally be skipped, you can
use your mouse to place the cursor within the field and then type in the data.
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T4 Adjustment Defaults Tab

Complete the T4 Adjustment Defaults tab. The information on this tab will be
copied to the T4 Adjustment Options tab of the Company Information window for
each new company. See further information in Chapter 7 Adjusting T4s and
Relevé 1s regarding how to set the adjustments to best suit your needs.

T4 Data Entry‘TélA Data Entry ‘TS Data Entry ‘Fﬂ Data Entry ‘RS Data Entry ‘

CPP{QPP Adjustment Options Transfer Over Remittance to Owner

v Adjustif over maximum/under required minimum When adjustments reduce total deductions for the company, the owver-
remittance may be transferred to the tax of an owner or sharehalder.

[ Adjust based on number of pensionable weeks

|— Maintain the net pay of the owner/sharehalder by increasing the

taximum number of pensionakle weeks aross pay by the amount added to tax.

El Adjustment Options Other Options

Adjust CPP/EI/QPIP differences greater than

Adjust CPR/EI/QFIP to calculated amounts even ifthere is
insufficient tax to offset the adjustment.

[v' Adjustif over annual maximum
[v' Adjust based an insurable earnings

| Adjustinsurable earnings based an El deducted

QPIP Adjustment Options I:I

[v' Adjustif over annual maximum

[v' Adjust based an insurable earnings

| Adjustinsurable earnings hased an QPIP deducted

New Company Defaults Tab

Complete the New Company Defaults tab. This information will be
automatically entered into each new company you set up. You may override
these defaults for individual companies as you set them up.

T4 Adjustment Defaults l lMagnetic Medial

T4 Data Entry l T44 Data Entry l T5 Data Entry l Fi1 Data Entry l Fi3 Data Entry l

All Other Summaries: Person to contact

Other Information

First name I:I Tax Centre l:l
Sumame l:l Taxation Services Office hd
Telephane I:I Drefault province of employment D
T5/NR4/T4P5/T1204 Summaries: Contact
Mame |
Telephone I:I

Certification section on all summaries

Authorized person Position or office

Magnetic Media Tab

The Magnetic Media tab contains information required by the system to submit
T4, NR4, T4A, T4AA-NR, T5, T1204, RL-1, RL-2, RL-3, and RL-25 returns on
diskette, CD or DVD. Enter the name and address of the company responsible
for transmitting the magnetic media data. You should also enter names and
phone numbers for accounting and technical contacts. If CRA has assigned a
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transmitter number for federal forms, it should be entered. If you will be filing
RL-1 and/or RL-3 returns you must contact the Ministere du Revenu to receive a
transmitter number and a set of serial numbers. See Chapter 10 — Filing by
Magnetic Media for further information regarding magnetic media filing.

T4 Adjustrnent Defaulks l Mew Company Defaults ] Y] ;
T4 Data Entry ] T44 Data Entry ] T3 Data Entry ] R1 Data Entry l R3 Data Enty ]

Tranzmitter Information

Mame line 1

Mame line 2
Addressz line 1
Address line 2

City. Prow | Federal

Postal code Bawilay CaM Transmitter Mo. l:l

Accounting Contact

Mamne Québec
Phire: | Ext. | | Lang. IE_ Transmitter Mo, l:l
Technical Contact Transmiter type Fing for self
M ame | |
Phaone | Ext. | | Lang. |E MEQ
E-mail Identification / file # | |
Fax Source of slips Reveru Québec

You do not have to submit a test diskette to either the CRA or the Québec
government before filing your returns on diskette. We have already received
approval for the magnetic media format on your behalf.

User Administration (Plus version only)

When the user “admin” is logged into T4 TimeSaver, the User Administration
function is available in the Setup menu. This allows the Administrator to add or
delete user profiles.

% User Administration

ADMIN
BOB

GEORGE :‘ E
Edit User Options
Reset Password
Set Az Creator
Delete User
Exit

The Edit User Options button allows the administrator to change setup options
for the selected user. Select a user, click Edit User Options , then on the main
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menu select User Setup Options from the Setup menu. After making the
desired changes, click OK to save your changes and Finish to return to the User
Administration window.

The Reset Password button allows the administrator to assign a new password
for a user. Click the Reset Password button, enter the new password twice and
click OK.

When Database Access Restriction is turned on (see below), the only users
allowed access to the database by default are the administrator (admin) and the
user who created the database. Clicking Set As Creator will change the creator
name from the existing name to the selected name.

The administrator (admin) can also create a new user with identical settings as
an existing user, by highlighting the original user name and clicking Copy User .
Note that this will also copy the password, so the new user profile name should
be selected and the Reset Password button clicked to reset the password.

Database Access Control

The administrator (admin) also has access to the Database Access Control
function. To restrict access to a database, select Database Access Control from
the Setup menu. Select the Setup Database Access User List from the
submenu. Check the “Restrict access to the current database” checkbox. The
only users allowed access to the database will be “admin”, the user that originally
created the database and any user names that appear in the box. Click the
Select Users button to add or remove names from the list.

a% Database Access Control H
v Restrict access to the curent databaze

'BOMIN', creator 'SARAH" and users in the list
below have access to the cunent database.

GEORGE

Contribution Rates and Constants
The administrator can change the rates and constants if required. Click the
Default button to return the values to the 2008 legislated values.



Company Information 5-1

Chapter 5 - Company Information

Creating a Company

You can enter as many companies as you would like into each database, as long
as each company has a unigue name. To create a new company in the current
database, select New Company from the Company menu. Company
information is entered on the Identification tab and the T4 Adjustment Options
tab.

Identification

You must enter a company name which is unique to the current database. (Itis
possible to have the same company name in different databases.) You should
also enter as much of the requested company information as possible when you
add a new company.

i l T4 Adjustment Options ]

Company Hame and Address Other Information

Mame [MEW COMPANY Business Mumber I:I
Taration Services Office -
Strest
addiess Default province of employment D
City | | FiEiee D Employer's El rate 1.4000

Pastal cods l:l Caw Guébec Identific:ation and File Mo, l:l
Beplicate Company . E

Default Employee Address ‘Web Access Code l:l
Street Compaty category code I:I
address
City | | Province D

Postal code l:l Country l:

Replicate Employes
Address

You must enter a valid business number if you wish to file slips and summaries
for this company using magnetic media processing. T4 TimeSaver will
automatically use the default values for the Tax Centre, the Taxation Services
Office Code, and the Default Province of Employment that you entered on the
New Company Defaults tab in the Setup menu. You may make any changes
required for this particular company by simply typing in the correct information.

The company category field is a self defined field that allows you to group the
companies into categories. Enter a different company category name for each
group of companies you require. This will allow you to print reports that include
only the companies in the specified category. See Using Filters in Chapter 9.
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T4 Adjustment Options.

With the T4 TimeSaver you have the flexibility of customizing your method of
adjusting CPP/QPP and EI discrepancies for individual companies. When you
add a new company, T4 TimeSaver will automatically insert the default values
that you entered on the T4 Adjustment Defaults tab in the Setup menu.

Identification T4 Adjustment Options: l

CPP{QPP Adjustment Options Transfer Over Remittance

v Adjustif over maximum/under required rminimum Transfer over remittance of CPP/El to employee with the following 311N,

| Adjust based on number of pensionable weeks I:I

Maximum number of pensionahle weeks | Increase gross pay of above employee by amount of over-remittance
El Adjustment Options Other Options
Iw Adjust if over annual maximum Adjust CPP/EI/QFIP differences greaterthan

L #ielusi besed s lnsulle seings | Adjust CPP/EI/QOPIP to calculated amounts even if there is insufficient

[ Adjustinsurakle eamings based on El deducted taxto offsetthe adjustment

QPIP Adjustment Options I:l

v Adjust if aver annual maximurm

|v Adjust based on insurable earnings

[ Adjustinsurable eamings based on OPIP deducted

You may make any changes required for this particular company by simply typing
in the correct information. For further information see Chapter 7 Adjusting T4s
and Relevé 1s.

If, for a specific company, you have changed the values for the Tax Centre, the
Taxation Services Office code, or the Default Province of Employment, on the
Identification tab (or any of the options on the T4 Adjustment Options tab)
pressing the User Defaults button will restore the default values that are stored
in the User Setup Options. You will be asked to confirm your choice.

Selecting a Company

To switch to another company, choose Selecting a Company from the
Company menu. A list of all the companies stored in the current database will
appear. Highlight the desired company and press [Enter] or click on the
company name. You can perform the same function by simply clicking on the
current company name visible at the top of the form.

Editing Company Information
You can edit the company information by selecting Edit Company Information
from the Company menu.
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T4 Adjustment O phions ]

Company Mame an dress Other Information
Tauxation Services Office -
Strest
address Default province of employment D
City | | FisiiEe D Employer's El rate 1.4000

Posztal code I:I Dz, GHugbec [dentification and File No. l:l
Replicate Company ) .
Addiess Québec Enterprige Mumber [MEQ) l:l

Default Employee Address Web Access Code l:l
Street Company categon code l:l
address
City | | Province D

Poztal code I:l Country l:

Feplicate Employes
Address

oK | LCancel | Uszer Qe[aulls|

Replicate Company Address
This button will copy the information in the current company address and care-of
lines to all companies in the current database.

Replicate Employee Address

This button will copy the information in the Default Employee Address section of
the data entry screen to all employees of the current employer (or all slips for the
current company).

User Defaults

If you have changed any of the adjustment options, pressing the User Default
button will restore the default values that were recorded during setup. You will be
asked to confirm the copying of this information.

Sometimes it may be necessary to make changes to the T4 Adjustment options
for a number of companies. Instead of making the changes on each company's
T4 Adjustment Options tab you can make the changes on the T4 Adjustment
Defaults tab in the Setup menu. Then simply press this User Defaults button on
the T4 Adjustment Options tab for each individual company.

Finding a Company
To locate a company, select Find Company from the Company menu. The Find
Company dialog box will open.
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w Find Company

Type part or all of company name: Find

Search in

* All databases in directory
" Current database only

Jilid.

Close

Type in a full or partial company name and select the scope of the search by
clicking on either "All databases in directory” or "Current database only". Then,
click on the Find button.

& Find Company

Type part or all of company name: Find
|s

Search in
+ All databases in directory

.

" Current database only

Shermaount Co-operative [in databazel)
Shadowland [in databazel)
Software King [in databazel)

3 matches found.

Once all the matching company names have been listed, double click on the
required company name or highlight it and press Select. The selected company
and its database will become the current company and database.

Deleting a Company

Delete the current company, and all slips and summary forms associated with the
company, by selecting Delete Company from the Company menu. You will be
given a warning and asked to confirm the deletion of the company by typing the
word "DELETE".

Remove all Slips

This function will remove all slips of any type from the current company. This is
useful if you wish to initialize the employee data for a given company. Enter the
type of slips you wish to remove (“T4", “T4A”, “T5", “T4ANR”, “NR4", “T4PS”,
“T4AP”, “T4AARCA", “T5013", “T5018", “R2", “R15", “R17”, “R25”0r “T1204"), or
“ALL” if you wish to remove all slips of every type for this company..
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Remove Inactive Slips

This function will remove slips that have all dollar values set to zero. This is
useful for eliminating slips for employees that are no longer with the company,
but for whom there is still a name and address in the database. Enter the type of
slips you wish to remove (“T4", “T4A”, “T5", “T4AANR”, “NR4", “T4PS", “TAAP”,
“T4ARCA”, “T5013", “T5018", “R2”, “R15", “R17”, “R25" or “T1204"), or “ALL" if
you wish to remove inactive slips of every type for this company.

Adjust/Unadjust Company’s T4s/RL-1s

This function allows you to adjust the CPP/QPP and/or El for all of the
employees in a given company at one time. The adjustments will be made
according to the adjustment options you have entered for the company. See
Chapter 7 — Adjusting T4s and Relevé 1s for further information about the
adjustment options. You may also remove the adjusted values and return to the
entered values by selecting the Undo Adjustment button from this window.

The Adjustment Options button opens the adjustment options data entry
screen for the current company. You can verify or edit the adjustment options for
the company before calculating the adjustments.

Check the Print adjustment report  box if you desire such a report for your
records. You can all print this report by selecting T4 then Adjustments from the
Reports menu.

Unlock all companies in database

From time to time you may receive a message stating that a certain record has
been locked by another user. If, in fact, no other user is accessing the database
this message indicates that a record has been left locked in error. Selecting this
function from the Company menu will unlock all of the locked records and allow
you access once again. Be careful to ensure that all other users are at the main
menu without any form or company records open when this function is utilized.

Refresh from Database

In situations where more than one person is entering data for the same company
data entered by one individual may not always be visible to another. Selecting
this option from the Company menu will cause T4 TimeSaver to reload the data
for this company and enable it to display data entered by other users.
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Chapter 6 - Entering Slips

Choose the type of slip you wish to enter by selecting it from the Forms menu.
The following are some of the functions you can use:

Adding Slips

This function is used to add a new slip, of the same type as you are currently
entering, to the active company. Access this function by selecting Add Slip from
the Edit menu, clicking on the Add Slip icon in the icon toolbar, or by pressing
[Ctrl] + [A]. A blank slip will appear in which you may enter the information for an
individual slip.

After entering data in a box you may press either the Enter or Tab key and the
cursor will move to the next box. The cursor only stops at the boxes that have
been checked off on the corresponding Data Entry tab of the Setup menu.
(Note: there are Data Entry tabs for the most commonly used form types — T4,
T4A, T5, RL-1, and RL-3.)

You will be warned if the data you have entered is invalid.

Deleting Slips

Select Delete Slip from the Edit menu, or click on the Delete Slip icon in the
icon toolbar, or press [Ctrl] + [D]. This function will delete the slip currently
displayed on the screen. You will be asked to confirm the deletion.

If you delete the only slip, the slip window will be closed.

Remove all Slips

This function is available in the Company menu and can be used to remove all
slips of any type from the current company. This is useful if you wish to initialize
the employee data for a given company. Enter the type of slips you wish to
remove (“T4", “T4A”, “T5", “T4AANR”, “NR4", “T4PS”, “T4AP”, “T4ARCA”",“T5013",
“T5018”, “R2”, “R15”, “R17”, “R25” or “T1204"), or “ALL” if you wish to remove all
slips of every type for this company..

Note: RL-1 slips will be removed with the corresponding T4 slips and RL-3 slips
will be removed with the corresponding T5 slips.

Removing Inactive Slips
Select Remove Inactive Slips from the Company menu to delete only those
slips that have all dollar values equal to zero. These would be employees that
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were imported or converted from a previous year, but were not employed in the
current yeatr.

Enter the type of slip you wish to remove (“T4", “T4A”, “T5", “T4ANR”, “NR4",
“T4PS”, “T4AP”, “T4AARCA", “T5013", “T5018", “R2", “R15", “R17", “R25” or
“T1204"), or type “ALL” to remove all inactive slips of any type for this company.

Note: You can determine whether inactive slips exist by creating a Company
Summary Report. The report will list the number of active and inactive slips of
each type for the company.

Note: Inactive RL-1 slips will be removed with the corresponding inactive T4
slips and inactive RL-3 slips will be removed with the corresponding inactive T5
slips.

Finding Slips

Choose Select slip from list  from the Edit menu to display a list of all the
employees for the current company. Clicking on the Find Slip icon in the icon
toolbar or pressing [Ctrl] + [S] performs the same function. Select from the list by
either double clicking on the desired employee or by highlighting the name and
then clicking on Select or pressing the enter key. The slip for the employee
selected will appear on the screen.

Sorting Slips

When displaying various slips you can modify their sort order by selecting the
desired field from the Select Order of slips field in the icon toolbar (located to
the left of the slip number field). This function will change the order of the slips
from the current sort order to the order designated by the field displayed in the
Select order of slips field (the fields available for sorting will vary by the type of
slip being edited). The slip currently being displayed will remain on the screen.

Entering Data

The data entry screen for each type of slip contains input fields that correspond
to the boxes on the printed forms. Descriptions of some of these boxes are listed
below under the appropriate type of slip. For the other boxes see the Employers'
Guides provided by CRA for information about the regulations concerning the
contents of any of the particular boxes.

There are a number of features available to make data entry as quick and easy
as possible. Many fields, for example the Province field, have black triangles in
the top right corner. This indicates that there are a limited number of valid
options for this field. Press F2, or double click in the field, to see and select from
the valid options.
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Pressing F5 while in the Name field will automatically format the name in the
“LAST, First” format. Pressing F8 while in the Name field will switch the order of
the first and last names.

You can insert the company address onto the address fields for an employee by
simultaneously pressing the Shift + F6 keys. If there is more than one slip for an
employee you can copy the Employee information from one slip using the F7 key
and then paste it onto another slip using the Shift + F7 combination of keys.

Overriding Calculated Fields

Some fields on the slips and summaries contain calculated values. These values
will appear in blue type. If it becomes necessary to edit a calculated field you
may do so by pressing the F4 key. The background colour of the field will
change to indicate the value is no longer the calculated value and you will be
able to enter the desired value. To return to the calculated value, click the
Recalculate button.
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NR4 Input Window

:5: Fle Company Forms Edit Reports Tools Setup Window Help _ =X
|FirstCUmpany |D = th & o R MNarne ~ | Adding slip 1
Non-Resident Recipient name and address Mate
NR4 Name | * Enter the non-resident account
number on the NR4 Summary OK
Address Restore
City / Frovince J ‘l Status
Fostal code Country USA | 1|
10 ¥ear |11 Recipienttype | 12 Country code | Payer or remitter [0 na. * Mon-resident 13 Foreign .5, Mo or SIM
- account number
[ J}[] e (U |l | | |

14 Income code | 15 Currency code | 16 Gross Income 17 Mon-resident tex 15 Exemption code

1 O | ow] | | m | [
24 25 2b 27 28
2| [ | 3 | o] || W | [
Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.

Recipient Type Code

Enter one of the following valid codes to identify the types of recipient:

1, if the income was earned by an individual

2, if the income was earned by a joint account (two individuals).

3, if the income was earned by a corporation.

4, if the income was earned by an association, a trust (fiduciary-trustee, nominee,
or estate), a club, a partnership, or other.

5, if the income was earned by a government, government enterprise, or
international organization.

Income Code
Enter the appropriate numeric income code, or select one from the drop down
list, to indicate the source of the income being reported.
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Currency Code

Gross income and non-resident tax withheld should be reported in Canadian
funds. However, if you cannot convert these amounts, CRA will convert both
these values to Canadian currency based on the currency code entered here and
the average annual rate. Ensure that both the gross income and the non-
resident tax withheld are in the same currency and that the appropriate three
letter code is selected.

Exemption Code
Enter the applicable exemption code, or select it from the drop down list. See
Appendix C in the CRA Publication T4061Non Resident Withholding Tax Guide.
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T4 Input Window

3. Fle Company Forms Edit Reports Tools Setup Window Help -7 X
IFlrstCDmpany |D =B A & & & A Narme ~ | Adding slip 60
Employee name and address Net pay
T4 Mama [DOE, John Employment Income 0.00 T
addrass |123 Main Street Standard deductions 0.00 =
Restore
City / Province |AmAown | acY Other deductions 0K
v
Postal code |[H1A 283 Country | CAN Net Pay 0.00 Goto RL1
Amended
o ] [ ] Fv] [
10 Prow. of emplay 12 SN, 28 Employ. code CPP pens. weeks  Year Woid
14 Employment 16 Employee's 17 Employee's 18 Employee's 20 Pension plan 22 Income tax 24 Elinsurahle
income CPP contribution QPP contribution  El premium contributions deductad EBrMiNgs
‘ oo | | | wo) O | 0.00] | 00| | 0.00
26 CPR/OPP 28 Exempt Do Mot Adjust 44 Union duss 46 Charitable B0 Pensionplan 52 Pension
Barmings CRR/OPP CPR/QPP donations DPSP number adjustrment
1 S s Y s ) i O —
PFIF PFIP

55 PPIP 56 PPIP insurable Boxes>»> "
premiums sarmings P — 3 DDl 700 T
‘ nnn| | 0.00 ‘ : | | | -
Employee no Boxes>> | |
l:l Amounts>> | uuu| | U.DD‘ ‘ 0.00

Employee Name

The employee name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered. Pressing the F8 key will reverse the first and
last names (e.g. John Smith will be changed to SMITH, John).

Province Code

T4 TimeSaver will automatically insert into Box 10 the code for the province of
employment entered on the Identification tab of the Company Information

You may, of course, override it for a specific employee. If the province code is
set to "QC", the Employee's QPP contribution box is included in the data entry
fields and you will be unable to access the CPP box. If any other province code
is entered, the Employee's CPP contribution box will be accessible but not the
QPP box. Also, if the province code is QC, a Relevé 1 slip can be accessed by
pressing F9 or clicking the Go to RL-1 button.

S.I.N. Validation

T4 TimeSaver will check the validity of the S.I.N. entered and will change the
background colour of the S.I.N. field to red if the S.I.N. is invalid. You can,
however, ignore the warning and continue to enter other information. The
formula used to test the value of the S.I.N. is found in the CRA Publication:
Formulae for Federal and Provincial Deductions for Computer Users.

When the edit list or detailed adjustment report is printed or displayed, there will
be an asterisk beside any invalid S.I.N. values.
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CPP Pensionable Weeks

If you have selected "Adjust based on number of pensionable weeks" for the
CPP/QPP Adjustment Option on the T4 Adjustment Options tab of the
Company Information , a value must be entered into the input field "CPP
Pensionable Weeks". This field will default to 52 or 53 depending on the value
entered under Maximum Number of Pensionable Weeks, but you may override
this value for specific employees.

El Insurable Earnings

A value should only be entered in the El Insurable earnings box when it is not
equal to zero or to the gross pay amount (Box 14). If no amount in entered, Box
24 will be left blank on the printed slip as required by CRA.

CPP/QPP, El, and PPIP Exempt Boxes
You may check one, two, or all three of the CPP/QPP, El and PPIP Exempt
boxes as appropriate for the current employee.

Do not check the CPP/QPP exempt box if you entered an amount in Box 16 or
Box 26. Check CPP/QPP exempt only if the earnings were exempt for the entire
period of employment.

Do not check the ElI Exempt box if you entered an amount in Box 18 or Box 24.
Check El exempt only if the earnings were exempt, or if they were not eligible for
the entire reporting period of employment.

Do not check the PPIP Exempt box if you entered an amount in Box 55 or Box
56. Check PPIP exempt only if the earnings were exempt, or if they were not
eligible for the entire reporting period of employment.

Do Not Adjust CPP/QPP, EI, and Boxes

Check one, two, or all three, of these boxes to indicate that this particular slip
should not be adjusted when the slips for this company are adjusted. This allows
you to adjust some slips while leaving others as entered.

Other Income

Record other income in the boxes provided at the bottom of the window. The
type code of the income should be indicated in the Boxes with the corresponding
Amounts directly beneath. Press F2 or double click the box field to display a list
of available codes. See your Tax Guide for a list and description of appropriate
type codes.

Amended T4s

Click on the check box labeled “Amended” to indicate that the T4 is an amended
one. This will cause the word "AMENDED" to be printed across the top of the
slip as required by CRA. It will also cause the slip to be included whenever the
“Amended only” option is chosen during printing of the T4 slips or the T4
Summary, and excluded when “Originals only” is chosen.
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Net Pay Calculation

The employee's net pay is calculated and displayed on the screen as you enter
data into each box of the T4 and may prove useful as an audit check. It will be
calculated in one of the two following ways:

Gross Pay - Standard Deductions - Other Deductions; or
Gross Pay - Standard Deductions - Taxable Benefits - Other Deductions.

The Gross Pay is the amount entered in Box 14. The Standard Deductions
include the values entered in Boxes 16, 17, 18, 20, 22, 44, 46 and 55. Note that
the Standard Deduction includes both provincial (Québec) and federal taxes.
Taxable Benefits is the sum of the “Amounts” boxes which represent taxable
benefits. Other deductions (if there are any) must be entered manually to arrive
at the appropriate figure for Net Pay.

. Net Pay Options E

Met Pay Calculation Method
Calculate net pay as emplopment income less:
&+ Standard deductions
(™ Standard deductions + taxable benefits
[~ Don't digplay net pay

Standard deductions are: CPP, QFF, El, PPIF, income tax, pension
plan contributions, chartable donations and union dues.

You can switch between these two methods of calculating the Net Pay by clicking
on the Net Pay button and then selecting the appropriate option. You can also
check the "Don't display net pay" to remove this information from the display.

Goto RL-1
Use this button to create and/or access the corresponding RL-1 for this
employee.
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T4PS Input Window

B3 File Company Forms Edit Reports Tools Setup Window Help =
|First Compary |D = M = OB M amme ~ | Adding slip 1
Employee's name and address _
R oo Ell
Address =
Restore
City # Province | oM
Postal code Country [ CAN
ear 12 Soc Ins Mumber — Stamys
30 Actual amt of 31 Tawxable amtof 32 Dividendtas 34 Capital gaing 36 Forfeited due
eligible dividends  eligible dividends  credit - eligible div. or lozzes 35 Otherincome  bo withdrawal
| 0.00] | | | | | 0.00] | 0.00] | 0.00]
24 Actual amtof 25 Taxable amtof 26 Dividendtax 37 Foreignmon- 38 Foreign capital 39 Foreign
non-eligible div. non-eligible div. credit - nor-eligble business income  gaing or losses hon-husiness tas
| 0.00] | | | | | 0.00] | 0.00] | 0.00]
Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Automatic Calculations

For the eligible dividends, the Taxable Amount of Dividends and the Federal
Dividend Tax Credit are calculated and displayed automatically by the system as
follows:

Taxable Amount of Dividends = (Actual Dividends) * 1.45

Federal Dividend Tax Credit = (Taxable Amount of Dividends) * 18.9655%

For dividends other than eligible dividends, the Taxable Amount of Dividends and
the Federal Dividend Tax Credit are calculated and displayed automatically by
the system as follows:

Taxable Amount of Dividends = (Actual Dividends) * 1.25

Federal Dividend Tax Credit = (Taxable Amount of Dividends) * 13.3333%

This calculation is suppressed for corporate recipients.

Recipient ID Number Validation

If the recipient is an individual, enter the recipient’s Social Insurance Number
(S.I.N.). For interest credited to a joint account, enter the S.I.N. of only one of the
individuals. If the recipient is not an individual, enter the first nine digits of the
recipient’s business number, if available. The T4 TimeSaver will check the
validity of the S.I.N. entered and display a warning if it is invalid. You can,




6-10 T4 TimeSaver User Manual

however, ignore the warning and continue to enter other information. The
formula used to test the value of the S.I.N. or business number is found in the
CRA Publication: Formulae for Federal and Provincial Deductions for Computer
Users.

Status
Indicate whether the current slip is an amended, duplicate, cancelled or
additional slip. Otherwise, this field can be left blank.
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T4A Input Window

5. Ele Company Forms Edit Reports Tools Setup Window Help — B x
|First Carmpary | O = dh S O & Mame ~ || Adding slip 1
Recipient’s name and address
Ta4 BLEEE Mag. Media 0K
Address
Restore
City / Pravince | OM |:| Go to BL-1
Fostal code Country | CAN Year
16 Pension ar 18 Lurmp-suni 20 Self-employed 22 Income tax 26 Elig. retiing 27 Mon-eligible

superannuation ayrnent COMMISZI0NS deducted 24 Annuities allowances retiing allowances
0.00 0.00] 0.00] | 0.00] | 0.00] | 0.00) 0.00)

30 Patronage 32 APP contr. 34 Pengion 36 Pension plan 40 RESP acc. 42 RESP educ.

28 Other income allocations [past service] adjustment registration no. income pymnts assist. papments
| D.DD| | D.DD| | D.DDl | D.DD| | | | u.nu| | u.nu|
46 Charitable 38 Footnote 14 Recipient's
donations 12 51N, codes 13 Business number  number
| 0.00] | | [ 3] Il |

Footnotes Recipient’s corporation or partnership name

IF entered, these fields will replace the name on the T44 slip.

Employee Name

The employee name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered. Pressing the F8 key will reverse the first and
last names (e.g. John Smith will be changed to SMITH, John).

S.I.N. Validation

The T4 TimeSaver will check the validity of the S.I.N. entered and display a
warning if it is invalid. You can, however, ignore the warning and continue to
enter other information. The formula used to test the value of the S.1.N. is found
in the CRA Publication: Formulae for Federal and Provincial Deductions for
Computer Users.

Footnotes

Text footnotes may be entered in the fields provided. These will be printed on
paper copies of the T4A. (Footnotes for use with Magnetic Media submissions
may be accessed by clicking on the Mag. Media command button in the top right
corner of the screen.) Type the word "amended" (in upper, lower, or mixed case)
in the footnote section to indicate that the T4A is an amended T4A. This will
cause the word "AMENDED" to be printed across the top of the slip as required
by CRA. It will also cause the slip to be included if you choose “Amended only”
when printing T4A slips or the T4A Summary and excluded when “Originals only”
is chosen.
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Goto RL-1

Use this button to create and/or access the corresponding RL-1 for this
employee, i.e. the RL-1 with the same social insurance number. There must also
be a corresponding T4 for the same employee with the province of employment
set to “QC".
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T4A-NR Input Window

(5. File Company Forms Edit Reports Tools Setup Window Help - X

|Firstl:0m|3an_l,l |D|D”'||M| @ Ih|.||k|lﬁ1|| |Name ﬂ Slip 1 of 1
Mon-resident recipient’s name and address _ oK
[T4A-NR] Name R 4—

Address Restore
Mor-resident's

service industry

City / Pravince | N clazsification code  Satye
Postal code Country | USA | 1 | 1

24 City, province code where services
rendered

16 Professional name

22 Tax deducted | 23 Redn

o9 [

14 Canadian 5IM

18 Groszincome | 20 Trawvel
| 0.00] || 0.00]

Year

26 Days in Canada

L]

12 Foreign 55 number

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Country of Residence

Enter the appropriate three character country code, or select it from the drop
down list, to indicate the country of residence of the recipient. See Appendix E
for a full list of the standard three character country codes.

Non-Resident’s Service Industry
Enter the four digit numeric code, or select it from the drop down list, indicating
the type of service industry.

Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.

City/Province where services rendered
Enter the city name, leave a space and then type the two character province
code for the province in which the services were rendered.

Days in Canada

Enter the total number of days the non-resident was in Canada during this
calendar year while under contract with the payer. Include weekends and
holidays.
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Professional Name

Use this box if the professional or operating name is different from the real or
legal name of the non-resident. For example, this box may be used when
payments are made to non-residents in the entertainment and athletic
professions.
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T4A(P) Input Window

(5. File Company Forms Edit Reports Tools Setup Window Help = ﬂ
[NEW COMPaNY DBl S| o& &[E] N '+ [ Adding slip 1
Employee's name and address
TA4AP | Name | ZIKIDL
Address ﬁ
Restore
City / Province | OM
Postal code Country | CAN
Tear Benefit Mumber Statusz
| | | | b
20 Taxable CPP 22 Income Tax
Benefits deducted 14 Retirement 15 Survivar
| o.00] | 0.0d| | 0.00] | 0.00]
UG ey 17 Child 18 Death 12 SIN 13 Effective date o1 Lo of
| 09| 0] | 00| | o]

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing

the F5 key. The T4 TimeSaver program will change the

surname to block letters,

ensure that the first letter of the first name is capitalized, and insert a comma if

none was entered (e.g. SMITH, John). Pressing the F8
and last names (e.g. John Smith will be changed to SM

Status

key will reverse the first
ITH, John).

Indicate whether the current slip is an amended, duplicate, or additional slip.

Otherwise, this field can be left blank.
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T4A(RCA) Input Window

B File Company Forms Edit Reports Teols Setup Window Help - ﬂ
[Fist Campary 0|z Bdal & oxl@w@E] [N /[ Adding sfip 1
Employee's name and address
TAARCA| Name EIIID]
Address —
Restore
City # Province | am
Postal code Courtry | CAN
“ear
12 Ref. of employer 14 Ref. of employes ) .
contributions contributions 16 Distributions 18 Selling price
| aon) | oo | [ | 0.0]
20 Other arnounts 22 Income tax 24 SN Status
| oog | o.og | | | 3

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
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T5 Input Window

B3 Flle Company Forms Edit Reports Tools Setup Window Help =
|First Company |D = i S oI B Mame + | Adding slip 1
Mame 1 T
Mame 2 Sl
Address Restore
Quebec RL-3
City / Province | oM FILE e 0K
Pastal code Country | CAM for this recipient Cancelled
Other Info i
Driginal Individual
21 Repart code 22 Recipient |D number 23 Recipient type
27 Foreign cumency 28 Transit 29 Recipient account Year
10 &ctual amtof 11 Tasable amtof 12 Dividend tax 13 Interestfrom 14 Otherincome 15 Foreign
dividends dividends credit Canadian sources  from Cdn sources  jncome
| o] | | | | | oo | 000 | 0.00
16 Foreign tax _ 18 Capital gainz 19 Accrued 20 Resource
paid 17 Rovalties dividends incame: Annuities  allow. deduction
| | | 0.00] | g 00| | 0.00)

24 Actual ambof 25 Taxable amtof 26 Dividend tax
eligible dividends eligible dividend:  credit - eligible div.

| 001] | | | |

Recipient Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered. Pressing the F8 key will reverse the first and
last names (e.g. John Smith will be changed to SMITH, John).

Recipient ID Number Validation

If the recipient is an individual, enter the recipient’s Social Insurance Number
(S.I.N.). For interest credited to a joint account, enter the S.I.N. of only one of the
individuals. If the recipient is not an individual, enter the recipient’s business
number, if available. The T4 TimeSaver will check the validity of the S.I.N.
entered and display a warning if it is invalid. You can, however, ignore the
warning and continue to enter other information. The formula used to test the
value of the S.I.N. or business number is found in the CRA Publication: Formulae
for Federal and Provincial Deductions for Computer Users.

Report Code
This code helps CRA determine if this is the original T5 slip issued to the
recipient, or if it amends the original.

Enter O, if this is the original slip.
Enter A, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).
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Recipient Type

Enter one of the following valid codes to identify the type of recipient:

1, if the investment income was earned by an individual

2, if the investment income was earned by a joint account (two individuals).

3, if the investment income was earned by a corporation.

4, if the investment income was earned by an association, a trust (fiduciary-
trustee, nominee, or estate), a club, a partnership, or other.

5, if the investment income was earned by a government, government enterprise,

or international organization.

Currency Code

If you cannot report amounts in Canadian dollars, identify the foreign currency
according to the 1ISO (International Organization for Standardization) 4217 Codes
for the Representation of Currencies and Funds. Enter the appropriate three-
letter alphabetical or three-digit numeric codes. If possible, use the alphabetical
codes. For example:

USD - United States, dollar
JPY - Japan, yen

SVC - El Salvador, colon

FRF - France, franc

HKD - Hong Kong, dollar

ITL - Italy, lire

DEM - Germany, mark

DKK - Denmark, kréne

GBP - United Kingdom, pound
ESP - Spain, peseta

Leave this area blank if you are reporting the amount in Canadian dollars. If you
must report amounts in different currencies in respect of the same recipient, use
a separate T5 slip for each currency.

Automatic Calculations

For the eligible dividends, the Taxable Amount of Dividends and the Federal
Dividend Tax Credit are calculated and displayed automatically by the system as
follows:

Taxable Amount of Dividends = (Actual Dividends) * 1.45

Federal Dividend Tax Credit = (Taxable Amount of Dividends) * 18.9655%

For dividends other than eligible dividends, the Taxable Amount of Dividends and
the Federal Dividend Tax Credit are calculated and displayed automatically by
the system as follows:

Taxable Amount of Dividends = (Actual Dividends) * 1.25

Federal Dividend Tax Credit = (Taxable Amount of Dividends) * 13.3333%

This calculation is suppressed for corporate recipients (recipient type 3).
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Relevé 3 Required

If a Relevé 3 will be printed for the current recipient, check the Relevé 3
Required box. You can then use the Go to RL-3 button in the top right corner of
the form to view and edit the Relevé 3 slip.

Note that Revenu du Québec has specified that where the recipient is a
corporation (i.e. the recipient type code is 3), the dividend income should be
entered on the RL-3 as Other income from Canadian sources (box E) and not as
Actual amount of dividend (box A). When adding a new T5 slip with recipient
type code of 3, any amount entered in box 10 will be added to income entered in
box 14 and will be carried over to box E of the corresponding RL-3 slip.
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T5013 Input Window (Plus version only)

1% 2007 T4 TimeSaver (Bobs Company) - [T5013 Slip] (=13}
B File Company Forms Edit Reports Tooks Setup Mindow Help BEES
WONDERFULWORLD 0F w0 | O3 || B[ 84| S| &% |®[@| [Neme ~ Slip 2 of 2
Partner's name and address Gota
M
Mame [JONES, Bob (1) Boxes 2027 | (5) Boves 150 | IKI
(2 Boes 34| (B) Other amounts s
Addiess [147 Main St
(@) Bores 2553 | () Other amounts Restore |
City # Prov. [Toronta [N 4) Bores 120 | (3 SCH 5D R
Fastal code. [MaH 6NS Couniay |_CAN —
07 County |05 Membercode | Loyr oinetehip |10 Parmers share | g gy, 11 Recipients id T3
el (%) of incomeloss I~ required for this
E Limited partrier [ o] [swoomn | || Y | [1+725ece3 | partrier
12 Complet shasing arangetents |
Limited partnstship net income (loss]
20 Linited patrership 201 Agriculburs] 21 Limited patrership 22 Limited psttnsrshin — 22-1 Livited prtrer's
Famting inccmes nnss] income statiliastionn  fishing incore finss]  bus. incoms (nss] staisk amourt
[ po | oo ] wog .| 0.0
Z2Uniedpatrels 73 Lintedpatiostip 24 Lmisopat oss 25 Provousoss
ot rick smount ertal income [loss) aryforward Cany torward 27 Ristum of capial
[ o0d | 0.0 \ [ [ | 0.00]
[ .| 0. [ oo 0.d

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Country Code

Enter the appropriate three character country code, or select it from the drop
down list, to indicate the country of residence of the recipient. See Appendix E
for a full list of the standard three character country codes.

Member Code

Enter one of the following valid codes to identify the types of recipient:
0, for a limited partner

1, for a specified member

2, for a general partner

3, for a limited partner’s exempt interest, or

4, for a nominee, agent, broker or advisor

Units held
Enter the number of partnership units, complete to all decimal places, held by the
partner.

Partner’s share (%) of income (loss)
This value will be calculated based on the Units or Interest Owned of all the
partners in the partnership.
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Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.

Recalculate

Click on this button to redistribute the amounts given on the summary, according
to each partner’'s share. You have the option of recalculating all fields, or only
those fields that have not been overridden.

GoTo

Use these buttons to switch between pages of input fields.

(1) Boxes 20-27: Displays boxes 20-27

(2) Boxes 35-34: Displays boxes 30, 34, 35, 37, 41 & 43

(3) Boxes 26-59: Displays boxes 26 & 50 - 59

(4) Boxes 120-: Displays boxes 119 to 145

(5) Boxes 150-: Displays boxes 150 to 155

(6) Other amounts: Displays boxes 70, 71 & 85

(7) Other amounts: Displays other amounts fields

(8) SCH 50: Displays the T5015 data fields and recipient code field

Recipient Code

Enter one of the following valid codes to identify the type of recipient:
1, for an individual

2, for a trust

3, for a corporation

4, for a partnership
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T5013 Sch 8 (T5014) Input Window (Plus version only )

I 2007 T4 TimeSaver (Bobs Company) - [T5014 Partnership CCA Schedule] 9 [=1[E
B Fls Company Forms [t Reports Tools Sstup Window Help - & x
WONDERFULWORLD 0F wi | [1 || B [ 84 @ |%|=|E]
T H 3 ) 5 B 7
Class number | Undepreciated | Castof addtions | Met adustments | Costor pioceeds | Undepreciated | 50% e for
capital cost at start | g fiscal period from disposal, capital cost Cunentyear
of fscal period whichever isless | (21+ () +-10)- (5| addiions
1 430000 000 00 000 30000 000
2
3
4
5
5 E] 0 T 2 6
Reduced Rate Recaptue of capta  Teminalloss | Captalcost  JCC at end o fiscal
Undepreciated % cost allowance allomnce (83 (9] | period [8) + (10]-
capital cost 5) - (7) ot lesset amount )12
| 1800 00) 10 20000 1800 00) Taz 00| 500
2
3
4
5
Totals
Roll forward Pagel | Page2 | Page3d oK Cancel

Class Number

Enter up to 15 different class numbers (1-5 on page 1, 6-10 on page 2, and 11-
15 on page 3). Class numbers range from 1 to 47. For a complete listing of valid
class numbers press the F2 key. The applicable rate will automatically be
entered into column 9 and be used in the capital cost allowance calculation.

Adjustments
Enter the corresponding adjustments. Increases to capital costs should be
entered as positive values, decreases as negative values.

Undepreciated capital cost
This value will be automatically calculated using the values entered in columns 2
through 5.
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T5013 Sch 50 (T5015) Input Window (Plus version onl y)

1% 2007 T4 TimeSaver (Bobs Company) - [T5013 Slip]

B3 File Company Forms Edit Reports Tools Setup Window Help

WONDERFULWORLD 07 wi | 12| B || S| | % |®a @] [Name

j Slip 2 of 2

Partner's name and address

Mame [JONES, Bob

Goto
1) Bowes 2027 | (5] Banes 150 | RIKIC

Address [147 Main 5t

[£] Boxes 35-34 | [E] Other amounts

| o

(3) Boxes 2653 | (2] Other amounts | Restore ‘
City / Prov. |Toronto ‘ ON (4) Bores 120- | [8) SCH 50 ‘ Recalcul
Pastal code [M3H BNG Country | CEN =
03 Partnership |10 Paitner's share Rt TE0134
07 Counlry |08 Member code | |y pelg B e s || e 11 Redpients id B el s
@ Limited partner | ™35 0000 | I MRS pattner

12 Camplex sharing arangements |

T5015 Information

Capital account start of period
Capital contributed during period
Other adjustments

Income allocated during period
Drawings

Capital account end of period

0.00

0.00

0.00

0.00

0.00

0.00

Recipient code

Individual

The top half of the form will already be completed if you have entered the T5013

information. Enter values for the Capital account start of period, Capital

contributed during period, Other adjustments, Income allocated during period,

and Drawings. The Capital account end of period will be automatically

calculated.

Recipient Code

Enter one of the following valid codes to identify the type of recipient:

1, for an individual
2, for a trust

3, for a corporation
4, for a partnership
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T5018 Input Window

E§. File Company Forms Edit Reports Tools Setup Window Help — = ﬂ
|Fir$t Caompany | ™ ‘ﬁ’r‘ ‘M‘ @ Iﬁ|.||ﬁ ‘ IEI‘ ‘ |Name ﬂ Adding slip 1
Reciment's name and address _
[ TS018 | Hame RIRTGL]

Address L
Restore
City / Province | ]
Postal code Country | CAM

22 Conshuction subcontractor papments Status
24 Recipient's id number [BM or SIM] |:|

Recipient type Farthership's filer 1D

Individual [ ]

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Construction subcontractor payments
Enter the total payment received by the subcontractor during the period specified
on the T5018 Summary.

Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.

Recipient ID Number Validation

If the recipient is an individual, enter the recipient’s Social Insurance Number
(S.I.N.). For interest credited to a joint account, enter the S.I.N. of only one of the
individuals. If the recipient is not an individual, enter the first nine digits of the
recipient’s business number, if available. The T4 TimeSaver will check the
validity of the S.I.N. entered and display a warning if it is invalid. You can,
however, ignore the warning and continue to enter other information. The
formula used to test the value of the S.I.N. or business number is found in the
CRA Publication: Formulae for Federal and Provincial Deductions for Computer
Users.
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T1204 Input Window

B3+ File Company Forms Edit Reports Tools Setup Window Help -5 X
|Filst Cormpany | O l= i =S x| & M arne ~ | Adding slip 1
Recipient’s buginess name and address

T1204] Name 1
114
MHame 2
Address Restore
City / Pravince | OM Statuz
Postal code Country | CAM | 1

Sole proprietor name Year
Last name First name Iitial

Government service contract payments

23 FRecipient type 82 Service payments only 84 Mired services and goods payments
12 Sole proprietor's S5.1.M. E1 Recipient's BM 86 Partnerzhip's filer 1D

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Status
Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.

Recipient Type Code

Enter one of the following valid codes to identify the types of recipient:
1, for an individual, other than a trust;

3, for a corporation; or

4, for a trust or a partnership
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Relevé 1 Input Window

. B3 Fle Company Forms Edit Reports Tools Setup Window Help = ﬂ
[NEWw COMPANY |02 #| S o G[E[E] A e v [ Adding slip 3
MNet pay
Employee name and address _
Narme | Incone [boxes A+0) 0.oo mnum
R1 Addiess Standard deductions 0.00 et Pay
Restore
City / Province | oc Other deductions n.oo 114 |
Postal code Country | TAN Net Pay 000 Goto T4
Other Information Footnotes Go to T4A
QPP pens. Code
WEEkzens 5200 [Box O] D
& Employrment B Employee's C Employes'z EI [ Penzionplan E Ouebec
inCorme QFF contribution  premium contributions income taxded.  F Union dues G QPP eamings
| 0.00) | 0.00| | 0.00) | 0.00) | 0.00) | 0.00| | 0.00
H Employee's ) J Private health K. Travelina N Charitable
QPP premiurm | QPIF eamings  plan prescribed zone L Other benefits M Commissions  donations
000 | nod| | 000 | 000 | 000 | 0.00] | 0.00]
F Multi-employer R Income situ,
0 Other income insurance plan 0 Deferred zalary  on reserve 5 Tipz received
| 0.00 | 0.00) | 0.00] | 0.00) | 0.00|
) Yo heal: and Wi Perzonal uze
T Tipz allocated U Phazed Retre.  accommodation of emplover's auta
| D.DD| | D.DD| | n_un| | n.nn|

A Relevé 1 will always be added when a T4 is created that has "QC" entered as
the Province of Employment. Conversely, a T4 will also be added automatically
for each Relevé 1 entered. Note that the Province of Employment is always "QC"
for any RL-1 created.

When you are adding a Relevé 1 or a T4, all the relevant values (dollar amounts,
name and address, etc.) are carried over to the corresponding form. Footnotes
and boxes that are specific only to the Relevé 1 or the T4 will not be carried over.
See Appendix F - Equivalent fields on T4 and Relevé 1 Slips for further details.

Employee Name

The employee name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters
and ensure that the first letter of the first name is capitalized (e.g. SMITH, John).
Pressing the F8 key will reverse the first and last names (e.g. John Smith will be
changed to SMITH, John).
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S.I.N. Validation

T4 TimeSaver will check the validity of the S.I.N. entered and display a warning if
it is invalid. You can, however, ignore the warning and continue to enter other
information. The formula used to test the value of the S.I.N. is found in the CRA
Publication: Formulae for Federal and Provincial Deductions for Computer Users.

QPP Pensionable Weeks

If you have selected "Adjust based on number of pensionable weeks" for the
CPP/QPP Adjustment Option on the T4 Adjustment Options tab of the
Company Information , a value must be entered into the input field "QPP
Pensionable Weeks". This field will default to 52 or 53 depending on the value
entered under Maximum Number of Pensionable Weeks, but you may override
this value for specific employees.

Footnotes
Text footnotes may be entered in the fields provided.

Net Pay Calculation

The employee's net pay is calculated and displayed on the screen as you enter
data into each box of the RL-1 and may prove useful as an audit check. It will be
calculated in one of the two following ways:

Gross Pay - Standard Deductions - Other Deductions; or
Gross Pay - Standard Deductions - Taxable Benefits - Other Deductions.

The Standard Deductions include the values entered in Boxes B, C, D, E, F, H
and N, plus Box 22 (Income tax deducted) of the corresponding T4. Taxable
Benefits is the sum of Boxes J, K, L, P, V and W. Other deductions (if there are
any) must be entered manually to arrive at the appropriate figure for Net Pay.

. Net Pay Options E

Met Pay Calculation Method
Calculate net pay as emplopment income less:
&+ Standard deductions
(™ Standard deductions + taxable benefits
[~ Don't digplay net pay

Standard deductions are: CPP, QFF, El, PPIF, income tax, pension
plan contributions, chartable donations and union dues.

You can switch between these two methods of calculating the Net Pay by clicking
on the Net Pay button and then selecting the appropriate option. You can also
check the "Don't display net pay" to remove this information from the display.
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Relevé 2 Input Window

B3 File Company Forms Edit Reports Tools Setup Window Help — 8 X
|This Carmpariy |D == =1 e LY Mame v | Adding slip 1
Employee name and address
Mame 1 |
118
Address Bemeficiary Mumber Restore
S o [
Postal cods CaM
Q E I— Cancelled

Other Information

i ) e Y — — 0

ear SN, SIN 2 Source of income Heleve code

D Refund RRSF

A Annuity B Eenefit C Other papments  Spouse E Death benefit

| 000 | 00| | oo | oo | 0.00]

F Refund RRSP

undeducted G Revocation H Other income | Deduction J o Taw withkeld at source
| 00y | | g | 0.00)

K. Income after L “Withdrawal M T ax-paid 0 “Withdraweal

death under LLP amounts under HEP

[ o00] | o] [ o00] | 0.00]

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Cancelled
Check this field if the slip has been cancelled.

Reléve Code

Enter O, if this is the original slip.

Enter 1, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).

Source of Income
Double clicking on the field or hitting the F2 key to view the complete list of
options.
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Relevé 3 Input Window

5. Ble Company Forms Edit Reports Tools Setup Window Help —|F X
|NEW COMPANY | O = #h = n & B Marie ~ || Adding slip 5
Recipient name and address

MNarme 1 Go to T5
Mame 2 ol
Address Restore
Quebec RL-3
City / Province | ac AL required 1] 4
Pastal code Courtry | CAN ' for this recipient Cancelled
Other Information Second Account
BT e— I B
Eeleve code SM. Recipient type code Fecipient D number
I:I l:l Individual
Currency code Bark transit 'ear
Before March 24, 2008 Savings bonds
A1 Actual amt of A2 Actual smt of B Taxable amt of L Federal dividend [ Interest fram Cdh
eligible dividends ardinary dividends dividends tax credit sOUMCE:
| D.DD| | u.uu| | | | | | 0.00|
E Other income F Gross foreign G Foreign income | Capital gains
from Cdn sources income (= H Royalies dividends
| 0.00] | 0.00] | 0.00] | 0.00] | 0.00]
J Acciued income;
Antuities

Recipient Namel and Name 2

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized (e.g. SMITH, John), and
insert a comma if none is entered. Pressing the F8 key will reverse the first and
last names (e.g. John Smith will be changed to SMITH, John).

In the case of joint accounts, enter the name of the second account holder in the
Name 2 box. The same formatting rules and options apply to this box.

Social Insurance Number

If the recipient is an individual or holder of a joint account (recipient type codes 1,
2, 6 and 7), enter the recipient’s Social Insurance Number (S.I.N.). For holders of
a joint account, enter the S.1.N. of one of the individuals in this box and enter the
other individual’'s S.I.N. in the Second Account area. If the recipient is not an
individual (recipient types 3, 4 or 5), this box will be unavailable. T4 TimeSaver
will check the validity of the S.I.N. entered and display a warning if it is invalid.
You can, however, ignore the warning and continue to enter other information.
The formula used to test the value of the S.I.N. is found in the CRA Publication:
Formulae for Federal and Provincial Deductions for Computer Users.
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Other ID / Recipient number
If the recipient is not an individual (recipient type 3, 4 or 5), enter the NEQ or
other identification number here. The value entered in this box is not validated.

Cancelled
Check this field if the slip has been cancelled.

Relevé Code
This code determines if this is the original RL-3 slip issued to the recipient, or if it
amends the original.

Enter O, if this is the original slip.
Enter 1, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).

Recipient Type Code

Enter one of the following codes to identify the types of recipient:

1 - an individual (other than a trust)

2 - ajoint account (two individuals)

3 - a corporation

4 - an association, a trust (bankruptcy trustee, mandatory or succession), a club,
or partnership

5 - a public body (municipality, government agency, etc.)

6 - the spouse of the settler of a trust or for the spouse of the deceased person

7 - one of the holders of a joint account other than the holders covered by code 2

Automatic Calculations
The Taxable Amount of Dividends and the Federal Dividend Tax Credit are
calculated and displayed automatically by the system as follows:

Taxable Amount of Dividends = the sum of 145% of eligible dividends (box Al)
and 125% of ordinary dividends (box A2)

Federal Dividend Tax Credit = the sum of 17.25% of eligible dividends (box Al),
13.54% of ordinary dividends received or deemed received before March 24,
2007 (Box A2) and 10% of ordinary dividends received or deemed received
after March 23, 2007 (Box A2).

This calculation does not apply for corporate recipients (recipient type 3).

Note that Ministére du Revenu has specified that where the recipient is a
corporation (i.e. the recipient type code is 3), the dividend income should be
entered as Other income from Canadian sources (box E) and not as Actual
amount of dividend (box A). When adding a new RL-3 slip with recipient type
code of 3, any amount entered in box E will be assumed to be dividend income
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and will be carried over to box 10 of the corresponding T5 slip. If the income is
not dividend income, you can edit the T5 appropriately.

Currency Code

All amounts entered on a RL-3 slip should be in Canadian dollars. If this is not
possible, enter the corresponding currency code according to international
standard 4217 of the International Organization for Standardization (ISO). Enter
the appropriate three-letter alphabetical or three-digit numeric codes. If possible,
use the alphabetical codes. For example:

USD - United States, dollar
JPY - Japan, yen

SVC - El Salvador, colon

FRF - France, franc

HKD - Hong Kong, dollar

ITL - Italy, lire

DEM - Germany, mark

DKK - Denmark, kréne

GBP - United Kingdom, pound
ESP - Spain, peseta

If you must report amounts in different currencies in respect of the same
recipient, use a separate RL-3 slip for each currency.
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Relevé 17 Input Window

F3- File Company Forms Edit Reports Tools Setup Window Help -8 X
[This Carnpany | O | = i S| ol B Mame ~ || Adding slip 1
Emplopee name and address
RE N
R17 0K
Address Restme
City # Province | ac Status
Postal code Countr}ll CAN | 1

Other Information

‘rear

SLM. Reference number

B Taotal income for - © Totalincome for - O Living allowance E - Living allowance

A Total deduction  the year the stay for the year for the stay

u.nu| | u.un| | u.un| | u.nc|| | 0.00

F Days outside G 30-day periods
Canada for the pear  outzide Canada H Cate departure | Date retun J Foreign country

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Status

Indicate whether the current slip is an amended, duplicate, or additional slip.
Otherwise, this field can be left blank.
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Relevé 25 Input Window

5. Flle Company Forms Edit Reporis Tools Setup Window Help _ = x
|This Compary | == th S| Ol & Mame ~ | Adding slip 1
Employee name and address

Mame 1 ||
R25 0K
Address Beneficiary Number Restore
City # Province | ac ———
Poztal code Country | CAN Enefielary e
I [ Indivicusl
Other Information
| | | [5Y origina
Year SN, Mames of principal person Bank transit  Releve code
Cancelled
& Actual C Capital gains for D Other amaont E Cancelled
Dividends B Capital Gaits exemption allocated or paid allocations
| .00 | 0.00] oo | 0.00] | 0.00
F Tarable G Dividend tax H Foreign | GQuebec
dividends credit income kax income tax
| 000 | 000 | 0.00) | 0.00]

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Beneficiary Type

Enter one of the following valid codes to identify the type of recipient:

1, if the beneficiary was an individual

2, if the beneficiary was a joint account (two individuals)

3, if the beneficiary was a corporation

4, if the beneficiary was an association, a trust (fiduciary-trustee, nominee, or
estate), a club, a partnership, or other

5, if the beneficiary was a public body, municipality, or government agency

6, if the beneficiary was the spouse of the settler or of the deceased

Reléve Code
Indicate whether the current slip is an amended or amended slip.

Enter O, or leave blank, if this is the original slip.
Enter 1, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).

Cancelled
Check this field if the slip has been cancelled



6-34 T4 TimeSaver User Manual

Relevé 15 Input Window

Partner's name and address Goto _
Mame || [1] Bozes 1-15 | [8] Tax Shelter mm
(2] Baxes 16-27 | (B) Flow-thru 0K
Address - i
[3] Boxes 28-37 | (7] Detailz Restore
Gl | [4] Boxes 38-41
iy /e, Recalculate
Postal Country | CAN
Fepart cade | SIM or other id. number Partterzhip id. number
Bozes 1 -15
1 Met Cdn / foreign 2 Met foreign 3 Met Cdn / foreign 4 Met foreign rental 5 Capital cogt
buz. income [lozs) buziness income rental income [lozs) Income [losz) allowance
| oog | ooy | 0.0q] | 0.00) | 0.0
B& Actual amount of BB Actual amount of 7 Intersst from 8 Foreigh dividends 9 Pabronage dividends
eligible dividends ordinary dividends Canadian sources and interest from co-operative
ooy | nog | oog | nog | 0.0q]
10 Cap. gains/loszes 11 Reserves re. 12 Cap. gains / losses 13 Business 14 Gross income /
uzed ... exemption dispositions nok ... exempion investment losses loss of partnership
| 0.0 | oo | oog | ooo] | 0.00)
154 Camying 158  Dividend rental
charges arrangement compensation
| oog | 0.00)

Name

The recipient name should be entered with the surname first, followed by a
comma, and then the first name. The name can be formatted easily by pressing
the F5 key. The T4 TimeSaver program will change the surname to block letters,
ensure that the first letter of the first name is capitalized, and insert a comma if
none was entered (e.g. SMITH, John). Pressing the F8 key will reverse the first
and last names (e.g. John Smith will be changed to SMITH, John).

Report Code
This code helps MRQ determine if this is the original RL-15 slip issued to the
recipient, or if it amends the original.

Enter O, if this is the original slip.
Enter A, if this is an amended slip (this slip changes the financial or identification
information of a slip previously submitted).

Boxes 1-36

These fields will be automatically filled based on the partner’s share of the net
income or loss and the amounts given on the TP-600 summary. To override a
calculated value, press the F4 key and then type in the desired value.

Box 37
Enter the number of units held by the partner, complete to all decimal places,
held by the partner.
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NOTE: These values will be displayed on the Partners page of the TP-600 and
used to distribute the summary values amongst the partners on the RL-15 slips
for each partner.

Partner Code (Box 40)

Enter one of the following valid options:
0, for limited partner

1, for specified partner

2, for general partner

Recipient Code (Box 41)

Enter one of the following valid options:
1, for an individual

3, for a corporation

4, for a trust or partnership

Recalculate

Click on this button to redistribute the amounts given on the summary, according
to each partner’s share. You have the option of recalculating all fields, or only
those fields that have not been overridden.

GoTo
Use these buttons to switch between pages of input fields.
Boxes 1-15: Displays boxes 1-15

Boxes 16-27: Displays boxes 16-27

Boxes 28-37: Displays boxes 28-37

Boxes 38-41: Displays boxes 38-41

Tax Shelter: Displays tax shelter boxes 50-55
Flow-thru: Displays flow-thru boxes 60-66
Details: Displays details field for text
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Chapter 7 - Adjusting T4s and Relevé 1s

Making adjustments to T4s and RL-1s

There are two methods of adjusting the T4s and RL-1s. The first method is to
use the Adjust this T4/R1 icon (or select Adjust/unadjust this T4/R1 from the
Edit menu) to adjust only the current employee. The adjustments will be made
based on the adjustment options selected for the current company. These
adjustments will not be reflected in the corresponding T4 summary, unless all of
the slips are adjusted.

The second method is to adjust all of the employees for the company at once.
To do this, select Adjust/unadjust company’s T4s/R1s  from the Company
menu. You can skip any individual slips that you may not want to adjust by
checking the Do not adjust CPP/QPP, EI and/or PPIP box(es). The
adjustments will be made based on the same adjustment options selected for the
current company. In this case the adjustments are reflected in the corresponding
T4 Summary.

An adjustment report can be produced by checking the Print adjustment report
option on the Adjust all T4s/R1s window before clicking the Do adjustments
button. Or you can select the Adjustment report from the T4 or RL-1 submenus
of the Reports menu. In either case an Adjustment Report window will open.
See Printing Adjustment Reports in chapter 9 for further details.

Reversing Adjustments

Reverse the adjustment on an individual T4 or RL-1 by clicking on the Adjust
this T4/R1 icon (or select Adjust/unadjust this T4/R1  from the Edit menu)
again. The CPP, QPP, EI, PPIP and tax will return to the originally entered
values.

The adjustments on all of the slips for the company can be reversed by clicking
the Undo Adjustments button on the Adjust all T4s/R1s window.

Setting Adjustment Options

The adjustment options for each company are stored with the company profile.
Select Edit company information  from the Company menu and then click the
T4 Adjustment Options tab. You can make any changes necessary for
individual companies, and also enter the S.I.N. number of the employee to
receive the transfer of over remittance of CPP/EI, if you choose.

If you are entering data for more than one company, you may want to select the
appropriate options on the T4 Adjustment Defaults tab in the Setup menu.
These global default options will then be used for each new company you setup.
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NOTE: DEFAULT VALUES ENTERED IN SETUP WILL BE REFLE CTED IN
NEW COMPANIES ONLY. TO CHANGE VALUES IN EXISTING COMPANIES,
SELECT EDIT COMPANY INFORMATION FROM THE COMPANY ME NU.

T4 Adjustment Options ]

CPP/OQFPP Adjustment Options Transfer Over Remittance

v Adiust i over masimumAundsr required mirimun Transfer over remittance of CPP/E] to employee with the following 5.1.M.
[ Adjust based on number of pensionable weeks I:I

M aximum rumber of pensionable weeks I Increaze gross pay of above emplaves by amount of over-remittance
El Adjustment Options Other Options

v Adjust El premiums i over annual masimurn Adiust CPP/EI/QRIP differences areater than

W Adiust El premiums based on insurable earnings [ Adjust CPREIGPIP to calculated amounts even if there is insufficient

[ Adjust insurable earmings based on E| premiums tax to offset the adiustment

L ]

QPIP Adjustment Optionsz
v Adiust OPIP premiums if over annual masimum
v fdiust OPIP premiums based on insurable eamings

[ Adjust inzurable earmings bazed on QPIP premiums

oK Cancel Uzer Defaults

CPP/QPP Adjustment Options
A - Adjust CPP/QPP if over maximum/under minimum
If this option is selected, CPP/QPP will be adjusted to fall within the range:

Upper Limit: the lesser of:
- the CPP/QPP pensionable earnings x 4.95%;
- and $2,049.30

Lower Limit: the lesser of:
- (the CPP/QPP pensionable earnings - $3500) x 4.95%;
- and $2,049.30

If the CPP/QPP deducted is greater than the Upper Limit, it will be adjusted down
to the Upper Limit. If the CPP/QPP deducted is less than the Lower Limit, it will
be adjusted up to the Lower Limit. If the CPP/QPP deducted falls within the
range of the Upper and Lower Limits, no adjustments will be made to CPP/QPP.

This option ignores any potential reduction resulting from the annual CPP/QPP
basic exemption which must be prorated based on pensionable weeks as
outlined below. This option was implemented for situations where it is not
desirable to enter the number of pensionable weeks on each T4 slip.
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B - Adjust CPP/QPP based on number of pensionable w____eeks
If this option is selected, CPP/QPP will be calculated as:
(CPP/QPP pensionable earnings - prorated deduction) x 4.95%
Where the prorated deduction is calculated as:
(number of pensionable weeks / maximum number of pensionable weeks) x $3500

NOTE THAT ONLY ONE OF A OR B MAY BE SELECTED.

C - Maximum number of pensionable weeks

This number is the number of weeks in the employer's fiscal year and is used in
the above calculation to prorate the CPP/QPP basic exemption. The default
value is 52 weeks but can be changed to 53 weeks if required.

El Adjustment Options

D - Adjust El premiums if over annual maximum
If this option is selected, the EI will only be adjusted if it is greater than:

- standard annual maximum of $41,100 x 1.39% or $571.29 for employees with
Québec as their province of employment

- standard annual maximum of $41,100 x 1.73% or $711.03 for all other
provinces

NOTE THAT THIS OPTION CAN BE SELECTED ALONE OR WITH E ORF

E - Adjust El premiums based on Insurable Earnings
If this option is selected, the EI will be calculated as:

- El insurable earnings x 1.39% for employees with Québec as their province of
employment

- El insurable earnings x 1.73% for all other provinces.
(If E.I. insurable earnings are not entered, gross pay will be used.)
F - Adjust insurable earnings based on EI premiums

This option assumes the entered amount for El deducted is correct. When this
option is selected, El insurable earnings will be calculated as the minimum of:

- El deducted (box 18) / 1.73% (or El deducted (box 18) / 1.39% for Québec);
- $41,100; and
- Employment income (box 14).

NOTE THAT ONLY ONE OF E OR F MAY BE SELECTED
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QPIP Adjustment Options

G - Adjust QPIP premiums if over annual maximum
If this option is selected, the QPIP will only be adjusted if it is greater than:

. standard annual maximum of $60,5000 x 0.45% or $272.25

NOTE THAT THIS OPTION CAN BE SELECTED ALONE ORWIT HE OR F

H - Adjust OPIP premiums based on Insurable Earning s
If this option is selected, the EI will be calculated as:

- QPIP insurable earnings x 0.45%
(If QPIP insurable earnings are not entered, gross pay will be used.)

| - Adjust insurable earnings based on QPIP deducte  d

This option assumes the entered amount for QPIP deducted is correct. When
this option is selected, QPIP insurable earnings will be calculated as the
minimum of:

- QPIP deducted (box 55) / 0.45;
- $60,500; and
- Employment income (box 14).

NOTE THAT ONLY ONE OF E OR F MAY BE SELECTED

Transfer Over Remittance

J - Transfer employer’s over remittance of CPP/QPP__ or El to the following
employee

When adjustments reduce total deductions for the company, the employer’s
portion of the over-remittance may be transferred to the tax of an owner or
shareholder.

If a S.I.N. is entered here, then any net overpayment of CPP/QPP and El
resulting from adjustments calculated by the program will be credited to the tax
deducted for the T4/RL-1 of this employee. This adjustment will be reflected in
the adjusted tax on the Adjustment reports for the particular employee.
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K - Increase the gross pay with over remittance

If an over remittance is created by the adjustments and you indicate that you
want the over remittance to be transferred to one employee (i.e. an owner or
shareholder), you may also increase the gross pay of that employee in order to
keep the net pay at the same level. If this option is chosen and the transferee’s
CPP/QPP is under the maximum deduction for the year, the CPP/QPP will NOT
be adjusted again for this underpayment.

Other Options

L - Adjust CPP/EI/QPIP differences greater than

If an amount is entered in this box, an adjustment to CPP/QPP El or QPIP must
be greater than this threshold in order for the adjustment to be made. If the
difference between the calculated amount and the entered amount for CPP/QPP,
El and QPIP is less than or equal to the threshold, no adjustments will be made
and the entered amounts for CPP/QPP, EIl, QPIP and tax will appear on the T4
slips.

M - Do you want CPP, El & OPIP to be adjusted to t _heir calculated amounts
even if there is insufficient tax to cover the diff erence?

If this option is selected, it will adjust CPP/QPP, El and QPIP to their calculated
amounts although there may not be sufficient tax to make up the difference.

Where there is insufficient tax to cover the net adjustment to CPP/QPP, El and
QPIP, this difference will be posted to the T4 Summary. The shortfall is
comprised of the increase in the employer’s portion of CPP/QPP/EI/QPIP and the
increase in the employee’s contribution which was not offset by tax. The
employer will have to make up the difference when filing the Summary. It would
then be up to the employer to collect the under-contributed employee’s portion
from the employee.

K - Enter the maximum amount by which tax may be re  duced

If item M was selected, you may enter the maximum amount by which tax may be
reduced. This option prevents the tax from being decreased to zero. For
example, if you only wanted tax to be decreased by a maximum of $100, enter
$100 in this field.
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Chapter 8 - Entering Summary Form Information

From the main menu select Forms and then select the type of Summary you
wish to view (or click on the Go to summary icon from the toolbar while editing a

slip).

All values that can be calculated from the information entered onto the slips will
appear on the summary form in blue. The remaining values will need to be
entered manually. These will generally appear as white boxes and the cursor will
move from one to the next, skipping the calculated values. See the specific form
and field below for more information.

Overriding Calculated Values

If it becomes necessary to edit a calculated field you may do so by pressing the
F4 key. The background colour of the field will change to indicate the value is no
longer the calculated value and you will be able to enter the desired value. To
return to the calculated value, click the Recalculate button.
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NR4 Summary

B File Company Forms Reports Tools Setup Window Help _ 8| x
[NEW COMPANY 0= B # S

HR4 Summary Information
Year ending Dec. 31, | Estates/trusts fizcal vear end

Filing az TS0 Code

disburging
e [ ]

Mon-regident account no.

HR4 Slip Totals

Tatal number of MR slips - Bax B8 o Reported tax withheld - Box 22 0.00
Reported gross income - Box 18 0.00 Unreported tax withheld - Box 28 0.00
Unreparted qross income - Bax 26 0.00 Total tax withheld [22+28] - Box 32 0.00
Total gross income [18+26) - Box 20 0.00 inug: remittances - Box 82 0.00

0.00

Balance due/[0verpayment]

Person to contact about this return

| | | | Data entry complete
Mame Telephone number

Lertification

Poszition or office Telephone number Date Printed

More Info

0K

Non-resident Account Number

Enter the account number under which non-resident tax deductions are remitted.
This number has to match the account number shown on the remittance part of
Form NR76, Non-Resident Tax - Statement of Account.

Unreported Gross Income
Add the gross income reported on Forms NR601 and NR602.

Unreported Tax Withheld
Add the non-resident tax amounts reported on Form NR601.

Remittances
Enter the amount of money already remitted to CRA.

Person to contact about this return

The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.
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Recalculate
Recalculates the calculated values, returning overridden values to the calculated

value.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media

if applicable.
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T4 Summary

B Fle Company Forms Reports Tools Setup Window Help = ﬂ

First Company |D|EF:||M| = | | || | J
T4 Slip Tatals [Page 1]
T4 dlips filed for USA employess.................... 0 Employes's CPP contribution.......... 0.00
Total number of T4 slhips fled................ 5 Employer's CPP contribution........... 0.00
Employment income before deductions.......... 340.000.00 Emplopee's El premiums........ 1.800.00
Feqistered pension plan contributions............ 0.aa Ermployer's El premiums..... 252000

Penzion adjustment, Q.00 Employes's PPIP premiums............ 30,00

El inzurable @amMings. .....ooovooveoovereeeeee 195,000.00 Employer's PPIP premiums. ........... E99.60

PFIF inzurable earmings............................. 120,000.00 Ihcome tax deducted....o. 45,000.00
Total deductions reported...... a0.043.60
Miuis: 1emittances...............o...... 0.o0

Slips are unadjusted. The NS IBMIanGes BN 4G.E0

totals represent the Balance due[Overpayment]......... i

unadjusted values entered Amount enclosed.... 0.00

by the user.

[ Data entry complete Page 1 Page 2 More Info 0K ‘

Remittances
Enter the amount of money already remitted to CRA.

Amount Enclosed
Enter the amount to be enclosed with the T4 Summary form.

Adjustment Status

The T4 Summary will reflect the adjusted values as long as all of the employees
for the company have been adjusted. If, however, only some of the slips have
been adjusted using the Adjust this T4/R1 icon, the summary will reflect the
unadjusted values for all of the employees.

Data entry complete

Once all of the data has been input for a given company, check the data entry
complete box. This will allow you to print reports that will include only the
companies that are completed, or conversely, only the companies that are not
completed. See Using Filters in Chapter 9.

Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

Page 2
Contains the rest of the information required for the T4 Summary.
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B Ble Company Forms Reports Tools Setup Window Help — = H
|First Compary | O |ﬁ| |M| = | | | | | J
T4 Summary Information [Page 2]
SIMN of proprietorfowner
Person to contact about this return Certification
A — | |
Surname| | Mame and sumame [in capital letters)
Ext. | | -
F'hone| | | | Pasition or office D ate Printed
[ Data entry complete | Page 1 ‘ Page 2 | More Info 0K ‘

Person to contact about this return

The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4A Summary

B3 Ble Company Forms Reports Tools Setup Window Help — = ﬂ
Firzt Company | D|ﬁ||ﬂ| = | | || | J
T4A Slip Totals [Page 1]
Tatal T44 slips far US emplayees. ... 0 Pension adjustment................ 34 0.00
Total number of T4& dlips filed.....88 2 RESF accum. income payments..40 0.00
Pension ar supsrannuation.......... 15 55,000.00 RESP educ. assist. payments..... 42 0.00
Lumnp-sumn payments.................... 18 0.oo Tatal tax deductions reported........ 22 30.000.00
Self-employed commizsions..... 20 0.oo tinusz: remittances. ... a2 0.00
. 0.o0
ARNUIHES. ... 24 Balance dus/[Overpapment]. . 30.000.00
Retiing allowances................ 26 0.00
Maon-eligible retiing allowances....27 0.00 ALY AT et
Other lbeome.. ... 23 18.000.00
Patronage allocations................ 30 0.0o
Pension plan contributions.......... 32 0.00
I Data entry complete ‘ Page 1 ‘ Page 2 ‘ More Info | 0K |

Remittances
Enter the amount of money already remitted to CRA.

Amount Enclosed
Enter the amount to be enclosed with the T4A Summary form.

Recalculate

Recalculates the calculated values, returning overridden values to the calculated
value.

Page 2
Contains additional information required for the T4A Summary.

E3- Fle Company Forms Reports Tools Setup Window Help -5 X
First Cormpary | O = i =
T4A Summary Information [Page 2)
Rey. Canada-izsued numbers for RPP or DPSP S1IMs of proprietors / owners
Person to contact about this return Certification Year
First name | | | | | |
SUIETE l:l Mame and surmame [in capital letters)
Telephone | | | |
% extenzion Pozition or office Date Printed

Data entry complste Page 1 Page 2 More Info (114
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Person to contact about this return

The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

More Info

Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4A-NR Summary

B File Company Forms Reports Tools Setup Window Help — | ﬂ
First Company |D|@||M| =] | | || | J
T4ANR Slip Totals
Tatal T44NF slips fled - Box 88 Bl Total tsx deductions - Box 22 o.od
Grogs income - Box 18 0.00 iz remittances - Box 82 0.00
Travel expenzes - Box 20 0.00 Balance due{0verpayment] 0.0
Amount enclozed 0.00
Person to contact about this return Certification
N | |
SRS | | MName and surname [in capital letters]
e [ | B |
Position or office Drate Printed
SIMsz of proprietors or principal owners Year

I Data entry complete

| More Info aK

Remittances
Enter the amount of money already remitted to CRA.

Person to contact about this return

The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4PS Summary

B3+ File Company Forms Reports Tools Setup Window Help _ 8| x
|First Compaty |D = i =

T4P5 Summary Information

Year ending Dec. 31, Mame of emplopee profit-zharing plan

T4PS Slip Totals

T4PS zegment forms - Box 51 0 Other income - Box 35 0.0
Mumber of T4PS slipz - Box 53 0 Farfeited dus ta withdrawal - Box 36 0.00
Actual non-eligible dividends - Box 24 0.00 Foreighn non-buziness income - Box 37 0.00
Actual eligible dividends - Box 30 000 Fereign capital gains o losses - Box 38 0.00
Capital gainz or loszes - Box 34 0.00 Foreign non-busineszs income tas - Box 39 0.00

Perzon to contact about this return

| | | Data entry complete

Mame Telephone number
Lertification
Hame More Info
| | ] oK
Pazition or office D ate Printed

Year ending
Enter the year being reported

T4PS seament forms
If you have created segment forms, enter the number here. Segment forms are
not required if you are filing electronically.

Person to contact about this return

The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T4A(P) Summary

B3 Fle Company Forms Reports Tools Setup Window Help = ﬂ
e CovPERY D[\ E(a] &) &% @[E| 4] =
'ear
T4AP Slip Totals
Tatal fumber of T44P zlips I Tatal zurvivor benefit 0.00
T axable CPP benefits 0.00 Total disability benefit 0.00
Tatal income tas deducted 0.00 Total child benefit 0.0a
Tatal retirement benefit 0.00 Total death benefit 0.00

Perzon to contact about this return

HEE

Certification

Fosition or office

T elephane number

Telephone nurmber

Date Printed

| I Data entry complete

More Info

(118

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information

at this time.

More Info

Contains the company category, printing dates, and date filed by Magnetic Media

if applicable.
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T4A(RCA) Summary

B Fle Company Forms Reports Tools Setup Window Help = H
[NEw COMPAHY D3| B & ofxmmE]a] El
T4A-RCA Summary Information
Year Mame of RCA, trust

T4A-RCA 5lip Totals

Total number of T4A-RCA slips - Box 88 0 Other amounts - Box 20 0.00
Refund of emplayer contributions - Box 12 0.00 Income tax deducted - Box 22 0.00
Fefund of emplopes contributions - Box 14 .00 inug remittances - Box 82 0.00
Diztributions - Box 16 o Balance due0verpayment] 0.00

Selling price of an interest in RCA - Box 18 0.0a Amount enclozed 0.00

Person to contact about thiz return

First name Surnarme Telephone number [~ Data entry complete

Certification

Mame and surname (in capital letters] More Info

i

Positian ar office Date Printed o8

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T5 Summary
E3: Fle Company Forms Reports Tools Setup Window Help -5 X
First Company |D = i =
T5 Summary Information
Infarmation return for year l:l Filer identification l:l Language of choice far v English
ended December 31, number cormespondence. French

IF this iz an amended TS summary, If thiz iz an additional TS summary, | [ [f you have filed a T5 information

check here. check here. return betore, check here.

T5 Slip Totals

Toatal number of TS slips................... 0  Faoyalties from Canadian sources............. 0.00

Actual dividends - non-eligible....... 0.00|  Capital gains dividends................cc.ooooee. 0.00

Taxable dividends - non-eligible........... 0.00|  Accrued income : SnRUHES. ..........coocoooe.... 0.00

Federal dividend tax credit................... 0.00|  Eligible far rezaurce allowance ded'n........ 0.00

Interest from Canadian sources.......... 0.00 Unclaimed amounts--dividends and interest 0.00

Other incame from Cdk sources.......... 0.00)  Ta deducted from unclaimed amounts...... 0.00

Foreign inSome. ...........coooovereereens 0.00|  Actual amaount of eligible dividends............ 0.00

Fareign tax paid..................... 0.00  Taxable amount of eligible dividends.......... 0.00
Dividend tax credit for eligible dividends..... 0.00

Perzon to contact about this return

| | | | Data entry complete
MHame Telephone number
LCertification More Info
| | | | oK
Authorized person Poszition or office Drate Printed

T5 Summary Information

Fill in the year, filer ID number, language choice, and indicate whether it is an
amended or additional Summary. Also indicate if you have filed a T5 Summary
before.

T5 Slip Totals
You must enter the unclaimed dividends and interest, and the tax on this
unclaimed amount.

Person to contact about this return

T4 TimeSaver will automatically use the data entered in New Company Defaults
in the Setup menu when the company was first created. You can, however,
change the information if required.

Certification

T4 TimeSaver will automatically use the data entered in New Company Defaults
in the Setup menu when the company was first created. You can, however,
change the information if required.

Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T5013 Summary

The T5013 Summary has multiple pages. Across the top of the screen there are
seven tabs: one for each of the five “Areas” on the T5013 summary, one for
“Additional Amounts for Allocation” and one for “Partners”. Each tab has up to
three pages of data entry screens. Most of the data entry fields appear exactly
as they appear on the T5013 Summary. See the 2008 Guide for the Partnership
Information Return for full details on the completion of the T5013 summary.
Listed below are some of the fields that may require some additional explanation.

Area A: ldentification, Page 1

IZ 2007 T4 TimeSaver {Bobs Company) - [T5013 Summary] [ (=1E3]
B File Company Forms Edi Reports Tools Setup  Window  Help HEE]
[WONDERFILWORLD 0F wi | [ [i5| B |da| & o=

& identification: 1 B-General | C1-Totals | C2-Totaks | D -Misc | E - Checklist | F - Cettfication | Partners

Section A - Identification

=

Fizcal period hum:l | To: ‘ |

Partnership’s filer identification number [ NN
Tax shelter identification number T§ |:|

Have you filed a partnership return before? vV | yes, for what year.  |2006 Amended T5013 Summary [
Additional T5013 Summary |

[ ]

Partnership name and address:

Mame "+ ONDERFUL WORLD OF WOODEN BLOCKS
Care of
Address 123 Main Street

City / Prow.  (Mytawn ‘DN
Postal code [L14 283 Country|CAH State] ] U5 Zipcode

Address on last return, if different from present:
Address
City / Prow.

|
Pastal code Country |CAN State LS. Zip code -|

[™ Data entry complete Recalculate ‘ More Info ‘ OK

Fiscal Period
Enter the beginning and ending dates of the fiscal period.

Status
Check the appropriate box if this is an amended or additional T5013 Summary.
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Area B: General

L%/ 2007 T4 TimeSaver (Bobs Company) - [T5013 Summary]

&' Fle Company Forms ©

[WanDERFUL woRLD 0F wa | [ [ 2|44 S|

Reports Tools Setup Window Help

|6¢ s =

Section B - General Information

L]
L]

071 - Humber of T5013 slips
Mumbes of TH 34 slips

02 - Type of partners: Individuals, other than a tust [ Trusts [ Corporations [ Partnerships [
03 - Type of end members: Individuals, other than a tust [ Trusts [ Corporations [

04 - Partrership's piircipal

Business activly ] nacscode[ ]
05 - s this the final information return for the partnership? r

08 -%Was the partnership inactive throughout this fiscal period? [

07 - Language of choics for correspondence. Engish ™
French [~
I~ Data entiy complete Recalculats | More Info oK

Area C1: Totals (Net Income/Loss)

&9+ Fle Company Forms =

e ern | D |52 4] &

IZ 2007 T4 TimeSaver (Bobs Company) - [T5013 Summary] (=13
g X

Reports Tools Setup Window Help

|5 @] El

Section C — T5013 and T50134 Slip Totals
Limited partnership net income (loss)

Linited partnership faming income (loss)

20
Agiculuralincome stabilization (C415) o
Linited partriership fishing income (loss] -

Limited partnership business income (lass)

™
[~}

Linited partner's atrisk amount .
Linited partner's adiusted atrisk amount e
Linited partnership rental income (lass]

M
&

Linited partnership lost available for carryforward

Previous loss car

"
2

yforward eligible in the current year

ra
&

Fietum of capital

1.

D -Mise. | E-Checkiist] F - Cerification | Partners

=1 R= =)
=l gllg
=1 | R=1 =1

N T = s

I~ Data entry c

omplete Recalculate | More Info

The amounts shown on the 6 pages of Area C1, are the total of the amounts

allocated to the partners on the T5013 slips. The sources of income and losses
are broken down into various categories that may be subject to different income
tax rules. Include income from both Canadian and foreign sources in Canadian

currency.

By pressing the Recalculate button (on the summary form or on the T5013 slip
form) the information entered in this area will be allocated among the partners
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and posted to the T5013 slips according to each partner’s share of net income

(or loss).

Area C2: Totals

L2 2007 T4 TimeSaver (Bobs Company) - [T5013 Summary] 9 (=13}
By File Company Forms G Reports Took Setup Window Help - A x
fanpERFILWORLD OF wo | [ [c| B |#4| & o || @]
& - Identification | B - General | C1 - Totals | #2Foialst | D - Misc. | E - Checkiist| F - Cenlfication | Partners
Section €. - T5013 and T50134 Slip Totals J
d Canadian and p
Renounced Canadian exploration expenses 120 T.00] Pertion subject to an interestfiee periodTC 129 0.00
Fienounced Canadian development expenses 121 0.00| Expenses quallying for B tax credit 141 0.00
Assistance for Canadian exploration espenses 124 0.00| Expenses qualiying for SK. tax credit 143 0.00
Assistance for Canadian develapment 125 0.00| Expenses qualifying for MB tax credit 144 0.00
Poticr subject b an intersstes periodCEE 130 DL00| Epruses ausliing or ON tax credit 145 000
Expenses qualitying for an 1TC 128 000 0.00
Tax shelter information
Mumber of urits acquied 150 oo Limtedrecourse amaunts 153 oo
Cost per it 151 oo Atk adjustment 154 0.00
0m [
Tkl st of s 152 Dttt indirect reductions 155
[~ Data enty complete Recalculats | More Info oK

Area D: Miscellaneous

The three pages of this section give miscellaneous information regarding the

I 2007 T4 TimeSaver (Bobs Company) - [T5013 Summary] (=13}
-8 X

B9 Fle Company Forms Cif Reports Iools Setup Window Help

[oRpERrIL R orwe 1 0 |5 B[] &) clmlml [ o
& -Identification | B -Geneval | C1-Totals | C2-Totals | i “Wige.. | E - Cheokist | F - Certfication | Partners

Section D -- Miscellaneous Information

1
01 -Is this o publiclytraded partnership? r
02 - Daes the partnership have operations in more than one jurisdiction? [~ 2
If yes, enter juisdiction codes H
3

03 - I this partnership a member of anather partnership? r

If yes, please give the name, address, and identiication number of the ather partnership.

Mame 04 | Partnershio's id. 05 ]

Addr 06
Ciy 07 Prov. 08 Postal code 09

If yes, pravide that partner's name.

10 I the pattnsrship repors renial inoorte, i the rertal propetty. —

the principal residence of any of the partners? | |
12 Did you pay someene to prepare this information retur? [
13 Did the patnetship danate any culusl or scolagical gits? [~

I Data enty complets Recalculate | More Info ok

partnership. Check each box to indicate a Yes response or leave blank for a No
response. In many cases, further information will be requested if the response is

Yes.
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Area E: Checklist
This section gives a list of all the documents that are required to be filed with a
T5013 submission, as well as some documents that may need to be filed, if they

apply.

Certification

Enter the name and position of the authorization partner responsible for the
T5013 submission.

Partners

L% 2007 T4 TimeSaver, (Bobs Company) - [T5013 Summary]
E3- File Company Forms £ Reporks Tools Setup  Window Help - 8 X

[WONDERFULWORLD 0F wi | [ || 21| d4] & o | & E |

A - Identification

Partners

Partrers information may be entered by selecting Partnership/T 5013 Slips from the Forms menu. To distribute
the amounts on this summary to the partners bazed on the percentages shown below, click Recalculate.

. Partner's id Units or interest| 13 - Partner's

PEIRETS REE number owned share [%
BROWHN, Bob 7891234565 15.0000 50.0000

p |JOMES. Bab 1472083694 15.0000 50.0000

Shows the name, Identification number, Units or interest owned, and the
Percentage share of each partner in the partnership.

More Info
Contains the company category and printing dates, if applicable.
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T5018 Summary

Other Information T5018 Slip Totals

' ' Choice of language far Total TEO18 slips filed - Box 80
For the period ending Ccolespondence

v Endglish French
Total construction subcontractor

Trade name (if different from legal name] payments - Bow 32

Perzon to contact about thiz return Certification

Forane ] | |
SUIRETDD | | Mame and surname [in capital letters]

] | |
[ ate: Printed

Position ar office

[Data entry complete

More Info OK

Period Ending
Enter the date for the end of the period being reported.

Person to contact about this return

The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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T1204 Summary
B3 Fle Company Forms Reports Tools Setup Window Help = ﬂ
|FirstCompany | D|ﬁ||ﬂ| &h | | ||
T1204 Shp Totals Year
Total T1204 slips filed - Box 28 0
Tatal service payments - Box 82 0.00
Total mived payments - Bow 84 0.oo
Perzon to contact about thiz return
Mame Telephone Extengion
LCertification
Mame and surname [in capital letters) Position or office [ ate Printed
[~ Data entry complete | More Info (119 |

Person to contact about this return

The default contact name and phone number entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name and
number were entered, these fields will be blank. In either case you can change
the information at this time.

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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RL-1 Summary

(5. File Company Forms Reports Tools Setup Window Help -8 ﬂ
First Company |D|ﬁ||ﬁ| @ | | || | J
Page 1

Contributions to QPP Contributions to QPIP

Employee [Box B]  Employer Employee [BosH]  Employer

| 3DD.nn| + | 3DD.nn| = | snn_uu| 3 | 3D_DD| + | 599_50| = | ?29.sn| 9

BQuebec income tax

RL-1 Tax RL-25 Tax RL-2 Tax

| D.DD| o | D,Dljl + | D_DD| Slips are unadjusted. Totals are the |

values entered by user.
- e

Compenzation tax
[v Check here if exempt from compenzation tax

Eamings 81.00000] = 1% = 2

Subtotal: lines 3,12 and 21 EO0.00) 25
QPF. income and comp. tax remitted  — 0.00{ 2
TOTAL = EO0.00 27
I Data entry complete Page 1 Page 2 Page 3 More Info (1] 4

Québec income tax
Enter the value of the total income tax withheld from all RL-16 slips, and all RL-2
slips.

Compensation Tax

Compensation tax applies only to listed financial institutions other than
corporations. If the company is not exempt from the compensation tax, remove
the check from the appropriate box. The wages subject to the compensation tax
are the totals from boss A and Q of the RL-1 slips.

Total
Once you have entered the sum of the QPP, income and compensation tax
remitted in box 26, the box 27 total will be calculated.

Recalculate

Recalculates the calculated values, returning overridden values to the calculated
value.

Page 2
Contains additional information required for the RL-1 Summary.
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B Ble Company Forms Reports Tools Setup Window Help ;Iilﬂ
[Fist Campery Dl=|B#l & ==w(a] | |
Page 2
Contribution to health services fund [F55]
Boxes A + 0 of AL1 slips 31.000.00 BALANCE 70
Adjustrents 0.oo
Wages paid or deemed paid 81.,000.00 23
Exempted wages | || 0.00
"Wages subject 81.000.00 w DT = 21870037
Less: Contributions ta FSS remitted 0.00(38
TOTAL 2.187.00| 39

Contribution to CNT
Remuneration subject to controbution

Contribution to FMF

Total payrall w1% = 0.00] 51
Eligible training expenditures — 0.00]| 52
Mote: Payroll legs than $1,000,000 = 0.00| 53
I Data entry complete ‘ Page 1 | Page 2 | Page 3 ‘ More Info | oK |

Contributions to health services fund (FSS)

In the Adjustments box, enter the value required to obtain the correct total
Salaries value. If the value contained in the box labeled Boxes A + Q is the
same as the total salaries, leave the Adjustments box with the default value of
0.00. Inthe Exempt box, enter any salaries and wages paid by a new
corporation and exempted from the contribution. You will need to attach a
completed copy of the chart found on page 2 of the Summary of Source
Deductions and Employer Contributions.

The amount subject to FSS is calculated, and the rate is applied based on the
formula described in the RL-1 guide.

Contribution to CNT

Enter the remuneration subject to contribution to the financing of the Commission
des normes du travail (CNT), as calculated on form LE-39.0.2-V. in the box
labeled Remuneration subject to contribution

Contribution to FNF

Enter the value of the eligible training expenditures  in the box so that the
contribution to the Fonds national de formation de la main-d’oeuvre can be
calculated.

Note that if the total payroll (sum of boxes A and Q) is less than one million
dollars, no contribution to FNF is required.

Page 3
Contains additional information required for the RL-1 Summary.
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B File Company Forms Reports Tools Setup Window Help ;lilﬂ
[Fist Campary Dis|B(el 8 o= wm] | |

Page 3 - Other Information

Identification Ma. | Enter identification number in Campany/Edit
Date of statement |
Previous name

Mo. RL slips on paper 3 I:l
Mo, AL slips on mag. media 0 Tear
Mo, RL dlipz via the Internet 0

Drata submitted on magnetic r
redia of via the Internet

Enter transmitter nunber in Setup / User Setup Options /

Transmitter number Magnetic media

Telephone
Drate Printed

I Data entry complete

‘ Page 1 | Page 2 | Page 3 ‘ Mulel_nfu| oK ‘

Other Information

Enter the other requested information for the RL-1 Summary form on page 3.
Note that the number of slips listed should be the total number of RL-1, RL-2 and
RL-25 slips for the company, whether they were filed on paper, magnetic media,
or by internet.

Date printed
If the Relevé 1 Summary was previously printed, the date printed on the

summary will be recorded here. Otherwise this box will be blank.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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RL-2 Summary

B3+ File Company Forms Reports Tools Setup Window Help _ 8| x

|First Carnpany |D = % %

RL-2 Slip Totals

Mo. RL-2 slips on paper 0 Refund undeduﬁcled FHF:_SF' = BBDHE 0.00
Mo, BL-2 slips on mag. media 0 BOGSNAN - D 0.00
MNo. Rl-2 slips via Internet 0 Other nEome - Box H 0.00
Annunity - Bos & 000 . Deduction - Box | 0.00
Bensfits - Box B 000 T ax withheld at source - Box ggg

Other Payments - Bax C oo . Income after death - Box K :
Befund RRSP L Box D o0 Wwithdrawal under LLF - Box L 0.a0
i ! spousn.a T : Tax-paid amounts - Box b 0.00
Death beneit -Box E 0.00 Withdrawal undes HEP - Bax O o0

Certification
Pogition or office Telephone number Date Printed
Diata entry complete More Info oK

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.



Entering Summary Information 8-23

RL-3 Summary

B3 File Company Forms Reports Tools Setup Window Help = ﬂ
First Company | D|ﬁ||ﬁ| & | | || | J
RL-3 Slip Total: [Page 1]
A1 Actual dividends - non-sligible. ... e T T S 0.00
A2 Actual dividends - eligible....... 0.00 J Accrued income : Annuities. .00
B Taxable amount of dividends. ......... 0.00 Total Boxes A1, A2, D E H. 1 andJ............ 0.00
. . 0.0o0
L D 2 Gt 000 Amount for which Relese 3z not filed........... 0.00
[ Interest from Canadian sournces.... - . . 0.0o
_ oo Total investment INCOME............oooocvieieinne
E Other income from Cdk sources. ... -
F Grozs foreign income.............c........ 0.00 Total amount of income of unknown users..... 0.0o
G Foreignincome tar ... 0.00 Quebec income tax withholding [15%)............ 000
H Ruoyalties from Canadian zources. .. 0.00
[~ Data entry complete | Page 1 | Page 2 ‘ More Info | OK ‘

Amount for which Relevé 3s not filed

You should manually total all amounts from RL-3 slips that were not submitted
because the amount was less than $50 and enter the total value in the box
labeled Amount for which Relevés 3s not filed

Total amount of income of unknown users

You will need to calculate this value yourself by totaling the combined income
from all RL-3 slips that have "Unknown" for the recipient's name and address.

Page 2
Contains additional information required for the RL-3 Summary.

B+ File Company Forms Reports Tools Setup Window Help _ 8 x
First Campaty |D = 4| S

AL-3 Summary Information [Page 2]

T anation v'ear I:I Caode El Original

Tranzmitter

o SLUMMMATY
A3 slips filed on paper Enter tranzmitter information in Setupd ser Setupy
On magnetic media i} Submitting Relevé Magnetic media
i 3 dataan
Wia Internet magnetic media?
Filer [payer or nominee]
Filer ID Mo, Enter filer id number and MEQ in
NEQ Edit Compaty Infarmation
Branch Mo,
Mame of resource perzon |
Telephone
Lertification
Title Telephone number [ate Printed

Diata entry complete Page 1 Page 2 More Info [1] 4
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RL-3 Summary Information
Enter the correct year for which the data applies.

The "Code" field refers to whether the Summary is an original (0), additional (1) ,
or amended (2) Summary. Enter the appropriate code.

If you are submitting RL-3 data on magnetic media, check the box and enter the
number of RL-3 slips which are being submitted in this manner.

Filer (payer or nominee)

Enter the filer ID number, filer branch number (if applicable), and the name and
telephone number of a resource person. The name and address of the filer will
be taken from the company information Identification tab.

Transmitter
Enter the ID number, transmitter number, name and address of the transmitter
company, and the name and phone number of a resource person.

Certification

When you create a new company, the title and phone number for the certification
section are copied from the New Company Defaults tab of the Setup menu.
You may edit them on the RL-3 Summary form if required.

Recalculate
Recalculates the calculated values, returning overridden values to the calculated
value.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.
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8-25

RL-17 Summary

F3- Ble Company Forms Reports Tools Setup Window Help = ﬂ
|FirstEorn|:uar'|5I |D|#||M| = | | ||| J
RL-17 Slip Totals
Total RL-17 glipz filed 0 Total income for stay - Box C 0.00
T otal deductions - Box A 0.00 Tatal allowance for pear - Bow D 0.00
Total income for year- Box B 0.00 Total allmwance for stay - Bos E 0.00
I Data entry complete More Info 0K

Recalculate

Recalculates the calculated values, returning overridden values to the calculated

value.

More Info

Contains the company category, printing dates, and date filed by Magnetic Media

if applicable.
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RL-25 Summary

B3 File Company Forms Reports Tools Setup  Window Help - & H

|FirstEompany |D|ﬁ||!ﬁ| @ | | || | J
Year I:I Mame of plan | |

RL-25 S5hlip Totals

Tatal RL-25 slips filed a Cancelled allocations - Box E 0.00

Actual dividends - Box & 0.00 Tauable Dividends - Bos F 0.00

Capital gains- Box B 0.00 Dividend tax credit - Box G 0.00

Gapital gaing for exemption - Box C n.oo Foreign income tax - Box H Qoo
Other amount - Box D 0.0o Québec income tax - Box | n.on

Certification

Pogition or office Telephone number Date Printed

I Data entry complete ‘ More Info

Certification

The default certification name and position entered on the New Company
Defaults tab of the Setup menu will appear in this area. If no default name was
entered, these fields will be blank. In either case you can change the information
at this time.

More Info
Contains the company category, printing dates, and date filed by Magnetic Media
if applicable.



Entering Summary Information 8-27

TP-600 — Partnership Information Return

The TP-600 has multiple pages. Across the top of the screen there are

seven tabs: “Identification” for boxes 1-9, “Information” for boxes 10-20,
“Income/loss” for boxes 30-70, “Amounts on financial statements” for boxes 80-
86, “Other Information”, “Additional Amounts for Allocation” and “Partners”. Each
tab has up to three pages of data entry screens. Most of the data entry fields
appear exactly as they appear on the TP-600 return. See the 2008 Partnerships
Guide to filing the Partnership Information Return for full details on the
completion of the TP-600. Listed below are some of the fields that may require
some additional explanation.

i ] B - Information ] LC-Incomedloss | D - Amtsonffs | E - Other | F - Additional | Partners

- Identification

[ Amended return Quebec enterprize number
Partrership's id. number

] =

Tax shelter id. number

Business code [box 37)
Tax zhelter's principal business - code

Tax shelter's principal business - descr.

[ 3] Resource person
[4] Iz thiz alimited parthership? [

If yes, provide name and address of principal general partner.

Mame
Address
City / Prow.

Postal code

[5] Fizzal period from: | | To: |

I Data entry complete Recalculate More Info

Amended Return
Leave blank if this is an original form. Otherwise, check the check box to indicate
an amended return.

Business Code
Enter the four digit Business activity code from the RL-15 slip box 38.

Tax Shelter’s principal business activity and code
Enter the two digit code and matching description from the “Information
concerning the tax shelter” section of the RL-15 slip.

The amounts shown in Area C, lines 30 to 70, are the total of the amounts
allocated to the partners in boxes 1 to 15 on the RL-15 slips. The sources of
income and losses are broken down into various categories that may be subject
to different income tax rules. Include income from both Canadian and foreign
sources in Canadian currency.

By pressing the Recalculate button (on the summary form or RL-15 slip) the
information entered in this area will be allocated among the partners and posted
to the RL-15 slips according to each partner’s share of net income or loss.
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Chapter 9 — Producing Reports

Validating Data

This report will be run automatically when you process returns for Internet or
magnetic media filing. Both the CRA and MRQ have strict filing requirements.
The validation procedure will identify any missing or invalid data and allow you
opportunity to correct the data before transmitting it.

Select the Québec or Federal validation process.

B File Company Forms Reports Tools Setup Window Help ;Iilﬂ
NEW COMPANY |0||B i & ml|ml=(a] =

Companies Return types

Al MEW COMPANY }1204

* Curent ~ ™

(" Selected (# Selected

Select
Filker

1 * Validate Only ¢ Intemet ¢ CD ¢ DWD " Diskeltte
Cloze

Copies of report Options Process

File Slip Type
0 - Qrigital j ¥Yalidation Options

) . . [v Suppress warnings related to format of names
Edit Tranzmitter Information ‘

[ Show Schema Emors
Current printer

\\production\HF Lazerlet 4000 Series PCL 6 [MeD4:] Select

Select the company or companies and the type of return(s) to be validated.
Select “Validate only” to run the validation report on its own, or select a filing
method to both validate and create the filing media at the same time. If the data
fails the validation procedure, the filing will be aborted.

Ensure that the transmitter information is complete and correct. See “Edit
Transmitter Information” in Chapter 10 for details. Click on Process .

The Critical Error Report will be generated. This report will list the location of
missing or invalid data that will cause the data submission to be rejected by the
CRA or MRQ. These errors must be corrected before a magnetic media or
internet submission can be made.
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Critical Errors Warnings Print Cloze

D ata containg critical emors which will have to be fixed before creating a submizsion file.

Critical Error Report

Data File: C:\T4TimeSaver MyData t06

Printed: 11/27/06 at 8:37:44 AM

Slips: T4

The items in this list must be comrected before filing the selected data.

Company MY COMPANY

Message Check the employer account number in the company information screen

Data as entered data is missing

Schema Error pattern constraint failed. The element: "bn' has an invalid value according to its data type.
Company MY COMPANY

Message Check the contact name in the T4 Summary

Data as entered data is missing

Schema Error minlength constraint falled. The element: 'cntc_nm' has an invalid value according to its data type.
Company MY COMPANY

Message Check the contact phone in the T4 Summary

Data as entered data is missing

Schema Error pattern constraint failed. The element: 'cnotc_phn_nbr' has an invalid value according to its data type.
End of report.

Click the Warnings button to view the missing or invalid data that may need to
be corrected but will not cause rejection of the submission by CRA or MRQ.
Either report can be printed by clicking the Print button.

Printing Slips

Select the desired type of slip from the Reports menu. Then select Slips from
this list of available reports. A dialog box will open, which will allow you to select
which slips you wish to print, the type of paper and the printer you wish to print
them on, and the number of copies you wish to print. The individual slips can
then be distributed to the employees or recipients and CRA.

Note that the unadjusted values will print on each of the T4 and Relevé 1 slips
unless all of the slips have been adjusted. You will be warned if some of the slips
are adjusted and others are not.

Companies
Select one of the three options listed:

- All (to print the slips for all companies in the current database),
Current (to print the slips for only the current company), or
Selected (to print the slips for the companies you select).

If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print slips
for using the Select, Unselect, Select All , and Unselect All buttons. When all
the required companies have been added to the selected list, click on Close.
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Slips

Select one of the four options listed:

All (to print all the slips for the selected companies),

Amended only (to print only the amended slips for the selected companies),

Originals only (to print only the slips that have not been amended for the
selected companies), or

Selected (to print only the selected slips for the current company).

If you choose Selected, click on the Select button to get a list of the employees
for the current company. Choose which employees you wish to print slips for
using the select, unselect, select all, and unselect all buttons. When all the
required employees have been added to the selected list, click on close.

Copy & Printer Selection

Choose which copies of the slips you wish to print by checking one or more of the
boxes. The options will change, depending on the Type of Form you have
selected. Each copy selection has a separate printer selection. Accept the
printer named in the combo box or select another valid printer from the list.

Paper Source
Indicate manual feed or one of the paper tray options listed for the selected
printer.

Font
Make sure the Use selected fonts option is checked. Select the desired font from
the list. You can select a different font for each copy of the report.

Note: By selecting a different font, you may affect the font size and placement of
the printing. It is advisable to print a test form to determine whether alignment
has been affected by the change in font.

Type of Forms

Select one of the listed options:

Plain paper facsimiles (to print a facsimile copy of the slip on a laser or ink jet
printer) ,

Pre-printed laser forms (to print onto preprinted laser forms)

(Continuous dot matrix forms  are no longer available in the T4 TimeSaver).

Sort Returns by

If you select "Sort returns by Company", T4 TimeSaver will print copies 2/3, copy
1 and then copy 4 for the first company, and then repeat for each remaining
company. If you select "Sort returns by Copy Number", all of the copy 2/3s will
print, followed by all of the copy 1s and finally all of the copy 4s.
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Order of Slips
Choose the order in which you wish the slips to print from the given options. The
options will change, depending on the type of slip to be printed.

Options
Whenever a facsimile or pre-printed laser form is being printed, the option to

Pause between copies for paper change will be available. If this option is
checked, the program will prompt you to change from the paper for copy 2/3 to
copy 1 and then to copy 4 when appropriate.

You may elect to print inactive (nil) forms . These are slips that have all dollar
values set to zero. These slips will not print unless this option is checked.

For some forms you will have the option to print French instructions on copy
2/3. You may select this option for French speaking employees.

In some cases T4 TimeSaver may try to switch to a paper size that your printer
driver cannot accommodate. Checking the use default paper size option will
cause the program to use the paper size selected in Windows.

Some printer drivers allow printing closer to the bottom of the paper than others.
In some cases, the preprinted forms cannot be completed, because the particular
printer driver cannot print as close to the bottom of the form as is necessary. If
this is the case T4 TimeSaver will warn you that there is a problem and offer
some possible solutions. One of the solutions may be to check the force

printing to bottom  option. When this option is selected, T4 TimeSaver will
attempt to change the paper size to a larger size to force the printer to print lower
on the page.

If you wish to have the employee number appear in the address field of the slip,
select the Print employee name followed by employee number option.

Print Alignment

Before beginning to print, you may wish to print a test page. If the printing does
not align correctly, click on the Adjust Margins button, and enter values that will
offset the printing and move it to the correct place.

Test Printer
This button will print a test page to your Windows default printer in order to
determine the maximum printable height for the printer.

Printing Summary Reports

Note that the T5013 summary and the T5014, T5015, and T5017 partnership
forms will print using the Adobe Acrobat Reader software. You will be able to
print the form for the current company only.
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To print the Summary Form to be sent with the slips to CRA, select the
appropriate type of summary from the list in the Reports menu, and then choose
Summaries from the list of available reports. A dialog box will open which will
allow you to select which Summary forms you wish to print, the type of paper to
print them on, the printer you wish to print them on, and the number of copies
you wish to print.

Note that the summary will reflect the unadjusted values from each slip unless all
of the slips have been adjusted. You will be warned if some of the slips are
adjusted while others are not.

Companies
Select one of the three options listed:

- All (to print the Summary reports for all companies in the current database),
- Current (to print the Summary report for only the current company), or
- Selected (to print the Summary reports for the companies you select).

If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print a
Summary Report for using the Select, Unselect , Select All , and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.

Slips
Select one of the options listed:
- All (to include all the slips in the Summary report for the selected companies),
- Amended only (to include only the amended slips in the Summary report for
the selected companies), or
- Originals only (to include only the non-amended slips in the Summary report
for the selected companies).

Copy & Printer Selection
Select one or more of the options listed. The options will change, depending on
the Type of Form you have selected.

Each copy selection has a separate printer selection. Accept the printer named
in the combo box or select another valid printer from the list.

Paper Source
Accept the paper tray named in the combo box or select another valid paper tray
option from the list for the selected printer.

Font
Make sure the Use selected fonts option is checked. Select the desired font from
the list. You can select a different font for each copy of the report.
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Note: By selecting a different font, you may affect the font size and placement of
the printing. It is advisable to print a test form to determine whether alignment
has been affected by the change in font.

Type of Forms

Select one of the options listed:
- Plain paper (to print a facsimile copy of the form on a laser or ink jet printer),
- Pre-printed laser forms (to print onto preprinted laser forms)

Sort Returns by

If you select "Sort returns by Company", T4 TimeSaver will print all of the
summaries for the first company and then repeat for each remaining company. If
you select "Sort returns by Copy Number”, the copy 1s for all the companies will
print first, followed by all of the copy 2s, etc.

You may also choose to print the current date, or change to another date if
appropriate.

Options
Whenever a laser form is being printed, the option to pause between copies for

paper change will be available. If this option is checked, the program will prompt
you to change paper between copies 1 and 2 and between copies 2 and 3.

You may elect to print inactive (nil) forms . These are slips that have all dollar
values set to zero. These slips will not print unless this option is checked.

If you have been sent pre-printed summaries from CRA, they may already
contain the company name, address, and business number as well as the code
for the applicable tax centre. In this case you would select the name/address
preprinted option to suppress duplicate printing of this information.

In some cases T4 TimeSaver may try to switch to a paper size that your printer
driver cannot accommodate. Checking the use default paper size option will
cause the program to use the paper size selected in Windows.

Some printer drivers allow printing closer to the bottom of the paper than others.
In some cases, the preprinted forms cannot be completed, because the particular
printer driver cannot print as close to the bottom of the form as is necessary. If
this is the case T4 TimeSaver will warn you that there is a problem and offer
some possible solutions. One of the solutions may be to check the force

printing to bottom  option. When this option is selected, T4 TimeSaver will
attempt to change the paper size to a larger size to force the printer to print lower
on the page.

Some of the pre-printed forms from CRA contain fields that are composed of
frames; one for each character in the field. It is not necessary to follow these
frames when typing or printing using a printer since the frames are ignored by the
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scanning devices used to read the data. However, if you would like to have the
data stretched to fit one character into each frame you can select the fit
numbers/text in frames option.

Print Alignment

Before beginning to print, you may wish to print a test page. If the printing does
not align correctly, click on the Adjust Margins button, and enter values that will
offset the printing and move it to the correct place.

Test Printer
This button will print a test page to your Windows default printer in order to
determine the maximum printable height for the printer.

Printing Adjustment Reports

A report showing all the adjustments made for each employee can be produced
for the T4 and RL-1 slips. To generate this report, select T4 or RL-1 from the
Reports menu. Then choose Adjustments from this list of available reports. A
dialog box will open which will allow you to select the companies for which you
wish to print T4 Adjustment Reports and the desired printer.

Companies
Select one of the three options listed:

- All (to print the Adjustment report for all companies in the current database),
- Current (to print the Adjustment report for only the current company), or
- Selected (to print the Adjustment report for the companies you select).

If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print the
Adjustment Reports for using the Select, Unselect , Select All , and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.

Or click on Filter to select the companies to include by data entry status, printing
status, magnetic media processing status, or company category. See the section
entitled Using Filters at the end of this chapter.

Order of Slips
Select one of the options listed below:
- Order by selected field (lists employees sorted by selected field), or
- Order in data entry sequence (lists employees in the order they were
entered).

Copies of Report
Type in the number of copies you require.
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Output Report to

Select one of the options listed below:
- Display (shows the report on your computer monitor), or
- Printer (prints the report on paper).

Options
Select one of the options listed below:

- Detailed report which shows the entered and adjusted values for each
employee’s CPP/QPP, El, and tax deduction, as well as a Summary for the
company, or

- Summary report which lists the total adjustments for each company.

Current Printer

This command button accesses the Print Setup dialog box, where you can select
the default printer for printing Adjustment Reports and the source (paper tray,
manual, etc.) of the paper.

Note: An asterisk beside a S.I.N. indicates that the S.I.N. value is invalid. (See
S.I.N. validation in Chapter 6).

Printing Edit List Reports

A complete edit listing of all the slips can be produced for all types of slips. To
generate this report, choose the type of slip from the Reports menu, and then
select Edit List from the list of available reports. A dialog box will open which will
allow you to select the companies to print an Edit List Report for and the printer
to print the reports on.

Companies
Select one of the three options listed below:

- All (to print the Edit List report for all companies in the current database),
- Current (to print the Edit List report for only the current company), or
- Selected (to print the Edit List report for the companies you select).

If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print the
Edit List Reports for using the Select, Unselect , Select All , and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.

Or click on Filter to select the companies to include by data entry status, printing
status, magnetic media processing status, or company category. See the section
entitled Using Filters at the end of this chapter.

Fields to print
Select one of the two options listed below:
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- All (to include all the fields available on the slip), or
- Selected (to print only those fields which you select).

Note: selecting “All” may result in a report printed in a font too small to be legible.

If you choose Selected , click on the Select button to get a list of the fields
available for the current slip. Choose the fields you wish to print on the Edit List
Reports by using the select, unselect, select all, and unselect all buttons. When
all the required fields have been added to the selected list, click on close.

Order of Slips
Select one of the options listed below:
- Order by selected field (lists employees sorted by selected field), or
- Order in data entry sequence (lists employees in the order they were
entered).

Copies of Report
Type in the number of copies you require.

Output Report to

Select one of the options listed below:
- Display (shows the report on your computer monitor), or
- Printer (prints the report on paper).

Options
Select the format you would prefer (either table style or memo style) and check

one or more of the other options listed below, if appropriate:
- Include addresses
- Include inactive slips . (An inactive slip is one which has all dollar amounts
set to zero.)
- Use legal paper (8%2x 14) , and
- Landscape orientation

Current Printer

This command button accesses the Print Setup dialog box where you can select
the default printer for printing Edit List Reports and the source (paper tray,
manual, etc.) of the paper.

Note: An asterisk beside a S.I.N. indicates that the S.I.N. value is invalid. (See
S.I.N. validation in Chapter 6).

Printing the Company Summary Report

A Company Summary Report is a listing of the companies in the current
database with the number of active and inactive slips of each type. Select
Company Summary Report from the Reports menu to generate this report. A
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dialog box will open which will allow you to select which companies to include, the
number of copies to be printed, the printer to use, and whether to print the report
or display it on the computer screen.

Companies
Select one of the three options listed below:

- All (to print the Summary reports for all companies in the current database),
- Current (to print the Summary report for only the current company), or
- Selected (to print the Summary reports for the companies you select).

If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to print a
Summary Report for using the Select, Unselect , Select All , and Unselect All
buttons. When all the required companies have been added to the selected list,
click on Close.

Or click on Filter to select the companies to include by data entry status, printing
status, company category, or with a specific type of slip. See the section entitled
Using Filters at the end of this chapter.

Copies of Report
Type in the number of copies you require.

Output Report to

Select one of the options listed below:
- Display (shows the report on your computer monitor), or
- Printer (prints the report on paper).

Options
Allows you to choose whether or not you want to include the address information.

Current Printer

This command button accesses the Print Setup dialog box where you can select
the default printer for printing Company Summary Reports and the source (paper
tray, manual, etc.) of the paper.

Using Filters

The Filter button allows you to select which companies to include in a report
based on data entry status, printing status, magnetic media status, or company
category. The report generated will contain information for the companies that
meet the criteria you select, all other companies will be filtered out. When you
click on the Filter button, the Select Companies by Filter window appears.



Producing Reports 9-11

. Select Companies by Filter E

Report zubtitle | |

—Data Entry Status——— — Printing Status
: V¥ Select on printing status

= Slips and surmmarnies printed
= Data entry not complete + Slips and/or surmmaries not printed

— Magnetic Media Status — Filter applies to

¥ Select on magnetic media status If you are setting a filker based on data
. X ety status, printing status, magnetic
C Magnetfc medfa mEzsE media status or slip type, select the ype
+ Magnetic media not processed of return ka filter on. [Only ahe may be
(" Date processed; |29-How-02 selected ) T4 s
T4a

Slip Type [N=F
’VI_ Select on bype of slip T45NR ™

"Eompany Category

[~ Select on company categomny
Set Filter LCancel

Data Entry Status
Check this box if you want to filter by whether or not the data entry is complete.
Select one of the options listed.

Printing Status
Check this box if you need to filter by whether or not the slips and summaries
have been printed. Select one of the options listed.

Magnetic Media Status

Check this box if you want to filter by whether or not the slips for the company
have been filed by magnetic media. You can also filter out the companies by the
date that their magnetic media was processed. This option only appears when
reports are being entered for returns for which magnetic media filing is supported.

Slip Type
Check this box if you wish to select one type of slip to report on. Then enter the

type of slip for which you want a report (“T4", “T4A”, “T5", “T4ANR”, “NR4",
“TAPS”, “T4AAP”, “T4AARCA”, “T5013", “T5018", “R2”, “R15”, “R17", “R25” or
“T1204").

Company Category
Check this box if you wish to select one company category to report on. Then
type in the company category name.

Filter Applies To

This option only appears when printing the Company Summary Report. You
need to indicate which type of return the data entry status and printing status
refers to. Once you have made your selections, click on the Set Filter button.
You will be told the number of companies that meet the criteria you have
outlined. Confirm the selection and the company names will appear in the
companies box.
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Chapter 10 - Filing by Magnetic Media or Internet

NOTE: Magnetic media filing is only available in T4 TimeSaver Plus, internet
filing is available in both Basic and Plus.

General information

NOTE: As a user of T4 TimeSaver, the requirement for you to submit a test file
with the Ministére du Revenu is waived because ELM Computer Systems
submits test files and receives approvals for the output of T4 TimeSaver from the
appropriate government departments each year. However, if you prefer to
submit your own test files, you may do so by following the instructions in the
appropriate guides.

Please note that returns for employers filing over 500 returns are required by
both CRA and MRQ to be filed on magnetic media or via the internet. CRA
allows the maximum size of an internet file to be 5Mb. Any submission in excess
of 5Mb must be submitted on magnetic media.

Filing on magnetic media is to your advantage because it reduces your printing
costs as well as the time spent handling paper. The program generates all the
components required for a complete magnetic media submission:

» diskette, CD or DVD containing the T4, NR4, T4A, T4A-NR, T4A(P), T5, T1204,
RL-1, RL-2, RL-3 or RL-25 information and transmitter identification (CRA no
longer accepts submissions on multiple diskettes)

* Description of Magnetic Medium (ED-400-V, formerly OPR-400-V) for Québec
returns

You may include returns for any number of companies when creating a magnetic
media submission. Approximately 2,000 slip and summary records will fit on a
single 1.44Mb floppy diskette, while about 80,000 slip and summary records will
fit on a CD and an even greater number on a DVD (depending on the type of
DVD media you are using). Each diskette counts as a single submission. If you
choose to submit your returns on CD or DVD a file will be created on your hard
drive which you may then copy to the appropriate drive using your own CD or
DVD writing software. NOTE: You must have access to a CD or DVD writer to
use this option.

Instructions for Federal Returns

The following instructions are provided here for convenient reference. For
complete details, obtain the CRA publications T4028 (for T4s, T4As, and T4A-
NRs), and T4031(E) (for T5s and NR4s), both entitled Computer Specifications
for Data Filed on Magnetic Media.

1. A magnetic media submission may contain only one diskette, CD or
DVD. If you have multiple submissions each submission must be
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submitted in a separate envelope. Multiple envelopes may be taped
together for simplified mailing.

2. You may file original, amended or cancelled returns on magnetic
media. You will be required to submit each type of return individually.
Prepare corrections in accordance with the instructions below.

3. If you are submitting returns partially on magnetic media and partially
on paper forms you must complete a separate summary for the portion
on paper. Both the magnetic media and paper portions of the return
should be submitted to the Magnetic Media Processing Team.

4. As noted earlier, filing on magnetic media eliminates the need to file
paper copies of the summaries and slips with CRA. Do not send CRA
paper copies of any returns that have been filed on diskette, CD, DVD
or via the internet.

Shipping Instructions

A complete magnetic media submission should be labeled ‘MAGNETIC MEDIA
FILER’ in clear, bold print and sent by courier or mail to the Magnetic Media
Processing Team. You may include a number of submissions in a single
shipment, as long as each submission is in a separate envelope.

Making Corrections
If it becomes necessary to make changes to the slips submitted on diskette
please consult the following instructions.

If the submission has not yet been sent to CRA you may choose to simply correct
the returns and recreate the diskette(s). If you do not wish to recreate the
diskette(s) you may prepare amended slips and summaries and include them
with the diskette submission.

If the corrections are being made to a submission that has already been sent to
the Magnetic Media Processing Team you are required to fill out a change form
to be included with your corrections. Please contact the Magnetic Media
Processing Team for further information.

Further Information
If you have further questions regarding the specifics of your magnetic media
submission, please contact the Magnetic Media Processing Team.

Magnetic Media Processing Team
Revenue Canada, Taxation
Ottawa Taxation Centre

875 Heron Road

Ottawa, Ontario K1A 1A2
Telephone: 1-800-665-5164
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Instructions for Québec Returns

The following instructions are provided here for convenient reference. For
complete details, obtain from the Ministére du Revenu the publications entitled
Guide for Filing Data on Magnetic Media, General and technical information, and
the associated guides for the type of slip you are filing.

Please note that returns for employers with fewer than 15 returns must not be
submitted on magnetic media. Returns for any employers with over 500 returns
are required by the Ministere du Revenu to be submitted on magnetic media.

Each organization filing RL magnetic media on their own behalf or on the behalf
of others must request a transmitter number and a set of serial numbers from
Ministere du Revenu before producing the magnetic media returns.

1. If you submit RL-slip data for more than one filer, you must provide the
Ministére du Revenu with a list of the names and the active
identification and file numbers of all filers for whom you are submitting
data for the year. You must also specify the type and number of RL
slips being filed on each filer's behalf.

2. A magnetic media submission may not contain multiple sets of media.
A submission can contain only one type of return, but may contain
returns for multiple companies.

3. T4 TimeSaver enables you to process original, amended and cancelled

RL-slips on magnetic media.

4. Filing on magnetic media eliminates the need to file paper copies of the
slips with the Ministére du Revenu. However, paper copies of
summaries must be sent under separate cover to the address given
in the guides for filing the returns. Do not send them to the address
that you use for data filed on magnetic media.

Shipping Instructions
1. The following information must be clearly marked on each diskette, CD or
DVD:
a. the type of RL data (for example, RL-1);
b. the transmitter's name and transmitter number;
c. the sequence number of the magnetic medium (for example, 1 of 3);
d. the name and telephone number of the resource person.

2. Enclose a completed copy of form ED-400V (formerly OPR-400-V),
Description of Magnetic Medium, for each diskette, CD or DVD set you
submit.

3. Send your package to the following address:
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Groupe de promotion de I'EDI et d’acquisition

des données électroniques

Direction générale du traitement et des technologies
Ministére du Revenu

3800, rue de Marly, secteur 2-2-0

Sainte-Foy (Québec) G1X 4A5

Further Information
If you have further questions regarding your magnetic media submission, please
contact:

M. Yvan-Denis Veilleux

Direction générale du traitement et des technologies
Ministere du Revenu

3800, rue de Marly, secteur 2-2-0

Sainte-Foy (Québec) G1X 4A5

Telephone: (418) 652-5281
Fax: (418) 646-0713
E-mail: yvan-denis.veilleux@mrg.gouv.qc.ca

Setting up the Magnetic Media Transmitter Record De  faults

During setup you should complete the Magnetic Media tab of the Setup menu if
you plan to submit returns on magnetic media. Much of the information required
by T4 TimeSaver for magnetic media processing is contained there.

To access magnetic media processing, choose the type of slip required from the
Reports menu and then Magnetic Media. Note that magnetic media filing is only
available for T4, NR4, T4A, T4A-NR, T4A(P), T5, T1204, T5018, RL-1, RL-2, RL-
3 and RL-25 returns.

The magnetic media dialog box will open and give you a number of options:
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B3 File Company Forms Reports Tools Setup Window Help - = ﬂ
[NEw/ COMPANY IsE=EN ) @ |z|=|E] =l
Companies Retumn types
~ al MEW COMPARNY T4
* Current & Curent
" Selected © Gelected
Filker
Copies of report Options Process
1 + Valdate Only ¢ Intemet ¢ CD ¢ DWD ¢ Diskette
File Slip Type ﬂ
0 - Original ﬂ Validation Options

: i . I Suppress warnings related to format of names
Edit Transmitter Infarmation ‘

Current printer

\\productionAHP LazerJet 4000 Seriez PCL 6 [Ne04:) Celect

Companies
Select one of the three options listed below:

- All (to create magnetic media output for all companies in the current
database),

- Current (to create magnetic media output for only the current company), or

- Selected (to create magnetic media output for the companies you select).

If you choose Selected, click on the Select button to get a list of the companies
contained in the current database. Choose the companies you wish to create
magnetic media output for using the select, unselect, select all, and unselect all
buttons. When all the required companies have been added to the selected list,
click on close.

Or click on Filter to select the companies to include by data entry status, printing
status, magnetic media processing status, or company category. See the section
entitled Using Filters at the end of Chapter 9.

Return types

Select one of the two options listed below:
- Current (to create magnetic media output for only the current slip type), or
- Selected (to create magnetic media output for the slip types you select).

If you choose Selected, click on the Select button to get a list of the slip types for
the selected company (or companies). Choose the slip types you wish to create
magnetic media output for using the select, unselect, select all, and unselect all
buttons. When all the required slip types have been added to the selected list,
click on close.
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Options
Before creating a magnetic media or internet filing submission T4 TimeSaver will

run a validating process to determine if there is any missing or invalid data. If
such data is located it will be displayed in one of two reports. Missing or invalid
data that would result in a refusal of your submission by CRA or MRQ are listed
in a Critical Error report. These critical errors must be corrected before
submitting the returns in any format. Missing or invalid data that may need to be
corrected, but would not result in a refusal of the submission by CRA or MRQ are
displayed in a Data Validation Warnings report. Warnings can be ignored and
the submission would be accepted by CRA or MRQ. The validation procedure is
implemented whenever a magnetic media submission is processed, but it can
also be run independently by selecting the Validate Only option.

Choose the media by which the return(s) will be submitted to the CRA or MRQ.
Your options are: Internet , CD, DVD or Diskette . If you choose to submit your
returns on CD or DVD a file will be created on your hard drive which you may
then copy to the appropriate drive using your own CD or DVD writing software.
NOTE: You must have access to a CD or DVD writerto  use this option.  If
you choose to submit your returns on diskette select the letter of the disk drive
(either A or B) you wish to send the output to. Be sure to place a blank formatted
diskette in the drive you selected.

If you are submitting returns over the internet please remember that only the
following returns may be submitted over the internet:
- CRA: T4, T4A, T5, NR4, T4ANR, T1204 and originals only of the T5018
- MRQ: RL-1, RL-2, RL-3 and RL-25
See the Internet Filing selection below for further details.

Edit Transmitter Information

Pressing this button will allow you access to the information stored on the
Magnetic Media tab of the Setup menu. You can add missing information or
edit existing data. Clicking on the OK button will return you to the magnetic
media dialog box.

File Slip Type
The data type (original or amended/cancelled) that will be filed is displayed here.

Current printer

This area displays the current printer. The Select command button accesses the
Print Setup dialog box where you can select the default printer for printing
Magnetic Media Reports and the source (paper tray, manual, etc.) of the paper.

Process

Pressing this command button will begin the processing of the magnetic media.
You will be prompted to insert formatted diskettes when needed, and given a
filename to put on the diskette label. The magnetic media transmittal reports
required by MRQ will print automatically once the processing is complete. There
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is no need to submit a transmittal report with federal returns, but the T4
TimeSaver will generate a report you can print out for your own records.

Remove Serial #s_(RL magnetic media only)

Use this function to remove previously assigned serial numbers. This should only
be done if the returns have not yet be submitted to Ministére du Revenu du
Québec and one of the following is true:

1. You elect not to submit by magnetic media after processing has been done.

2. The range of numbers used was not the range assigned by Ministere du
Revenu du Québec.

3. Errors or omissions were discovered in the data so the returns must be
reprocessed before submitting.

Set Serial #s_(RL magnetic media only)

The Ministére du Revenu du Québec requires each transmitter to use a unique
set of serial numbers for RL-1 and RL-3 magnetic media. You must contact them
to obtain your numbers (as well as your transmitter number). This button allows
you to enter the staring number, or change the number at any time. It is your
responsibility to ensure that the starting number is correct.

CD or DVD Filing
When the CD or DVD option is selected from the Magnetic Media dialog box, the
following screen will be displayed:

Submission Sequence Number

For CRA magnetic media fiing, the file name has a oK
specific format; AB CDYY™Y xml -

ABCD represents any alphanumeric combinatian [any sl
nurnber of characters] and Y reprezents the three

character sequence number starting at 0071 for the first

submigsion, 002 for the second, etc.

Fleaze enter the Y part of the file name according to
the number of submizsions you have done.

Enter the three digit number as requested and click the OK button. The following
dialog box will be displayed:

| = reovorie L

|t:\Program FilezhT4 TimeSaver\ 20064 files\RCT TAXDOT <ml

Submission File Mame:

“'our submizzion iz ready to be fled. Please take careful note of the above filename so you do not submit the wrang file.

Prirt Dretails Cloze
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Make note of the file name, print the details if desired and click Close. Copy the
file to the CD or DVD and submit as directed earlier in this chaper.

Internet Filing to CRA
T4 TimeSaver is able to utilize CRA’s URL for internet filing of the following
returns:

- CRA: T4, T4A, T5, NR4, T4ANR and originals only of the T5018

- MRQ: RL-1, RL-2, RL-3 and RL-25

When the Internet option is selected from the Magnetic Media dialog box, the
following screen will be displayed:

. Ready to File |
L etk (e |E:\F'rogram Filez\T4 TimeSaverh 2006\ Mrfilesi M EW_ COMPANYDZ. xml
Web Access Code: |

Business Mumber: |123458?82HPDDD1

Internet filing web page: |http:x’.ﬂ’www.cra-arc. g caleservicesfiref/other/ift ready-. html

Your submizzion iz ready to be filed. Please take careful note of the above
filename so you do not submit the wrong File.

Go To Internet
Filing Page

Close ‘

Make note of the information given, and click the Go to Internet Filing Page
button to continue. The following web page will be opened:

http://www.cra-arc.gc.ca/eservices/iref/file trans-e.html

Click the Enter Internet File Transfer (XML) Secure Web Site, which will open the
following web page:

https://apps.cra-arc.gc.ca/ebci/leb0/upload/T05iDisclaimerRender-e

and a page entitled: “Disclaimer - T4 Internet File Transfer (XML).” Read and
agree to the CRA terms and conditions disclaimer then enter the Business
Number and Web Access Code for the company for which you are filing an
internet return. Note: CRA can currently only receive submissions associated
with a business number with an “RP” extension. This should be expanded to
business numbers with other extensions for the 2008 filing season. (If you have
not received your Web Access Code by January 9™ contact the CRA support
staff at 1 866 322 7489 to have one issued to you.)

Once this information has been entered and validated you will be prompted to
upload a file containing the company data in XML format to the CRA website.



Filing by Magnetic Media 10-9

T4 TimeSaver will save all XML files in the following format:
COMPANY_NAME_XXX.XML

where “COMPANY_NAME” is the name of the company for which the file has
been created with all space characters replace by an underscore character;
“XXX' is a sequential number applied by T4 TimeSaver to ensure that older files
are not overwritten, and “XML” is the default file type designator required by CRA.

T4 TimeSaver Plus is able to submit returns for multiple companies over the
internet in a single file which can be no larger than 610kb in size. As in this case
you would be acting as an agent for multiple companies you must use your own
Business Number and Web Access Code to access the CRA website.

T4 TimeSaver Basic is limited to submitting returns for single companies over
the internet. As above, the file can be no larger than 610kb in size.

Internet Filing to Ministére du Revenu du Québec

To file a Revenu du Québec submission via the internet, go to the following
website and follow the directions for setting up a use word and password.

http://www.revenu.gouv.gc.ca/eng/services/sgp rl internet/index.asp

Then follow the filing directions given.

You must follow the naming convention below for submissions to the MRQ:
AAPPPPPPSSS

Where:
AA denotes the year of the submission (for 2008 AA = 07)
PPPPPP denotes the transmitter number

SSS denotes the sequence or submission number (beginning at 001 and
incrementing by 1 for each subsequent submission)
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Chapter 11 - Tools

Transfer Companies

Use this function to transfer one or more companies from the current database to
another database. Set the destination database by selecting an existing
database or creating a new one. Indicate which company(ies) you wish to
transfer using the Select, Unselect, Select All , and Unselect All buttons. If the
Remove Company from Source Database option is not checked, the company
information will remain in both the current database and the destination database,
otherwise it will be available only in the destination database.

Merge Companies

Use this function to merge two companies as a third company. The companies to
be merged can be selected from any database accessible to T4 TimeSaver. The
resulting company, containing the merged data, must not already exist in the
database in which it will be stored, which can be any database accessible to T4
TimeSaver.

. Merge Two Companies

— Company 1
— Company 2
Select Databaze | |----Select Second Company----- j

— Mew Company

Select Database | I

Start Merge | LClose

Change T4 Adjustment Options
This tool enables you to change the T4 adjustment options for all companies or a
group of companies (selected directly from a list or by their category code).

Correct Contact Information

Use this function to correct the contact information for one, all, or selected
companies. The option is provided to correct the company summary contact
information as well.
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. Commect Contact Information for Selected Companies

— Companies to be Changed

= Select from list

™ Select an company categary I

— Summaries to be Changed

oAl

" Select from list

Select |

Select |

First namel— [~ Change
Last name I— [~ Change
Phane I— [~ Change
Ext. I— [~ Change

— Mew Contact Information———————————————

Hew Certification Information

Name' [~ Change
Paositiorn | [~ Change
Phane | [~ Change

Proceed I LCloze |

Zero Out Slips

Use this function to clear the dollar values from slips while maintaining the
existing employee names and addresses.

Compames
+ Al

(" Current

" Select on company categary

™ Select from list

[

Ship Types
o

(" Select from list

LCloze

=

Select the all companies in the database, just the current database, all
companies with the entered company category, or select individual companies.

Select either all slips of all types, or select the slip type from the list.

Once the selections have been made, click the Proceed button to complete the

process.
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Move Dividends

Amounts in the “Actual amount of non-eligible dividends” box can be moved to
the “Actual amount of eligible dividends” and vice versa on T5, RL-3, T4PS and/or
RL-25 slips. Select Move Dividends from the Tools menu. Select the company
or companies, as well as the types of slips, to be processed. Indicate the
direction of movement (i.e. from eligible to non-eligible or from non-eligible to
eligible)

&% Move Dividends for Selected Companies

Companies
Al
(& Current

" Select on compary categany

™ Select from list

MEW COMPANY

Slip Types Direction to Move Data
W T5andRL-3 f* Mon-eligible to Eligible
[ T4Ps " Eligiblz ta Man-eligible
I RL-25

[E=T ]

LCancel

Database Repair

The database repair routine in T4 TimeSaver performs two functions. It
compacts databases to save space and it recovers from certain types of file
corruption caused by power failures, software problems, many hardware
problems, and most common types of operator errors. However, certain
situations such as physical damage to the data storage media (hard drive or
disks), or inadvertent erasure of files cannot be rectified by database repair
routine.

Warning:

IN NO CASE SHOULD YOU RELY SOLELY ON THE DATABASE REPAIR
ROUTINE IN THIS SYSTEM TO PROTECT YOUR FILES FROM ACCIDENTAL
ERASURE OR ANY OTHER LOSS OR CORRUPTION. YOU ARE
RESPONSIBLE FOR ENSURING THAT ADEQUATE BACKUP COPIES OF ALL
YOUR FILES (BOTH DATA AND PROGRAMS) ARE MADE ON A REGULAR,
SYSTEMATIC BASIS.

When to run Database Repair

The system constantly checks the validity of its files, and if it detects any
corruption it will report it. This could occur if you had turned off the computer (or
re-booted) without exiting T4 TimeSaver or had a power failure. If you run out of
disk space you may also experience some problems with the data. In this case,
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you should free up some disk space before proceeding with the database repair
routine.

If you get an error message about a corrupted database, you should run the
Database Repair option in the Tools menu to attempt to correct the damage.
Before using this tool it is advisable to make a backup copy of your database.
You can copy the database to a floppy diskette, or to another hard drive.

Select the Database Repair option from the Tools menu. Choose the current
database or selected database and click Start. If you have chosen selected
database, highlight the correct database directory and name from the list of
available databases. The process will begin as soon as you click on OK. You will
be informed when the repair is complete. Any data that cannot be fixed will be
discarded. You can then open the database again, and continue as usual.

Convert Last Year's Database

. Convert 2001 Databases to 2002 Format [ |
— Options

[v Initialize fields [zero amounts, remove “amended”, etc.):
[¥ Clear CPP exempt boxes | Clear El exempt boxes
[ Initialize partnership forms [ Clear T5013 and RL-15 Details

— Select Databases

—Select Source Directory —Select Destination Directory ——
s s
1 _RESTORE (I _RESTORE
34T 4TI
(23 compan [ compan
[C cpodre [ cpodree
[(ACpas (A Cpgs
_CI ELM LI [;"I ELM LI
I (=11 j I (=13 j
Convert | Cancel |

This function converts a “.TO7" database into a “.T08" database of the same
name. Use this function to maintain the company and employee data.

Options
You can choose to set all dollar values to zero and to remove any “amended”

markers by checking this box. Otherwise, all dollar values will be maintained and
amended slips will still be labeled amended. Check in the appropriate box(es) if
you want to clear the CPP exemption fields, the El exempt fields, the T5013
Details boxes and/or to initialize the partnership forms.

Select Source Directory

Choose the drive and directory that contains the 2007 databases you wish to
convert. The T4 TimeSaver will automatically find and list all the files having a
“TO7" extension. The “.TO7" databases will not be deleted.
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Select T4 TimeSaver file(s) to be converted

Highlight the file(s) you wish to convert. T4 TimeSaver will create a new file with
the same name but a “.T08" extension in the same directory as the original 2007
database. Only the highlighted files will be converted when the Convert button is
clicked.

Select Destination Directory

Choose the drive and directory in which you wish to store the 2008 database.
The directory can be the one containing the 2007 database or you can create a
new one each year.

Import

Import from Text File
Note: Appendix G contains important information regarding Importing from text files.

If you have information in a payroll package or another tax slip preparation
software product, and you would like to import this information into T4 TimeSaver,
you can do so if the software allows you to export to a spreadsheet or text file.
You can import both company information and information for individual slips.

Creating an import file

The files that T4 TimeSaver imports are tab-delimited text files. (The format of
the text file is quite similar to the format used by QuickBooks for its export and
import files.) The file is structured with keywords in capital letters that serve as
row and column headings. The keywords that appear at the beginning of each
row identify the type of information in that row. For example, the keyword T4
indicates that the row contains data about a T4 slip.

Generally, rows that begin with the same keyword are grouped together. For
example, all of the T4 entries appear as a single block of rows in the file. Each
block, in turn, has its own column headings that appear in capital letters in the
cells of the first row in the block. The column headings identify the type of
information that each column in the block contains.

There is one important exception to the rule that rows are grouped by keyword. If
your import file includes both company and slip information, the slip information
must follow immediately after the company to which it applies. For example, if
your import file includes two companies with their associated T4 data, the blocks
of information would be in sequence as follows:

Company 1
T4's for Company 1
Company 2
T4's for Company 2
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You may optionally choose not to import company information, but to add the
company information using T4 TimeSaver. The Import function will prompt you
for the company to import slip information into. If you select the company this
way, the import file may only contain slips for that company.

The best way to create or view an import file is to use a spreadsheet program, like
Microsoft Excel -- that way, you will see the data laid out into rows and columns.

If you do not have a spreadsheet program, you can also create an import file in a
word processor.

To help you get started we have included a set of templates in Microsoft Excel
format. You can access these by selecting Tools, Import, Open Excel Templates
for Import from Text.

Instructions
1. Open the spreadsheet that contains the data.

2. Move the contents of all the cells in your spreadsheet one column to the right
so that the first column is blank.

3. Move the contents of all the cells down by one row so that the first row is
blank.

4. Check the structure of the spreadsheet. If it contains more than one type of
information, for example, company information and T4 information, make sure
that each type of information has its own block in the spreadsheet. The blocks
should follow each other vertically.

5. In the first cell in the blank row above each block of information, enter one of
the keywords shown in this table. Be sure to include the exclamation point (!).

Enter thistext ... If the block contains...
ICOMPANY Company information

IT4 T4 and/or RL-1 slip information
IT4A T4A slip information

ITS T5 and/or RL-3 slip information
IT4PS T4PS information

INR4 NR4 information

ITAANR T4A-NR information

IT5013 T5013 (Partnership) information
IT5018 T5018 information

IRL2 RL-2 information

IRL15 RL-15 information

IRL17 RL-17 information

IRL25 RL-25 information
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For example, if the spreadsheet contains a company followed by its T4 slips, the
structure of the spreadsheet would be as follows:

ICOMPANY

[Company information]

IT4

[List of employee’s names, addresses, gross pay, etc.]

6. Fill in the remaining cells of the first column with the keyword you entered in
the first row for each information block. This time, omit the exclamation point. In
our example, the first column would look like this:

ICOMPANY
COMPANY
IT4

T4

T4

T4

[etc.]

7. Complete the first row for each block of information by adding the headings
that T4 TimeSaver expects to find for that type of information. (See Appendix G
for details about headings for company and slip information.) For example, the
first row for a list of T4 slips might look like this:

IT4A NAME ADDRESS1 ADDRESS2 CITY PROV POSTAL SIN (etc.)

8. Make sure that the content of the columns in each block matches the
headings you just added. For example, if the city and province are in one
column, you need to move the province to the PROV column and the city to the
CITY column. Our sample spread sheet would look something like this:

A | B | c | D | E | F | c | ]
1 [COMPANY MNAME" ADDRESS1 ADDRESS2 CITY PROV POSTAL
2 |COMPANY My Company 100 Industrial Road  Unit 101 Toronto ON M3N 8V7
3 |4 NAME ADDRESS1 CITY PROV POSTAL EMPHMUM  SIN
4 [T4 EMPLOYEE, A 1 Apple Ave. Willowdale oN M2J 172 A100 471
5 |T4 EMPLOYEE, B 2 Burton Bhd. Etobicoke CN Ma8X 2J9 A101 472
6 [T4 EMPLOYEE, C 3 Carling Cresc. Thornhill oN L4J 501 A102 473
7 |4 EMPLOYEE, D 4 Davis Drive Mississauga OM LAWY 2Ww2  A103 474
8 |ICOMPANY MNAME1 ADDRESS1 ADDRESS2 CITY PROV POSTAL
9 |COMPANY Your Company 200 Thornton Drive  Unit 202 Oshawa ON L2T 372
10 |4 NAME ADDRESS1 CITY PROV POSTAL EMPHMUM  SIN
11 |T4 EMPLOYEE, E 5 Edwards Crt. Morth York oN M2H 3B4 B200 571
12 T4 EMPLOYEE, F 6 Fortescue Blwd. Scarborough  ON M3B 4G5 B201 571
13 |IT4 NAMEA ADDRESS1 CITY PROV POSTAL COUNTRY
14 [T5 EMPLOYEE, G 7 Grand Gulf Road  Richmond Hill  ON L2R 3723 Canada
15 |T5 EMPLOYEE, H & Hill House Ave. East York 0N M&V 9C6 Canada :L
16
17
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9. Save the spreadsheet as a tab delimited text file. (The columns must be
separated by tabs.) Add a .TXT extension to the filename. The .TXT extension is
not required; however, if you use the extension, T4 TimeSaver locates the file
more quickly.

10. Start T4 TimeSaver. From the Tools menu, choose Import from Text File and
enter the name and path of the file you just created. Click OK.

What happens

T4 TimeSaver adds the data to the database you currently have open and
updates summaries as needed. For example, if you have imported a list of T4
slips, T4 TimeSaver updates the T4 summary with the totals of the slips.

Import from Magnetic Media File

If you have information in a magnetic media file, and you would like to import this
information into T4 TimeSaver this tool allows you to do so. You can import
company information as well as employee information for any slip type currently
supported by T4 TimeSaver's Magnetic Media function.

Import from Payroll (Plus version only)

Follow the instructions from your payroll package for submitting your T4s either by
the internet or as a magnetic media submission. In either case, save the created
file on your local computer.

Select Import from Payroll from the Import subdirectory of the Tools menu.
The following window will appear.

Source File Company Selection
Drive | =11 ﬂ " Import both slipz and company information.
Diectory [E30 ' Import only zlips information.

aoiR2
[Zwarking Copy

Select Company Create Company

Destination company:
Shadaowland

Filename

2003 T4.xml

Flease select either ML file or
M agnetic Media file created from your
payroll sofhware

Source filename:

Start Import

LCancel ‘

Browse to the drive and directory where you saved the T4 submission file and
highlight the correct file. Select the appropriate Company Selection option, and
select the company if required. Click the Start Import button to import the data.
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Export Names and Addresses

The Export tool permits you to create a list of employee names and addresses to
a quote-comma delimited text file. You may select to export data from a single
company or a group of companies for any or all types of slips. This list may then
be imported into any program capable of opening quote-comma delimited files for
further processing.

Usage Analysis

The Usage Analysis tool can scan the various storage media attached to your
computer for T4 TimeSaver databases and display (or optionally print) a report
showing a list of all databases, companies, and types of slips that have been
entered into T4 TimeSaver. You can specify any combination of storage media to
scan for this report. Please note that the Usage Analysis tool will take several
minutes to complete on larger hard drives and over a network connection.

Calculator
Select Calculator from the Tools menu to open a window containing a calculator
which can be used for simple mathematical calculations.

Edit Settings

T4 TimeSaver uses .ini files to store configuration data. It may occasionally
become necessary to view and/or edit these files directly. Under the supervision
of a T4 TimeSaver Technical support specialist you can make use of Edit Settings
from the Tools menu to examine these files and make any necessary changes.
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Chapter 12 — Appendices

Appendix A - Data Backup

Routine backup procedures are essential to protect against data loss or
corruption in any computerized system. The best time to make a backup copy is
just before you turn the computer off at night. Do not backup your data onto
existing backup disks! If you should have a power failure while doing the backup,
you would lose your previous backup as well.

Backup for Floppy Disk Users

Use Explorer to make a copy of your data disk(s). Access Window Help or your
User Manual for further information. You should also have a backup copy of your
T4 TimeSaver installation disks.

Backup for Hard Disk Users

Copy the database to a floppy disk or separate hard drive using the DOS copy
command or Windows Explorer. The current database name appears in the very
top bar of the T4 TimeSaver window. The database will be in the same directory
as the program unless you specified otherwise when you created the database.
Be sure to close the database before attempting to back it up.

Restoring Data Files
Copy the stored backup of the database back to the working directory using the
DOS copy command or Windows Explorer.
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Appendix B - Technical Notes

Data Storage

T4 TimeSaver stores the data you enter in MS Access database files having the
extension ".T08". The company information is stored within the database in a
table called "Company"”, one record per company. There is also a table within the
database for each type of slip and Summary form. Data is stored in these tables,
one record per employee, and connected to the company information by a
company number assigned by the system.

The file T4WO07.INI is stored in the same directory as the program and, among
other things, stores the authorization number. There will be additional file(s)
containing various user and machine related information also stored in the
working directory. If you have the single user version of T4 TimeSaver the file
will be named SINGLEYY.INI, where YY is the 2 digit year of the program. If you
have the network version of the program, there will be a separate file for each
user and the files will be named userYY.INI, where user is the user name entered
when starting T4 TimeSaver and YY is the 2 digit year of the program.
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Appendix C - Common Problems

1. "I get the message 'Company is locked by user ', but there are

no other stations using the T4 TimeSaver." or “The user named is not
currently using the program.”

This problem typically occurs when a database is left open after the program is
finished with it. If you are sure that the user being named is not using T4
TimeSaver already and that the company is not in use at another workstation, you
can answer “Yes” and unlock the company. If this does not solve the problem,
select Unlock all companies from the Company menu.

2. "The system is not calculating CPP properly. Ho  w do | enter the number
of pensionable weeks?"

This is one of the most common problems encountered by users of the T4
TimeSaver. Most likely, the problem stems from a failure to properly set up the
adjustment options. Access the company profile by selecting Edit company
information from the Company menu. Then select the T4 Adjustment Options
tab. There are two adjustment options involving CPP:

Adjust CPP if over maximum or under minimum
Adjust over/under paid CPP to tax based on number of pensionable weeks. (See
information in Chapter 7 Adjusting T4s and Relevé 1s for details)

The first option provides only a rough adjustment. It will either adjust CPP up to
the minimum or down to the maximum. If it falls in between these two, it will not
be changed. This option was implemented for situations where it is not desirable
to enter the number of pensionable weeks on each T4 slip. Because the system
does not have the number of weeks available to calculate prorated CPP
exemptions (if any), it must assume that there is no exemption. The calculated
CPP may therefore be higher when this option is used.

The second option requires you to enter the number of pensionable weeks on
each T4 slip, defaulting to the value entered for this option. Thus the program
has enough information to calculate prorated exemptions, and a more exact
adjustment results.

3. "When | print to pre-printed laser forms, the pr  inting doesn't line up.”

From the printing dialog box click on the Adjust Margins button. Enter positive or
negative values into the spaces provided under the headings "Vertical" and
"Horizontal". Positive values will move the printing down or to the right, while
negative values will move the printing up or to the left. You can indicate different
adjustments for each type of form listed.
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4. "El insurable earnings is not printing even when | have entered a value in
Box 24."

If the EI insurable earnings is equal to gross pay or if it is equal to zero, CRA
Taxation asks that the El insurable earnings not be printed, leaving Box 24 blank
in such cases. This is not a problem with T4 TimeSaver and we have checked
with CRA Taxation to ensure that the system is functioning properly.

5. “I have installed an update but the new features do not appear to be
available or functioning”

Check the version number of the T4 TimeSaver you are running by selecting
About T4TimeSaver from the Help menu. Make sure that the revision number
and date correspond to the update you have installed. If it is not, the most likely
problem is that you have installed the new version of the program into a different
directory than you did the first time. Run the update program again and select the
appropriate installation directory. Also, if you are starting the program from an
icon on your desktop, make sure that this shortcut is pointing to the correct
location. Alternatively, in a network environment, you may have some
workstations where the program was installed to a local hard disk. In this case,
the update program will have to be installed on the workstation’s local hard disk
as well. If none of the previous suggestions resolve the problem please ensure
that all users have exited the T4 TimeSaver and try installing the update once
again.

6. “I get error messages when | try to import my da  ta from a text file”

The format of the text file must be exactly correct for the T4 TimeSaver to be able
to read and interpret the data. Make sure there are no blank rows or columns.
Try removing all columns with the heading “NULL". Also, try selecting the data
cells from the top left to the bottom right, copying them and pasting them into a
new spreadsheet. Save this new spreadsheet as a tab delimited text file and try
the import from text function again.

7. “l get the message, ‘Cannot execute external pr  ogram regedit.exe’ when
installing the program.”

The installation program needs to be able to find the file regedit.exe. Itis
normally in your Windows directory. The solution is to make sure that regedit.exe
is in the Windows directory and that there is a path set to that directory. The path
is usually set in the autoexec.bat. See your systems administrator for help if
needed.

8. “My computer hangs when | start up T4 TimeSaver " or “My computer
hangs when | start up the program and enter the use  r name”

This indicates that the file USERYY.MDB is likely damaged. You can delete the
files USERYY.MDB and USERYY.BK*. You will then need to set up the user
names again. If you have a large number of users, you may wish to attempt
repairing the USERYY.MDB database. To do this, rename USERYY.MDB. Then
startup T4 TimeSaver. Select Repair Database from the Tools menu and point to
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the renamed file. Once it is repaired, you can rename it back to USERYY.MDB.
(YY indicates the two digit year of the program.)

9. “l get the message, ‘The OLE system files are in  -use and cannot be
updated. This installation must restart Windows to update OLE before it

can continue. Press Yes to restart Windows and con  tinue the installation,

or press No to exit the installation.” when install ing the program.”

This message is typically displayed when you are installing to a network directory
on a Novell network (although similar messages may be displayed if you are
installing to other network operating systems) and you do not have sufficient
rights to modify the contents of the network directory. To resolve the problem log
on to the network as an administrator and run the installation program again.

10. Other Problems
a) Miscellaneous data problems:

- run the Database Repair... found in the Tools menu on your data.
b) Miscellaneous printing problems:

- turn both the computer and the printer off, wait a minute, and turn them both
on again.

- check to see that a printer is connected to your computer and that the cables
are snug.

. ensure that the most recent printer driver for your operating system has been
installed, printer drivers are generally available from the printer manufacturer’'s
website.

c) Miscellaneous installation problems

. ensure that no other software is running during installation of T4 TimeSaver
such as anti-virus software or programs that start with Windows

. restart your computer to eliminate any potential memory corruption issues
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Appendix D - Province/State Codes
The following abbreviations apply to the Canadian provinces:

NL - Newfoundland

LB - Labrador

PE - Prince Edward Island
NS - Nova Scotia

NB - New Brunswick

QC - Québec

ON - Ontario

The following abbreviations apply to the

AL - Alabama

AK - Alaska

AR - Arizona

AR - Arkansas

CA - California

CO - Colorado

CT - Connecticut

DE - Delaware

DC - District of Columbia
FL - Florida

GA - Georgia
HI - Hawaii
ID - Idaho

IL - lllinois

IN - Indiana
IA - lowa

KS - Kansas

KY - Kentucky

LA - Louisiana

ME - Maine

MD - Maryland

MA - Massachusetts
MI - Michigan

MN - Minnesota

MS - Mississippi

MO - Missouri

MB - Manitoba

SK - Saskatchewan

AB - Alberta

BC - British Columbia

NT - Northwest Territories
NU - Nunavut

YT - Yukon Territories

United States:

MT - Montana

NE - Nebraska

NH - New Hampshire
NJ - New Jersey
NM - New Mexico
NY - New York

NV - Nevada

NC - North Carolina
ND - North Dakota
OH - Ohio

OK - Oklahoma

OR - Oregon

PA - Pennsylvania
RI - Rhode Island
SC - South Carolina
SD - South Dakota
TN - Tennessee

TX - Texas

UT - Utah

VT - Vermont

VA - Virginia

WA - Washington
WYV - West Virginia
W1 - Wisconsin

WY - Wyoming

Use the code 'ZZ' for instances where none of the above apply.
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Appendix E - Country Codes

ARG - Argentina

AUS - Australia

AUT - Austria

BHS - Bahamas, The

BHR - Bahrain

BGD - Bangladesh

BRB - Barbados

BEL - Belgium

BMU - Bermuda

BRA - Brazil

VGB - British Virgin Islands

CMR - Cameroon

CAN - Canada

CYM - Cayman Islands

CHL - Chile

CHN - China, People's Republic of
COL - Columbia

SUN - Commonwealth of Independent States
CIV - Ivory Coast

CYP - Cyprus

DNK - Denmark

DOM - Dominican Republic

EGY - Egypt

FIN - Finland

FRA - France

DEU - Germany, Federal Republic of
GRC - Greece

GRD - Grenada

GUY - Guyana

HKG - Hong Kong

ISL - Iceland

IND - India

IDN - Indonesia

IRL - Ireland

ISR - Israel

ITA - Italy

JAM - Jamaica

JPN - Japan

KEN - Kenya

KOR - Korea, Republic of (South)
LBN - Lebanon

BLZ - Leeward & Windward Islands & Belize
LBR - Liberia

LIE - Liechtenstein

LUX - Luxembourg

MYS - Malaysia

MLT - Malta

MEX - Mexico

MAR - Morocco

NLD - Netherlands

ANT - Netherlands Antilles
NZL - New Zealand

NGA - Nigeria

NOR - Norway

PAK - Pakistan

PAN - Panama

PNG - Papua New Guinea
PHL - Philippines

POL - Poland

PRT - Portugal

PRI - Puerto Rico

ROM - Romania

SAU - Saudi Arabia

SEN - Senegal

SYC - Seychelles

SLE - Sierra Leone

SGP - Singapore

ZAF - South Africa

ESP - Spain

LKA - Sri Lanka

SWE - Sweden

CHE - Switzerland

TWN - Taiwan (Republic of China)
THA - Thailand

TTO - Trinidad and Tobago
TUN - Tunisia

TUR - Turkey

ARE - United Arab Emirates
GBR - United Kingdom
USA - United States of America
URY - Uruguay

VEN - Venezuela

VIR - Virgin Islands (US)
YUG - Yugoslavia

ZMB — Zambia

OMC - All other countries
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Appendix F - Equivalent Fields

Equivalent fields on T4 and Relevé 1 Slips

The following fields are always identical on a T4 slip and a Relevé 1 slip:
Changing a value on either the T4 or the Relevé 1 will result in the same change
in the corresponding field of the other form.

Box 17 - QPP

Box 18 - El

Box 20 - RPP contribution
Box 46 - Charitable donations
Box 55 — PPIP premiums
Box 56 — PPIP earnings

Box B - QPP

Box C - El

Box D - RPP contribution
Box N - Charitable donations
Box H — QPIP premium

Box | — QPIP earnings

Equivalent fields on T5 and Relevé 3 Slips

The following fields are always identical on a T5 slip and a Relevé 3 slip:
Changing a value on either the T5 or the Relevé 3 will result in the same change
in the corresponding field of the other form.

Box 10 - Am’t of non eligible dividend

Box 24 — Am't of eligible dividend

Box 13 - Interest from Cdn. sources

Box 14 - Other income from Cdn. sources
Box 15 - Foreign income

Box 16 - Foreign tax paid

Box 17 - Royalties

Box 18 - Cap. Gains Dividends

Box 19 - Acc’d Income: Annuities

Box A2 — Am't of ordinary dividend
Box Al - Amount of eligible dividend
Box D - Interest from Cdn. sources
Box E - Other income from Cdn. sources
Box F - Foreign income

Box G - Foreign tax paid

Box H - Royalties

Box | - Cap. Gains Dividends

Box J - Acc’d Income: Annuities

‘In cases where the recipient is a corporation (i.e. recipient type code is 3), boxes
Al and A2 on the RL-3 will be set to zero and box E will contain the sum of Box
10, Box 24, and Box 14 values from the corresponding T5.
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Appendix G - Headings for Import File

Keywords are used as column headings by the import function to identify the
information in the column. Generally, each keyword is the name of a field in a
TimeSaver table. A special keyword, NULL, can be used to cause the import to
ignore a column.

Text fields are alphanumeric fields with a specified maximum size. If the data to
be imported exceeds the maximum size, the value will be truncated to fit into the
field. If data exceeds the maximum size of a field by more than 30 characters, an
error message will be given and the import process will be halted. Generally, the
alphanumeric fields may contain letters, numbers, spaces and punctuation. In
some cases, they must be in upper case (such as province codes, postal codes
and country codes). In other fields, mixed case is acceptable.

Yes/No fields. Acceptable values for Yes are Y, YES, or -1. Acceptable values
for No are N, NO or 0.

Currency fields are dollar amounts. They should be formatted with a decimal
between the dollars and cents; if there is no decimal, even dollars is assumed.
Do not insert commas as thousands separators. For example, $1,200.50 should
be formatted as 1200.50. The absolute maximum value is 999,999,999.99.

Integer fields are numeric whole numbers from 1 to about 32,000. They must be
entered without decimals or commas; for example, 1234.

Some fields have default values that will be used if the field is not present in the
import file. These are listed in the Comments, Example and Defaults column in
bold print. In addition to those listed below, the province and country codes for
slips are defaulted to the province and country codes of the company information.



12-10

T4 TimeSaver User Manual

Headings for Company Information

Heading

NAME1
NAME2
CAREOF
ADDRESS1
ADDRESS?2
CITY

PROV
POSTAL
COUNTRY
DEFPROVEMP
ACCOUNTNO

TAXCENTRE

IDNOQ

NEQ

Description

Line 1 of company name
Line 2 of company name
Care of line of address

Line 1 of address

Line 2 of address

City

Province code

Postal code (including space)
Country code

Usual province of employment
Business number

Taxation centre

Québec Identification number and file
number (Format 1234567890RS0001)

Québec Enterprise number

Type,
max. size
Text, 35
Text,30
Text,30
Text,30
Text,30
Text,28
Text,2
Text,10
Text,3
Text,2
Text,15

Text,13

Text,16

Text,16

Comments,
Examples &
Defaults

ON, QC, BC...

CAN, USA...
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Headings for T4 and RL-1 Slips

Type, Comments,
Heading Description max. size Examples &
Defaults
NAME Employee name Text, 30 Required field
ADDRESS1 Address line 1 Text, 30
ADDRESS2 Address line 2 Text, 30
CITY City Text, 28
PROV Province code Text, 2
POSTAL Postal code (including space) Text, 10
COUNTRY Country code Text, 3
INCOME Employment income (box 14) Currency
CPP CPP contributions (box 16) Currency
QPP QPP contributions (box 17, B) Currency
El El premiums (box 18, C) Currency
RPP Reg. Pension plan contr. (box 20, D) Currency
TAX Federal income tax deducted (box 22) Currency
EIEARN El insurable earnings (box 24) Currency
CPPEARN CPP pensionable earnings (box 26) Currency
CPPEARN CPP pensionable earnings (box 26) Currency
PPIPPREMIUM PPIP premiums (box 55, H) Currency
PPIPEARNING PPIP earnings (box 56, 1) Currency
CPPEXEMPT CPP exempt (box 28) Yes/No
EIEXEMPT El exempt (box 28) Yes/No
PPIPEXEMPT PPIP exempt (box 28) Yes/No
UNION Union dues (box 44) Currency
CHARITABLE Charitable donations (box 46, N) Currency
PENSIONNO RPP/DPSP number (box 50) Text, 7
PENSION Pension adjustment (box 52) Currency
PROVEMP Province of employment (box 10) Text, 2
SIN Social insurance number (box 12) Text, 9
EMPCODE Employment code (box 29) Text, 2
EMPNUM Employee number, reference number Text, 20
CPPWEEKS Weeks eligible for CPP Numeric,4 52.00, 52.5, etc.
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Heading

NETPAYOTHER
OTHERCODEL1
OTHERAMTL1
OTHERCODE2
OTHERAMT2
OTHERCODES3
OTHERAMTS3
OTHERCODE4
OTHERAMT4
OTHERCODES
OTHERAMTS
OTHERCODE®G
OTHERAMT6
AMENDED
VOID

TAXYEAR

Description

Other deductions from Net Pay
Other information code #1
Other information amount #1
Other information code #2
Other information amount #2
Other information code #3
Other information amount #3
Other information code #4
Other information amount #4
Other information code #5
Other information amount #5
Other information code #6
Other information amount #6
Amended slip

Cancelled slip

Taxation year

Additional headings for RL-1 fields:

INCOMER1
TAXR1
UNIONR1
QPPEARN
HOUSING
AUTOR1
HEALTHR1
TRAVELR1
OTHERTBR1
COMMISSIONS
OTHERINC
INSURANCE

DEFERRED

Employment income (box A)
Québec income tax deducted (box E)
Union dues (box F)

QPP pensionable earnings (box G)
Meals and accommodation (box H)
Personal use of auto (box I)
Private health insurance (box J)
Travel (box K)

Other taxable benefits (box L)
Employment commissions (box M)
Other taxable income (box O)
Multi-employer insurance (box P)

Deferred salary (box Q)

Type,
max. size
Currency
Text, 2
Currency
Text, 2
Currency
Text, 2
Currency
Text, 2
Currency
Text, 2
Currency
Text, 2
Currency
Yes/No
Yes/No

Integer,4

Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency

Currency

Comments,
Examples &
Defaults

For net pay calc.

Current year
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Type, Comments,

Heading Description max. size Examples &

Defaults

INDIANINC Exempt income for an Indian (box R) Currency

TIPS Tips received (box S) Currency

TIPSALLOCATED Tips allocated (box T) Currency

PHASEDRETIRE Phased retirement (box U) Currency

CODEBOXOR1 Code for Box O Text, 2

R1ISBUSINESS Recipient is business Yes/No

IDNOQUEBEC Recipient Quebec identification number Numeric,10

FNOTE1R1 Footnote #1 Text, 30

FNOTE2R1 Footnote #2 Text, 30

FNOTE3R1 Footnote #3 Text, 30
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Headings for NR4 Slips

Heading

NAME1

NAME2
ADDRESS1
ADDRESS2

CITYy

PROV

POSTAL
COUNTRY
STATUS
TAXYEAR
RECTYPE
COUNTRYCODE
PAYERID

SIN
INCOMECODEL1
CURRENCYCODE1
INCOME1

TAX1
EXEMPTIONCODE1
INCOMECODE2
CURRENCYCODE2
INCOME2

TAX2

EXEMPTIONCODE2

Description

Recipient name line 1
Recipient name line 2
Address line 1

Address line 2

City

Province code

Postal code (including space)
Country, in address
Status of slip

Year (box 10)

Recipient Type (box 11)
Country code (box 12)

Payer or remitter Identification Number

Foreign Social Security or Insurance No.

Income Code (box 14)

Currency code (box 15)

Gross Income (box 16)
Non-resident tax withheld (box 17)
Exemption code (box 18)

Income Code (box 24)

Currency code (box 25)

Gross Income (box 26)
Non-resident tax withheld (box 27)

Exemption code (box 28)

Type,
max. size
Text, 30
Text, 30
Text, 30
Text, 30
Text, 28
Text, 2
Text, 10
Text, 3
Text, 12
Integer,4
Text, 1
Text, 3
Text, 20
Text, 20
Text, 2
Text, 3
Currency
Currency
Text, 1
Text, 2
Text, 3
Currency
Currency

Text, 1

Comments,
Examples &
Defaults

Required field

CAN, USA, etc.

Amended, etc.

2007, 2008, etc.
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Headings for T4PS Slips
Type, Comments,
Heading Description max. size Examples &
Defaults
NAME Recipient name Text, 30 Required field
ADDRESS1 Address line 1 Text, 30
ADDRESS2 Address line 2 Text, 30
CITY City Text, 28
PROV Province code Text, 2
POSTAL Postal code (including space) Text, 10
COUNTRY Country, in address Text, 3 CAN, USA, etc.
STATUS Status of slip Text, 12 Amended, etc.
YEAR Year Integer, 4
ACTUAL_E Actual amount of eligible dividends (box 24) Currency
ACTUAL Actual amount of non-eligible dividends (box 30)  Currency
CAPGAINS Capital gains for loses (box 34) Currency
OTHER Other income (box 35) Currency
FORFEITED Forfeited due to withdrawal (box 36) Currency
FOREIGNINCOME Foreign non-business income (box 37) Currency
FOREIGNCAPGAINS  Foreign capital gains or losses (box 38) Currency
FOREIGNTAX Foreign non-business tax (box 39) Currency
SIN Canadian social insurance number (box 12) Text, 9
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Headings for T4A Slips

Type, Comments,
Heading Description max. size Examples &
Defaults
NAME Employee name Text, 30 Required field
ADDRESS1 Address line 1 Text, 30
ADDRESS?2 Address line 2 Text, 30
CITY City Text, 28
PROV Province code Text, 2
POSTAL Postal code (including space) Text, 10
COUNTRY Country code Text, 3
SIN Social insurance number (box 12) Text, 9
YEAR Year Integer, 4
RECBN Recipient Business No. (1% 9 digits) Text, 9
CORPNAME1 Recipient corporation name line 1 Text, 30
CORPNAME2 Recipient corporation name line 2 Text, 30
SUPER Pension or superannuation (box 16) Currency
LUMPSUM Lump-sum payments (box 18) Currency
SELF Self-employed commissions (box 20) Currency
TAX Income tax deducted (box 22) Currency
ANNUITIES Annuities (box 24) Currency
RETIRING Eligible retiring allowances (box 26) Currency
RETIRINGNON Non-eligible retiring allowances (box 27) Currency
OTHER Other income (box 28) Currency
PATRONAGE Patronage allocations (box 30) Currency
PAST RPP contributions (past service)(box 32) Currency
PENSION Pension adjustment (box 34) Currency
PENSIONNO Pension plan reg. number (box 36) Text, 19
FNOTECODE Footnote code (box 38) Text, 2
RESPACCUM RESP accumulated income pay’ts (box 40) Currency
RESPED RESP educational assist. pay’ts (box 42) Currency
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Type, Comments,

Heading Description max. size Examples &

Defaults

CHARITABLE Charitable donations (box 46) Currency

APPRENTICESHIPIN  Apprenticeship incentive grant Currency

CENTIVE

RECIPIENTNO Recipient’s number (box 14) Text, 12

FNOTE1 Footnote #1 Text, 30

FNOTE2 Footnote #2 Text, 30

FNOTE3 Footnote #3 Text, 30

The following fields are for magnetic media filers

only. Consult CRA’s magnetic media specifications

for details. On printed T4A slips, most of this information is included as footnotes. However, the T4
TimeSaver import procedure will NOT create footnotes from this information. To import footnotes that will
appear on printed slips, use the headings FNOTE1, FNOTE2 and FNOTE3 above.

BOX16CODE

UNREGPEN

SIPENSION

BOX18CODE

LUMPSUMACC

LUMPSUMSI

LUMPSUMRPP

LUMPSUMDPSP

LUMPSUMNONRES

LUMPSUMUNREG

LUMPSUMNOTRANS

BOX24CODE

DPSPANNUITY

IAACANNUITY

BOX26CODE

RETIRINGSI

BOX27CODE

RETIRINGNONSI

BOX28CODE

OTHERSI

OTHERDPSP

Box 16 code

Unregistered pension plan

Status Indian - pension or superannuation
Box 18 code

Lump-sum payments accrued to 12/31/97
Status Indian - Lump-sum payments
Lump-sum payments (RPP-not eligible)
Lump-sum payments (DPSP-not eligible)
Lump-sum payments (non-resident services)
Lump-sum payments (unreg'd pension ben.)
Lump-sum payments (not eligible for trans.)
Box 24 code

Instalment or annuity payment under DPSP
IAAC annuity

Box 26 code

Status Indian - eligible retiring allowance
Box 27 code

Status Indian - non-eligible retiring allowance
Box 28 code

Status Indian - other income

Instalment or annuity under revoked DPSP

Integer,2
Currency
Currency
Integer, 2
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Integer, 2
Currency
Currency
Integer, 2
Currency
Integer, 2
Currency
Integer, 2
Currency

Currency

0,913, 14

2,8,9,10,13,14

0, 10, 13, 15

0,14

0, 14

see Guide
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Type, Comments,
Heading Description max. size Examples &
Defaults
BOARDSITE Board and lodging at special work sites Currency
MEDTRAVEL Medical travel Currency
LOANBENEFIT Loan benefit under subsection 80.4(2) Currency
RESEARCH Research Grants Currency
SCHOLARSHIP Scholarships, fellowships, or bursaries Currency
WAGELOSS Income from wage loss plans Currency
DEATHBENEFIT Death benefits Currency
MEDBENEFIT Medical Premium benefit Currency
DISABILITY Disability benefits Currency
GROUPTERMLIFE Group Term Life Insurance Benefit Currency
VETERANSBENEFIT  Veteran's benefits Currency
TAXDEFPATDIVIDENDS  Tax deferred patronage dividends Currency
RPPPRE1990 RPP (pre-1990 past service) Currency
FNOTEDESC Footnote description area Text, 60
BOX32CODE Box 32 code Integer, 2 see Guide
BOX40CODE Box 40 code Integer, 2 0, 22
RESEARCH Research Grants Currency
CHARNO1 Charitable Registration Number 1 Text, 15
CHARNO?2 Charitable Registration Number 2 Text, 15
CHARNO3 Charitable Registration Number 3 Text, 15
APPRENTICESHIPIN  Apprenticeship incentive grant Currency
CENTIVE
REGISTEREDDISABI  Registered disability savings plan Currency
LITY
WAGEEARNERPRO Wage earner protection program Currency
TECTION
VARIABLEPENSION Variable pension benefits Currency
BOX32CODE Box 32 code Integer, 2 see Guide
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Headings for T4AA-NR Slips
Type, Comments,
Heading Description max. size Examples &
Defaults
NAME Recipient name Text, 30 Required field
ADDRESS1 Address line 1 Text, 30
ADDRESS2 Address line 2 Text, 30
CITY City Text, 28
PROV Province code Text, 2
POSTAL Postal code (including space) Text, 10
COUNTRY Country Text, 3 USA
YEAR Taxation Year Integer, 4 2008
STATUS Status of slip Text, 12 Amended, etc.
RECIPIENTCODE Recipient Code (box 11) Text, 1
BN Business Number (Box 13) Text, 15
INCOME Income (box 18) Currency
TRAVEL Travel (box 20) Currency
TAX Income tax deducted (box 22) Currency
REDUCTION Reduction authorized (box 23) Text, 1 1
CITYPROV City and Province where services tendered Text, 32
DAYSINCANADA Number of days recipient was in Canada Integer Max. of 366
FOREIGNSIN Foreign Social security number (box 14) Text, 20
SIN Canadian social insurance number (box 12) Text, 9
PROFNAME Professional name (box 16) Text, 30
INDUSTRY Non-resident’s service industry Text, 4
COUNTRYRES Country of Residence Text, 3 USA
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Headings for T4A(P) Slips

Heading

NAME

ADDRESS1
ADDRESS2

CITY

PROV

POSTAL
COUNTRY
NUMOFMONTH

EFFECTIVEDATE

TAXABLECPP
INCOMETAX
RETIREMENT
SURVIVOR
DISABILITY
CHILD
DEATH
BENEFITNUM

SIN

Description

Employee name

Address line 1

Address line 2

City

Province code

Postal code (including space)
Country code

Number of month (box 21)

Effective date (box 13)

Taxable CPP benefits (box 20)
Income tax deducted (box 22)
Retirement benefit (box 14)
Survivor benefit (box 15)
Disability benefit (box 16)
Child benefit (box 17)

Death benefit (box 18)

Benefit number

Social insurance number (box 12)

Type,
max. size
Text, 30

Text, 30
Text, 30

Text, 28
Text, 2
Text, 10
Text, 3
Integer, 2

Date,
mmm dd,,

yyyy

Currency
Currency
Currency
Currency
Currency
Currency
Currency
Text, 20

Text, 9

Comments,
Examples &
Defaults

Required field

Aug 03, 2008
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Headings for TAA(RCA) Slips
Type, Comments,
Heading Description max. size Examples &
Defaults
NAME Employee name Text, 30 Required field
ADDRESS1 Address line 1 Text, 30
ADDRESS?2 Address line 2 Text, 30
CITY City Text, 28
PROV Province code Text, 2
POSTAL Postal code (including space) Text, 10
COUNTRY Country code Text, 3
REFUNDEMPLOYER  Refund of employer contributions (box 12) Currency
REFUNDEMPLOYEE  Refund of employee contributions (box 14) Currency
DISTRIBUTIONS Distributions (box 16) Currency
SELLINGPRICE Selling price of an interest in RCA(box 18) Currency
OTHER Other amounts (box 20) Currency
INCOMETAX Income tax deducted (box 22) Currency
SIN Social insurance number (box 24) Text, 9
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Headings for T5 and RL-3 Slips

Heading

NAME1
NAME2
ADDRESS1
ADDRESS2
CITYy
PROV
POSTAL
COUNTRY
TAXYEAR
ACTUAL
ACTUAL_E
INTEREST
OTHER
FORINC
FORTAX
ROYALTIES
CAPGAINS
PBCAPGAINS
ACCRUED
RESOURCE
REPORTCODE
SIN
RECTYPE
CURRENCY
TRANSIT

ACCOUNTNO

Description

Recipient name line 1

Recipient name line 2

Address line 1

Address line 2

City

Province code

Postal code (including space)

Country code

Taxation year

Am’t of non-eligible dividends (box 10, A2)
Am't of eligible dividends (box 24, A1)
Interest from Cdn sources (box 13, D)
Other income from Cdn sources (box 14)
Foreign income (box 15, F)

Foreign tax paid (box 16, G)

Royalties from Cdn sources (box 17, H)
Capital gains dividends (box 18, I)
Pre-Budget cap. gains dividends (box 40)
Accrued income: Annuities (box 19, J)
Resource allowance deduction (box 20)
Report code (box 21)

Recipient identification number (box 22)
Recipient type (box 23)

Foreign currency code (box 27)

Transit (box 28)

Recipient account number (box 29)

Additional Heading for RL-3 fields:

RECTYPER3

ISINTERESTSAVINGSBONDS

ACTUALR3PREMAR24

Recipient type code

Is interest from Fed. or Québec savings bonds

Type,
max. size
Text, 30
Text, 30
Text, 30
Text, 30
Text, 28
Text, 2
Text, 10
Text, 3
Integer,4
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Text, 1
Text, 15
Text, 1
Text, 3
Text, 10

Text, 16

Text, 1

Yes/No

Comments,
Examples &
Defaults

Required field

Current year

0
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Heading Description Type, Comments,
max. size Examples &
Defaults
Were dividends issued before Mar 24/06 Yes/No
ACTUALR3_E Actual amount of eligible dividends (box A1) Currency
ACTUALR3 Actual amount of ordinary dividends (box A2)  Currency
OTHERR3 Other income from Cdn Sources (box E) Currency
NEEDR3 Recipient needs RL-3 Yes/No
ACCOUNTNORS3 Other ID/Recipient Number RL-3 Text, 16
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Headings for T5013 Slips

Heading

Main page fields
NAME1

NAME2
ADDRESS1
ADDRESS2
CITY

PROV

POSTAL
COUNTRY
STATUS
COUNTRYCODE
MEMBERCODE
UNITSOWNED
RECTYPE

PARTNERID

Description

Recipient name line 1
Recipient name line 2
Address line 1

Address line 2

City

Province code

Postal code (including space)
Country, in address

Status of slip

Country code (box 7)
Member code (box 8)
Partnership units held (box 9)
Recipient code (box 11)

Recipient’s ID (box 12)

(1) Limited partnership income/loss (Boxes 20-27)

NETFARMINGACC
NETFARMINGACCCAIS
NETFISHINGACC
NETTOTALBUSINESSACC
ATRISK
ATRISKADJUSTED
NETRENTALACC
LOSSCARRYFWD
PREVLOSSCARRYFWD
RETURNOFCAPITAL
GENERICEXBOXCODE_A1
GENERICEXBOXX_A1l
GENERICEXBOX_Al

GENERICEXBOXCODE_A2

Farming income (box 20)
Farming income (box 20)
Fishing income (box 21)
Bus. Income (box 22)
At risk amount (box 22-1)
Adj. at risk amount (box 22-2)
Rental income (box 23)
Loss carry forward (box 24)
Prev. loss carry forward (box 25)
Return of capital (box 27)
Generic extra box 1 code
Generic extra box 1 descr.
Generic extra box 1 amount

Generic extra box 2 code

Type,
max. size

Text, 30
Text, 30
Text, 30
Text, 30
Text, 28
Text, 2
Text, 10
Text, 3
Text, 12
Text, 3
Text, 1
Numeric
Text, 1

Text, 16

Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Text, 6

Text, 3

Currency

Text, 6

Comments,
Examples &
Defaults

Required field

CAN, USA, etc.
Amended, etc.

CAN, USA, etc.

4 decimals



(3) Canadian and foreign investments and carrying ¢

RECONCILEDNETRENTAL
DIVIDENDS

TAXABLE

CREDIT

DIVIDENDS_E
TAXABLE_E

CREDIT_E

INTEREST
FRNDIVIDENDS
BUSINVESTLOSS
CARRYINGCHARGES
GENERICEXBOXCODE_B1
GENERICEXBOXX_B1
GENERICEXBOX_B1

GENERICEXBOXCODE_B2

Net rental income (box 26)

Actual non-eligible div. (box 51)
Taxable am’t non-el. div. (box 51-1)
Non-elig div. tax credit (box 51-2)
Actual eligible div. (box 52)
Taxable am't eligible div.(box 52-1)
Eligible div. tax credit (box 52-2)
Interest from Can sources (box 50)
For. div. and interest inc. (box 55)
Business invest loss (box 56)
Carrying charges (box 59)

Generic extra box 1 code

Generic extra box 1 descr.
Generic extra box 1 amount

Generic extra box 2 code

Appendices 12-25
Type, Comments,
Heading Description max. size Examples &
Defaults
GENERICEXBOXX_A2 Generic extra box 2 descr. Text, 3
GENERICEXBOX_A2 Generic extra box 2 amount Currency
GENERICEXBOXCODE_A3 Generic extra box 3 code Text, 6
GENERICEXBOXX_A3 Generic extra box 3 descr. Text, 3
GENERICEXBOX_A3 Generic extra box 3 amount Currency
GENERICEXBOXCODE_A4 Generic extra box 4 code Text, 6
GENERICEXBOXX_A4 Generic extra box 4 descr. Text, 3
GENERICEXBOX_A4 Generic extra box 4 amount Currency
(2) Canadian and foreign net business income / loss (Boxes 35-34)
RECONCILEDNETBUSINESS Business income (box 35) Currency
RECONCILEDNETPROFESSIONAL  Professional income (box 37) Currency
RECONCILEDNETFARMING Farming income (box 41) Currency
RECONCILEDNETFISHING Fishing income (box 43) Currency
OTHERINCOME Other income (box 30) Currency
GROSSTOTALINCOME Total gross income (box 34) Currency

harges (Boxes 26-59)

Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Currency
Text, 6

Text, 3

Currency

Text, 6
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Type, Comments,

Heading Description max. size Examples &
Defaults

GENERICEXBOXX_B2 Generic extra box 2 descr. Text, 3
GENERICEXBOX_B2 Generic extra box 2 amount Currency
GENERICEXBOXCODE_B3 Generic extra box 3 code Text, 6
GENERICEXBOXX_B3 Generic extra box 3 descr. Text, 3
GENERICEXBOX_B3 Generic extra box 3 amount Currency

(4) Renounced Canadian exploration and development expenses (Boxes 120-)
RENOUNCEDCANEXPLEXP Renounced Can. Explor. Exp. (box 120)  Currency
RENOUNCEDCANDEVEXP Renounced Can. Dev. Exp. (box 121) Currency

ASSISTANCECANEXPLEXP Assiss. for Can. Explor. Exp. (box 124) Currency

ASSISTANCECANDEVEXP Assiss. for Can. Dev. Exp. (box 125) Currency
PORTIONINTFREECEE Portion interest free CEE (box 130) Currency
EXPENSESITC Expenses qualified for ITC (box 128) Currency
PORTIONINTFREEITC Portion interest free ITC (box 129) Currency
ADJUSTEDATRISKAMT Adjusted at risk amount (box 119) Currency
EXPENSESBCTAXCREDIT Expenses BC tax credit (box 141) Currency
EXPENSESSKTAXCREDIT Expenses SK tax credit (box 143) Currency
EXPENSESMBTAXCREDIT Expenses MB tax credit (box 144) Currency
EXPENSESONTAXCREDIT Expenses ON tax credit (box 145) Currency
GENERICEXBOXCODE_D1 Generic extra box 1 code Text, 6

GENERICEXBOXX_D1 Generic extra box 1 descr. Text, 3

GENERICEXBOX_D1 Generic extra box 1 amount Currency
GENERICEXBOXCODE_D2 Generic extra box 2 code Text, 6

GENERICEXBOXX_D2 Generic extra box 2 descr. Text, 3

GENERICEXBOX_D2 Generic extra box 2 amount Currency

(5) Tax shelter information (Boxes 150-)

NUMBUNITSACQUIRED Number of units (box 150) Currency
COSTPERUNIT Costs per unit (box 151) Currency
TOTALCOSTOFUNITS Total cost of units (box 152) Currency
LIMITEDRECOURSEAMOUNTS Limited recourse am’ts (box 153) Currency
ATRISKADJUSTMENTS At risk adjustments (box 154) Currency

OTHERINDIRECTREDUCTIONS Other indirect. reduct. (box 155) Currency
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Type, Comments,
Heading Description max. size Examples &
Defaults
GENERICEXBOXCODE_E1 Generic extra box 1 code Text, 6
GENERICEXBOXX_E1 Generic extra box 1 descr. Text, 3
GENERICEXBOX_E1 Generic extra box 1 amount Currency
(6) Other amounts and information
CAPGAINS Capital gains (box 70) Currency
CAPGAINSRES Capital gains reserves (box 71) Currency
CCA Capital cost allowance (box 85) Currency
Generic boxes where n is 1 to 25:
GENERICEXBOXCODE_Cn Generic extra box n code Text, 6
GENERICEXBOXX_Cn Generic extra box n descr. Text, 3
GENERICEXBOX_Cn Generic extra box n amount Currency
(7) Other amounts and information
Generic large boxes where nis 1 to 10:
GENERICLARGEBOXCODE_n Generic box n code Text, 6
GENERICLARGEBOX_n Generic box n text Text, 30
Additional Headings for T5015 fields:
CAPITALSTART Capital account start of period Currency
CAPITALCONTR Capital contribution during period Currency
OTHERADJUSTMENTS  Other Adjustments Currency
INCOMEALLOC Income allocated during period Currency
DRAWINGS Drawings Currency
CAPITALEND Capital account end of period Currency
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Headings for T5018 Slips

Type, Comments,

Heading Description max. size Examples &
Defaults

STATUS Status of slip Text, 12 Amended, etc.
NAME Recipient name Text, 30 Required field
ADDRESS1 Address line 1 Text, 30
ADDRESS?2 Address line 2 Text, 30
CITY City Text, 28
PROV Province code Text, 2
POSTAL Postal code (including space) Text, 10
COUNTRY Country, in address Text, 3 CAN, USA, etc.
RECTYPE Recipient type Text, 1 1
PARTNERSHIPID Parnership’s Filer ID Text, 9 1
PAYMENTS Construction subcontractor payments (box 22) Currency

SIN Recipient’s ID number (BN or SIN) (box 24) Text, 15
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Headings for T1204 Slips
Type, Comments,
Heading Description max. size Examples &
Defaults
STATUS Status of slip Text, 12 Amended, etc.
NAME1 Recipient name line 1 Text, 30 Required field
NAME2 Recipient name line 2 Text, 30
ADDRESS1 Address line 1 Text, 30
ADDRESS2 Address line 2 Text, 30
CITY City Text, 28
POSTAL Postal code (including space) Text, 10
PROV Province code Text, 2
COUNTRY Country, in address Text, 3 CAN, USA, etc.
YEAR Year Integer, 4
RECTYPE Recipient type (box 23) Text, 1 1,3,0r4
SERVICEPAYMENTS  Service payments (box 82) Currency
MIXEDPAYMENTS Mixed services payments (box 84) Currency
SIN Social insurance number (box 12) Text, 9
BN Business number (box 61) Text, 15
PARTNERSHIPID Partnership’s filer ID (box 86) Text, 9
LASTNAME Sole proprietor’s last name Text, 20
FIRSTNAME Sole proprietor’s first name Text, 12
INITIAL Sole proprietor’s initial Text, 1
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Headings for RL-2 Slips

NAME1

NAME2

ADDRESS1

ADDRESS2

CITY

PROV

POSTAL

COUNTRY

SOURCEL1

BENEFICIARYNUM

ANNUITY

BENEFIT

OTHERPAYMENT

REFUNDRRSPSPOUSE

DEATHBENEFIT

REFUNDRRSPUNDEDUCTED

REVOCATION

OTHERINCOME

DEDUCTION

TAX

INCOMEAFTERDEATH

LIFELONGLEARNING

TAXPAIDAMOUNT

SIN

SIN2

Recipient name line 1

Recipient name line 2

Address line 1

Address line 2

City

Province code

Postal code (including space)
Country, in address

Source of income

Employer assigned number

Life annuity payments amount
RRSP, RRIF, DPSP benefit amount
Other Payment amount

Refunded RRSP amounts

Value of benefit at time of death
Amount of refunded excess RRSP
Value of benefit before amendment
All other income

Amount giving entitlement to deduction
Amount of Québec tax held at source
Income earned after death amount
Life Long Learning Plan amount
Tax paid amount

Spouses social insurance number

Spouses social insurance number

Text, 30 Required field
Text, 30

Text, 30

Text, 30

Text, 28

Text, 2

Text, 10

Text, 3 CAN, USA, etc.
Text, 6

Text, 20

Currency Box A
Currency Box B
Currency Box C
Currency Box D
Currency Box E
Currency Box F
Currency Box G
Currency Box H
Currency Box |
Currency Box J
Currency Box K
Currency Box L
Currency Box M
Text, 9

Text, 9 Box N
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Headings for RL-15 Slips

Type, Comments,
Heading Description max. size Examples &
Defaults
NAME1 Recipient name line 1 Text, 30 Required field
NAME2 Recipient name line 2 Text, 30
ADDRESS1 Address line 1 Text, 30
ADDRESS2 Address line 2 Text, 30
CITY City Text, 28
PROV Province code Text, 2
POSTAL Postal code (including space) Text, 10
COUNTRY Country, in address Text, 3 CAN, USA, etc.
REPORTCODE Report code (code du relevé) Text, 1 O=original,
1=amended
MEMBERCODE Member code (box 40) Text, 1
UNITSOWNED Partnership units held (box 36) Numeric 4 decimals
RECTYPE Recipient code (box 41) Text, 1
PARTNERID Recipient’s ID (SIN, etc.) Text, 16

Headings for boxes 1-34 and 41-66 are in the following format, where nn is the box number, X is a letter
following the number (for example, Box 20A) and yy is the sub box number for boxes 34 and 66.

BOXnnX Box nnX Currency

BOXnn_yy Box 34-27, 34-28, 66-60, 66-61, etc. Currency

DETAILS Details (see note below) Text Up to 1000 char.
Note:

The Details box of the RL-15 slip is a free-format field where you may enter details about the various boxes
on the slip. When you create a text file of RL-15 data to be imported into T4 TimeSaver, you can insert a
tilde (~) in the text to cause a line break. For example, to create the following table:

Provincial allocation:

BC: 18.5%
AB:  12.0%
QC: 12.3%
(etc)

you would enter the following in the Details column of your import file:

Provincial allocation:~BC:  18.5%~AB: 12.0%~QC: 12.3%-~(etc.)
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Headings for RL-17 Slips

Heading

STATUS

NAME1

NAME2
ADDRESS1
ADDRESS?2

CITY

POSTAL

PROV

COUNTRY

YEAR

DEDUCTION
INCOMEYEAR
INCOMESTAY
ALLOWANCEYEAR
ALLOWANCESTAY
DAYSOUTSIDE
PERIODSOUTSIDE
DATEDEPARTURE
DATERETURN
FOREIGNCOUNTRY
SIN

REFERENCENUMBER

Description

Status of slip

Recipient name line 1

Recipient name line 2

Address line 1

Address line 2

City

Postal code (including space)
Province code

Country, in address

Year

Total deductions (box A)

Total employment revenue (box B)
Total income for stay (box C)
Allowance in year (box D)
Allowance for stay (box E)

Days outside Canada (box F)
Number of 30 day periods (box G)
Departure date from Canada (box H)
Return date to Canada (box I)
Name of foreign country (box J)
Social insurance number

Employer reference number

Type,
max. size
Text, 12
Text, 30
Text, 30
Text, 30
Text, 30
Text, 28
Text, 10
Text, 2
Text, 3
Text, 1
Currency
Currency
Currency
Currency
Currency
Integer
Integer
Date
Date
Text, 20
Text, 9

Text, 15

Comments,
Examples &
Defaults
Amended, etc.

Required field

CAN, USA, etc.
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Headings for RL-25 Slips
Type, Comments,
Heading Description max. size Examples &
Defaults
NAME1 Recipient name line 1 Text, 30 Required field
NAME2 Recipient name line 2 Text, 30
ADDRESS1 Address line 1 Text, 30
ADDRESS2 Address line 2 Text, 30
CITY City Text, 28
POSTAL Postal code (including space) Text, 10
PROV Province code Text, 2
COUNTRY Country, in address Text, 3 CAN, USA, etc.
BENEFICIARYNUM Employer assigned number Text, 20
TRANSIT Bank transit number Text, 10
RECTYPE Recipient type (box 23) Text, 1 1
SECONDNAMELAST Last name of 2" account holder if joint Text, 30
SECONDNAMEFIRST First name of 2" account holder if joint Text, 30
SECONDINDIVIDUAL Is second recipient an individual Yes/No
ACTUALDIVIDENDS Non-Eligible Dividend amount Currency Box Al
ACTUALDIVIDENDS_E Eligible Dividend amount Currency Box A2
CAPGAINS Total net Capital Gains Currency Box B
CAPGAINSEXEMPTION  Farm or small business capital gains Currency Box C
OTHER QPP and other amounts Currency Box D
CANCELLED Amounts cancelled Currency Box E
TAXABLEDIVIDENDS Taxable amount of dividends Currency Box F
TAXCREDIT Amount of dividend tax credit Currency Box G
FOREIGNTAX Income tax paid to a foreign government Currency Box H
QUEBECTAX Québec income tax withheld Currency Box |
NAMESPRINCIPAL Principal person who established trust deed Text, 25
SIN Beneficiary SIN Text, 9
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